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History of Changes

History of Changes 0

Date Changes Reason

2011-12-19 First version

2012-10-31 A local system account must be used for NDL conversion (see step 6 on page 250). CQ00231981

2012-10-31 Lotus Domino 8.5.3 und Lotus Notes 8.5.3 werden unterstützt.

2012-10-31 Registry keys NDLRemoveMrsCnvIcon [REG_DWORD] on page 252 and 
NdlWaitPrintEndSleep [REG_DWORD] on page 253 added

CQ00230550

2013-10-07 Registry key NonFaxDefaulDeliveryReport [REG_SZ] on page 237 added CQ00272515

2014-02-10 Starting with version 9, “Lotus Notes” and “Lotus Domino” are called “IBM Notes” and “IBM 
Domino”.

2014-02-10 IBM Notes 9 and IBM Domino 9 are supported. FRN6618,
FRN7467

2014-02-25 The supported IBM/Lotus Notes and IBM/Lotus Domino versions are indicated by a link to 
the release notice (see Section , “Introduction”, on page 9).

2014-03-10 If you connect XPR to IBM Notes 9.0 Social Edition (Basic Configuration) and IBM Domino 
9.0 Social Edition, use the mail templates for Lotus Notes 8 (see Section 3.4.1.2, 
“Modifications to the IBM/Lotus Notes Mail Template”, on page 42, Section 4.2.1, “Creation 
of the Administration Database”, on page 61, Section 4.4.1, “General Considerations”, on 
page 75Section C.1.1, “General Considerations”, on page 161).

2016-08-26 Updated steps to extend an UM Mail Template by Shared Actions (see Section 4.4.3.7, 
“Extending the Mail Template by Shared Actions”, on page 105). 
Updated instructions to modify default Forms and Design Elements for UM and TUM 
functions (See Appendix C.1.9, “Design Elements for IM and TUM Functions”).

UCBE-7536
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Introduction

1  Introduction

Thank you for the decision to operate the OpenScape Xpressions (Message 
Routing System) under IBM/Lotus Notes.

OpenScape Xpressions for IBM/Lotus Notes extends your existing IBM/Lotus 
Notes application by the functions of an advanced unified messaging system that 
integrates all communications (telephony, e-mail, voice mail, fax and SMS) on 
one platform, thus significantly improving workstation efficiency. In addition you 
can extend every workstation by multimedia call center functions.

Using XPR with IBM/Lotus Notes has the following advantages:

• The entire message administration occurs clearly and in one place.

• Simple transmission and receipt of fax, e-mail and voice messages and 
sending of SMS messages via the familiar IBM/Lotus Notes interface.

• CTI features such as telephone journal in IBM/Lotus Notes for all telephone 
calls and simple dialing from the address book.

• Mobile access via Web to the stationary workplace telephone and to all 
messages.

• Easy learning owing to integration in the familiar IBM/Lotus Notes interface.

NOTE:  The products Lotus Notes, Lotus Domino Lotus Domino Adminstrator 
and Lotus Domino Designer are called IBM Notes, IBM Domino, IBM Domino 
Adminstrator and IBM Domino Designer starting with version 9.

IMPORTANT:  All specifications in this manual that refer to version 7.x of Lotus 
Domino, Notes templates and Notes clients apply for the other supported 
versions of IBM/Lotus Domino, Notes templates and Notes clients also. Refer to 
the OpenScape Xpressions Release Notice to retrieve these versions. The GUI 
may appear slightly different, but the functionality is the same.
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1.1  About this Book

This manual describes the structure and administration of an XPR system under 
IBM/Lotus Notes. Information about using the XPR extensions integrated in IBM/
Lotus Notes are provided in a separate user manual. 

In order to understand the described functions and processes, the reader must 
have specialized knowledge in the following areas:

• Administration and configuration of the Windows Server 2008 operating 
system

• Administration and configuration of the supported IBM/Lotus Domino 
versions

• Network technology

• Installation and configuration of the XPRsystem. This knowledge can be 
obtained by participating in a Unify Software and Solutions GmbH & Co. KG 
seminar.

• Configuration of a PBX used in connection with the XPRsystem.

1.2  General Notes for this Manual

1.2.1  Manual Structure

The manual is divided into the following sections: 

• Introductory chapter with general notes on the product and on how to use the 
manual (current chapter).

• Realization Concept (Chapter 2).

• Installation of the IBM/Lotus Notes Gateway (Chapter 3).

• Configuration and Extension (Chapter 4).

• Configuration of the IBM/Lotus Notes Gateway (Appendix A)

• Configuration of the Administration Database (Appendix B)

• Design Elements of the XPR Mail Template (Appendix C)

• Installing and Integrating optiClient 130 (Appendix D)

• Information about fax templates, Legacy fax support, assist mails, update and 
Citrix Metaframe setup (Appendix E)

• Function Reference (Appendix F).
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1.3  Required Tools

1.3.1  Manuals

During the XPR installation and configuration the following manuals in electronic 
or printed format will be referred to: 

• Server Installation

• Server Administration

• IBM Notes Extensions – operating instructions

1.4  Document Conventions

Passages in the text conveying important information are indicated by striking 
symbols. 

IMPORTANT:  
Such a section points to settings and processes to be performed with special 
care.

NOTE:  
Such a section marks passages in the text that contain additional notes or supple-
mentary examples.
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1.4.1  Acronym Directory

The following table lists the acronyms used in alphabetic sequence. 

Acronyms Description

ACL Access Control List

APL Access Protocol Layer

CTI Computer Telephony Integration

HKCU HKEY_CURRENT_USER

HKLM HKEY_LOCAL_MACHINE

IM Integrated Messaging

LNAPL Lotus Notes-APL, IBM/Lotus Notes Gateway

LnUmAPL Lotus Notes Unified Messaging-APL

MSP Message Service Provider

MTA Message Transfer Agent

TUM True Unified Messaging

UM Unified Messaging

XPR OpenScape Xpressions
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1.5  Data Protection and Data Security

This system also processes and uses personal data for purposes such as billing, 
displays, and customer data acquisition.

In Germany, the processing and use of such personal data is subject to various 
regulations, including the regulations of the Federal Data Protection Law 
(Bundesdatenschutzgesetz = BDSG). For other countries, please follow the 
appropriate national laws.

The aim of data protection is to protect the rights of individuals being affected by 
use of their personal data.

In addition, the aim of data protection is to prevent the misuse of data when it is 
processed and to ensure that one’s own interests and the interests of other 
parties which need to be protected are not affected.

NOTE:  
The customer is responsible for ensuring that the system is installed, operated 
and maintained in accordance with all applicable labor laws and regulations and 
all laws and regulations relating to data protection, privacy and safe labor 
environment.

Employees of Unify Software and Solutions GmbH & Co. KG are bound to 
safeguard trade secrets and personal data under the terms of the company's 
work rules.

In order to ensure that the statutory requirements during service – whether during 
“on-site service” or during “remote service” – are consistently met, you should 
always observe the following rules. You will not only maintain the interests of your 
and our customers, you will also avoid personal consequences.

A conscientious and responsible approach helps protect data and ensure 
privacy: 

• Ensure that only authorized persons have access to customer data.

• Take full advantage of password assignment options; do not allow 
unauthorized persons to gain access to passwords by writing them down on 
a piece of paper or via other means.

• Ensure that no unauthorized person is able to process (store, modify, 
transmit, disable, delete) or use customer data in any way.

• Prevent unauthorized persons from gaining access to storage media, such as 
backup diskettes or log printouts. This applies to service calls as well as to 
storage and transport.

• Ensure that storage media which are no longer required are completely 
destroyed. Ensure that no sensitive documents are left unprotected.
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Work closely with your customer contact; this promotes trust and reduces 
your workload. 
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Realization Concept

2  Realization Concept

This chapter describes the realization concept of the XPR integration with IBM/
Lotus Notes (IBM/Lotus Notes Gateway). The first paragraphs include basic 
information on the IBM/Lotus Notes Gateway structure, which will be important 
for the later configuration and administration of the product. 

Since the terms Unified Messaging (UM), Integrated Messaging (IM) and True 
Unified Messaging (TUM) will be often used in this manual, this chapter contains 
a description of these terms along with detailed information on the functionality of 
all three Unified Messaging technologies.

NOTE:  Please read this chapter attentively before the installation and configu-
ration of the IBM/Lotus  Notes Gateway, since the concepts described here is the 
basis for the correct and trouble-free operation of the product.
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2.1  General Structure Concept

Figure 1 shows how the XPR system can be integrated in an existing LAN or 
ISDN infrastructure. The IBM/Lotus Notes Gateway is installed on the XPR server 
executing all Unified Messaging functions. The XPR server is integrated in the 
existing LAN and a PBX. 

Integration to the PBX may be via ISDN or LAN (Voice-over-IP), provided that the 
applied PBX supports Voice-over-IP technology. 

Figure 1 Structure concept - Overview 

The users' workstation computers are connected to the IBM/Lotus Domino server 
via LAN. Each workstation has a telephone. Between the XPR server and the 
PBX a CTI link (via LAN or ISDN) can be established, enabling the user to: 

• control telephones and other devices under IBM/Lotus Notes

• receive telephone journals in IBM/Lotus Notes

With the XPR integration into IBM/Lotus Notes the user is able to use all message 
types out of his/her IBM/Lotus Notes work environment. The XPR system 
provides so-called mail file extensions via which the Unified Messaging features 
of the XPR system can be added to the default mail file of a IBM/Lotus Notes 
system. 

In Figure 2 the XPR system integration into a IBM/Lotus Notes environment is 
depicted more clearly. The XPR server software and a IBM/Lotus Notes client are 
installed on the XPR server. The IBM/Lotus Notes APL uses the IBM/Lotus Notes 
client information to connect with the IBM/Lotus Domino server. From the IBM/
Lotus Domino server's point of view, the die Lotus Notes APL is nothing else but 
a user. 

A IBM/Lotus Notes client is installed on the user's workstation computer, 
communicating with the IBM/Lotus Domino server via LAN. If a user applies the 
XPR services fax, voice mail and SMS in addition to the normal e-mail 
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functionality, these messages will be sent directly from the IBM/Lotus Notes client 
to the IBM/Lotus Domino server. The Domino server processes the messages 
and forwards them to the Lotus Notes APL of the XPR server. From here, they 
are sent to a recipient e.g. via a Telematic APL (ISDN or IP). 

Figure 2 Structure concept - Detailed view

If the CTI service is to be used additionally (sending or listening to voicemails via 
telephone, telephone control via the IBM/Lotus Notes client, etc.), the Message 
Service Provider (MSP) must be installed on the workstation computer of the 
XPR. The MSP communicates via LAN with the XPR server. If a user wants to 
control his/her telephone with the IBM/Lotus Notes client, a connection request is 
transmitted from the IBM/Lotus Notes client to the MSP, which sends this request 
via the LAN to the TCP APL of the XPR server.

In the XPR server the connection request is forwarded to the CTI APL. The CTI 
APL sends the request via a LAN or ISDN connection to the PBX. The PBX will 
then establish the connection to the dialed phone number.
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2.2  Unified Messaging Technologies

In this manual, the terms Unified Messaging (UM), Integrated Messaging (IM) 
and True Unified Messaging (TUM) are often used. For a better understanding 
the meaning of the terms and their functionality will be explained in the following 
paragraph.

2.2.1  Unified Messaging

Unified Messaging offers the possibility to access messages by means of one 
journal independent of the service used for sending them. This means you can 
view or play back fax messages, voice mails or e-mail messages from within IBM/
Lotus Notes. 

If you have installed the Lotus Notes APL but have not performed any 
configuration steps yet, it is exclusively possible to use Unified Messaging. 
Unified Messaging can therefore be considered as the basic function.

Depending on the Lotus Notes APL configuration you can extend this basic 
functionality to the advanced functionality of Integrated Messaging and/or True 
Unified Messaging.

In the following sections sending and receiving messages with Unified Messaging 
will be explained with the help of an example.

2.2.1.1  Sending a Fax Message

User A wants to send a fax message out of his/her IBM/Lotus Notes client to an 
external user B. User A creates the fax messages as usual in his/her IBM/
Lotus Notes mail application and enters the fax number of the external user B as 
recipient address. 

With its transmission the fax message is at first stored in the mail database of user 
A and by the IBM/Lotus Notes mailrouter transferred to the foreign domain 
defined during the Lotus Notes APL installation (the document is copied to the 
corresponding database, e.g. notesgat.box).

The Lotus Notes APL (LnAPL) installed on the XPR server checks the gateway 
mailbox regularly for new messages. If this is the case, the LnAPL fetches the 
message and forwards it to the MTA.

The MTA recognizes the message as a fax document and sends it to the 
Telematic APL (e.g. ISDN APL). The Telematic APL sends the fax message via 
the telephone network to the fax device of user B.
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2.2.1.2  Receiving a Fax Message

In the reversed case, external user B wants to send user A a fax message via his/
her fax device. Therefore user B inserts the message in his/her fax device and 
dials user A's fax number. The document is sent to the XPR server where it is first 
evaluated by the Telematic APL and then transmitted to the MTA. 

The MTA sends the fax message to the Lotus Notes APL. The Lotus Notes APL 
copies the message to the server mailbox of the IBM/Lotus Domino server 
(mail.box).

From there it is forwarded by the IBM/Lotus Notes mailrouter to the mail database 
of user A. As soon as user A opens his/her IBM/Lotus Notes mail application, the 
fax message is displayed as a new message. He/she may open and view it in his/
her mail application.
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2.2.2  Integrated Messaging (IM)

For IM a so-called inbox replication from a user's IBM/Lotus Notes mail database 
to his/her XPR mail database on the XPR server and vice versa takes place. The 
advantage of Integrated Messaging is that a user can read messages in his/her 
IBM/Lotus Notes mail application, but also retrieve this message e.g. via a 
telephone from the XPR server.

The inbox replication is performed in both directions, i.e. from the IBM/Lotus 
Domino server to the XPR server as well as from the XPR server to the IBM/Lotus 
Domino server. These procedures will be explained with the help of the following 
two examples.

2.2.2.1  Inbox Replication from IBM/Lotus Domino to XPR 

User A sends user B an e-mail via the IBM/Lotus Notes client. Since user B is 
sales representative and thus cannot always check his e-mail messages via his/
her IBM/Lotus Notes client in the company, user B exclusively uses the XPR 
server to retrieve his/her latest messages. However, he/she can only retrieve the 
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messages that have been received directly via the XPR server (e.g. a fax 
message that has been received from outside). He/she is not able to retrieve e-
mail messages from the XPR server that have been sent to him/her via IBM/
Lotus Notes without IM (inbox replication). 

The e-mail that user A sends to user B via IBM/Lotus Notes is at first copied from 
the mail database of user A to the server mail-database of the IBM/Lotus Domino 
server (mail.box). The IBM/Lotus Notes mailrouter transfers this message to the 
IBM/Lotus Notes mail database of user B. From here user B can open and read 
the e-mail in his/her IBM/Lotus Notes mail application. Since this transmission 
process is performed in IBM/Lotus Notes, XPR server is not informed so that user 
B can only access this message via his/her IBM/Lotus Notes client. 

If however IM has been activated, the XPR dispatcher agent running on the IBM/
Lotus Domino server creates a copy of the received e-mail and sends it to the 
foreign domain defined during the Lotus Notes APL installation (gateway mailbox 
notesgat.box). The Lotus Notes APL regularly checks the gateway mailbox for 
new messages. 

If a new message is found, the Lotus Notes APL copies it from the gateway 
mailbox via the MTA to the XPR mail database of user B. User B can now access 
his/her XPR mail database by telephone and have the received e-mail read out 
e.g. via Text-to-Speech.

2.2.2.2  Inbox Replication from XPR to IBM/Lotus Domino

An external originator sends a fax message to user A. The fax is at first received 
by the Telematic APL of the XPR server (e.g. ISDN-APL) and transferred to the 
MTA.
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The MTA enters the document once in the XPR mail database of user A and at 
the same time hands a copy over to the Lotus Notes APL. The Lotus Notes APL 
transfers the fax message to the IBM/Lotus Notes mailrouter, which stores the 
document in the IBM/Lotus Notes mail database of user A. 

When the fax message has arrived at the IBM/Lotus Notes mail database of user 
B, the XPR dispatcher agent creates a so-called “link mail” from the incoming fax 
message. This “link mail” serves for the synchronization of the document 
information (e.g. Message ID) between the fax document in the IBM/Lotus Notes 
mail database and the fax document in the XPR mail database. The XPR 
dispatcher agent sends the link mail to the gateway mailbox notesgat.box. The 
Lotus Notes APL fetches it from here and sends it to user B's XPR mail database.

In this example, user B is able to open a received message as well in his IBM/
Lotus Notes client as to retrieve it via the XPR server.

2.2.3  True Unified Messaging (TUM)

For TUM in contrast to Integrated Messaging no inbox replication takes place but 
the data storage or the mail databases of the foreign system (e.g. IBM/
Lotus Notes) are directly accessed. The advantages are that data need not be 
kept twice as with IM and long waiting periods caused by replication can be ruled 
out since the foreign system transmits the requested messages nearly in real-
time. 
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TUM and IM can be operated on the XPR server in parallel. For each single user 
you can define whether to use IM or TUM.

NOTE:  To use TUM, the Lotus Notes Unified Messaging APL (LnUmAPL) must 
be installed in addition to the Lotus Notes APL (LNAPL).

2.2.3.1  TUM Functionality

User A sends user B an e-mail via the IBM/Lotus Notes client. User B is sales 
representative and retrieves his/her messages mostly via telephone. 

The e-mail is first stored in the IBM/Lotus Notes mail database of user A and then 
sent by the IBM/Lotus Notes mailrouter to the IBM/Lotus Notes mail database of 
user B. Since no inbox replication takes place with TUM as with IM, the e-mail is 
exclusively stored in user B's IBM/Lotus Notes mail database. 

When user B retrieves this e-mail e.g. via telephone, the Lotus Notes Unified 
Messaging APL (LnUmAPL) first accesses the administration database, reads 
out the user information stored there (relationships between IBM/Lotus Notes 
and XPR) and checks in the Domino Directory which IBM/Lotus Notes mail 
database user B uses. Subsequently the LnUmAPL directly accesses the mail 
database of user B and forwards the e-mail to the MTA, which routes the e-mail 
via the Telematic APL to the telephone that user B uses for message retrieval. 

If user A sends user B a fax message via a fax device instead of an e-mail, the 
externally received fax message is stored in user B's IBM/Lotus Notes mail 
database via the Lotus Notes APL (LnAPL) with UM (see also example in Section 
2.2.1.2, “Receiving a Fax Message”, on page 19). User B can then retrieve the 
fax message via TUM.
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2.3  Computer Telephony Integration (CTI)

The term CTI comprises all functions that enable a logical linking of data and 
telephone services. The key to this is the connection of a computer workstation 
to a telephone. A simple case of a CTI application can be e.g. starting a defined 
PC application when a call arrives at the telephone terminal device. This can be 
extended at will, so that an incoming call can be linked to more complex, 
computer-based workflows, for example reading caller-specific information out of 
a database with subsequent preparation and representation. 

CTI works the other way round just as well. A good example is the setup of a 
communication connection to a telephone user from a computer application. The 
most simple form of such an application is a so-called dialer, which establishes a 
phone connection with the entered number at the push of a button.

2.3.1  CTI Functions

CTI provides different features for controlling and monitoring PBX systems and 
telephone devices. The most important ones are: 

• Control of telephone devices (accept call, establish connection, show 
display information etc.)

• Control of telecommunication connections (initiating connection setup, 
conferences, “park calls”, “alternate” etc.)

• Creation of CTI journals, to provide a complete telephone activities list.
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2.3.2  CTI Functions under IBM/Lotus Notes

If you operate the IBM/Lotus Notes Gateway under IBM/Lotus Notes, you have 
two options to use the CTI functions:

a) Integration of the dialer SimpleDialer in an UM mail template. This 
version requires the additional installation of the CTI-Light script in the 
Telematic APL of the XPR server (see also Section 2.4, “CTI Light”, on 
page 26). 

b) Usage of the additional software optiClient 130 for Notes. In case of this 
version you need not perform any modifications to a mail template.

optiClient 130 for Notes is based on IBM/Lotus Notes and extends or uses its 
existing functionality.

The most important functions are listed below. 

• Logging calls
A call dialog opens automatically for each inbound and outbound call. The call 
dialog contains the date and time of the call as well as the name of the calling/
called party or the phone number. You can enter notes for each call. You can 
specify whether a journal item and/or a task are to be created in IBM/Lotus 
Notes for each call. 

• Initiating calls via IBM/Lotus Notes
optiClient 130 for Notes allows you to initiate a call from a IBM/Lotus Notes 
item (contact, journal entry, task, e-mail or appointment). 

• Using convenient telephony functions
You have access to typical telephony functions such as alternate, conference, 
forwarding, etc. 

• Managing List of missed calls
If the caller hangs up without you having accepted the call, optiClient 130 for 
Notes closes the call dialog again and generates a task item. The last six calls 
of that type are also displayed in the Missed calls context menu linked to the 
telephone icon so that you can directly initiate a callback. You can also 
generate a journal item instead of a task item. 

• Picked up calls: Sending notification
If you pick up a call that was directed to another user (telephone system group 
function or call forwarding), optiClient 130 for Notes opens a call dialog in 
which the e-mail address of the user who was originally being called and the 
name of the caller are displayed. You can also generate a journal item instead 
of a message. 
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2.4  CTI Light

In association with a SimpleDialer the CTI Light function can be used to establish 
a call connection via telephone. 

For using the SimpleDialer, the IBM/Lotus Notes mail template must be extended 
by two design elements (cf. section “SimpleDialer Usage” on page 101).

The CTI Light script is automatically installed during the installation of a Telematic 
APL (e.g. ISDN APL). After the installation, further configurations are required, 
the description of which is provided in the Server Administration manual. 

NOTE:  So that the users can use the SimpleDialer, specify the computers' IP 
addresses or an IP address range in the SMTP APL. Information on how to 
configure the SMTP APL is contained in the Server Administration manual.

Usage of the SimpleDialer is described in the IBM Notes Extensions manual.
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Installation of the IBM/Lotus Notes Gateway

Graphic Overview of the Installation Process

3  Installation of the IBM/Lotus Notes Gateway

Before you start the installation, please read Chapter 2, “Realization Concept”.

3.1  Graphic Overview of the Installation Process

The following figure shows the installation process of the IBM/Lotus Notes 
Gateway. The entire process is divided into three consecutive sections for 
simplification. After each installation section a functionality check takes place. 
Print out this page for a better overview and checkmark completed worksteps on 
the printout.
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3.2  Installation Requirements on the XPR Side

3.2.1  Hardware Requirements of the XPR Server

For information about the hardware requirements of the XPR server please refer 
to the Server Installation manual.

3.2.2  Software Requirements of the XPR Server

In addition to the software requirements outlined in chapter two of the Server 
Installation manual, a IBM/Lotus Notes client of the supported versions must be 
present on the XPR server.

IMPORTANT:  Operating a IBM/Lotus Domino server and an XPR server in 
parallel on a server computer is not possible. In principle, XPR server and IBM/
Lotus Domino server are used on separate computers.

While you install the IBM/Lotus Notes client on the XPR server computer you 
need to specify the name of the Domino server incl. certifier (Domino tree/organi-
zation tree). Routing will otherwise not work. In case of doubt please check the 
content of the following registry key:

HKLM\Software\Wow6432Node\PP-COM/MRS\LNApl\Notes Connec-
tions\<domain>\GatewayServer
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3.2.3  Checking the Installation Requirements by 
Notes FailSafe

The Notes FailSafe tool checks whether the following requirements for setting up 
the LnAPL have been met and the configurations are correct:

• Installation of IBM/Lotus Notes (directories and DLLs)

• User privileges for accessing the IBM/Lotus Domino server and the required 
databases

The LnAPL connects the XPR server to a IBM/Lotus Notes client that is 
connected to a IBM/Lotus Domino server.

Execute the following steps:

1. Verify that the following conditions have been met on the computer on which 
you wish to install the XPR server:

a) Microsoft Visual C++ 2005 Distributable Package installed

b) A IBM/Lotus Notes client connected to the corresponding IBM/Lotus 
Domino server must have been configured.

c) The IBM/Lotus Notes client and all other IBM/Lotus Notes applications 
must have been shut down before you execute Notes FailSafe.

2. On the computer on which you wish to install the LnAPL or XPR server 
execute the 
XpressionsInstall\Prerequisites\NotesFailSafe.exe
file on the XPR installation medium.
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3. Click on Next.

4. Enter the setup directory of the IBM/Lotus Notes client and IBM/Lotus Notes 
data directory and the configuration file path.

5. Click on Next.

6. Enter the name of the IBM/Lotus Domino server and IBM/Lotus Notes 
domain, the user ID, and the password.
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7. Click on Next.

8. Click on Run Test to start the check.
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9. Click on Failed to receive a troubleshooting notice.



GatewayInstallation.fm

Installation of the IBM/Lotus Notes Gateway

Installation Requirements on the IBM/Lotus Notes Side

A31003-S2370-M102-9-76A9, 08/2016
OpenScape Xpressions V7 IBM Notes Gateway, Installation and Administrator Documentation 33

          

3.3  Installation Requirements on the IBM/Lotus Notes Side

Hardware requirements of the IBM/Lotus Domino server

For information on the hardware requirements of the IBM/Lotus Domino server 
please refer to the IBM/Lotus Domino product documentation.

Software requirements of the IBM/Lotus Domino server and the IBM/Lotus 
Notes client

The IBM/Lotus Notes gateway can cooperate with IBM/Lotus Domino servers 
and clients of the supported versions except Lotus Domino 6.0.

IMPORTANT:  The IBM/Lotus Notes Gateway cannot be used in an xSP Domino 
environment. 
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3.3.1  Hardware Requirements on the Client

You find hardware and software requirements in the Release Notes, in the 
Release Notice for the XPR server and in the Client Installations manual.

3.3.2  User ID for the IBM/Lotus Notes Gateway

The IBM/Lotus Notes Gateway connects to the Domino Server via the IBM/Lotus 
Notes client that is installed on the same computer as the XPR server. Therefore 
a user ID must be created before the gateway installation that is used by the 
client. This user ID must be provided with special user rights so that the IBM/
Lotus Notes Gateway functionality can be ensured. 

A differentiation is made between user rights required for the installation and 
configuration of the gateway and user rights that are necessary for the later 
operation of the gateway.

NOTE:  
If it is not possible to provide the user ID with the required user privileges for 
security reasons, an installation with limited privileges must be performed (cf. 
Section 3.4.2, “Installation with restricted User Privileges”, on page 52).

3.3.2.1  Required Installation and Configuration Privileges

For the IBM/Lotus Notes Gateway installation and configuration the user ID must 
have the following privileges: 

• Access authority for the Name and Address Books of the IBM/Lotus Notes 
Domain. The user ID must have Editor rights for the name and address 
books of the domain and must have the roles NetCreator and NetModifier. 
The editor privileges must include the right to delete documents.

• Access privilege for the database template Mail Router Mailbox 
(StdNotesMailbox, Mailbox.ntf) as Manager. 

• Privilege to create databases. The user ID must have the privilege to create 
new databases on each of the Domino servers with which the Lotus Notes 
APL is to communicate. This authority is required during the installation of a 
Foreign Domain.

• When TUM is used, the user ID must have manager rights for the user 
mailboxes. This user right must be maintained for the later operation of the 
IBM/Lotus Notes Gateway. 
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After the user ID has been provided with the necessary authorizations, you 
should perform a functionality check. Therefore, use the IBM/Lotus Notes client 
that is installed on the XPR server and log in at the IBM/Lotus Domino server with 
the gateway user ID. Check then if the user ID is able to comply with the 
properties required above.

3.3.2.2  Required Operation Privileges

After the installation and configuration of the IBM/Lotus Notes Gateway the 
privileges of the applied user ID can be set back to the following privileges: 

• Read privileges for the IBM/Lotus Notes domain Name and Address 
Books.

• You can withdraw the access rights for the database template Mail Router 
Mailbox (StdNotesMailbox, Mailbox.ntf) because they are no longer needed.

• You can withdraw the privilege for creating databases because it is no longer 
needed.

• When TUM is used, the manager privilege for using the user mailboxes 
must be preserved.

IMPORTANT:  When TUM is used, this user ID or the IBM/Lotus Notes client 
installed on the server allows to access all messages of all users. Make sure 
that no one has unauthorized access to this user ID or this IBM/Lotus Notes 
Client.
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3.4  Installation Process

The IBM/Lotus Notes Gateway installation is performed during an XPR server 
installation. You need a valid license key to use the gateway. There is one license 
key for the LnAPL and one for the LnUmAPL. 

You settings are checked during the gateway installation. For example, a check 
is performed as to whether the Domino server is available and whether the 
gateway ID-file specified has the required privileges. If, for example, this ID-file 
does not have all required privileges, you receive an error message that points to 
the missing privileges. You can then change the gateway ID-file accordingly and 
continue with the installation without interruption. 

Check the following before the installation process: 

• A IBM/Lotus Notes client must be installed on the XPR server computer. If this 
is not the case, the IBM/Lotus Notes Gateway will not be displayed during the 
later selection of the XPR server components to be installed.

• The connection between the IBM/Lotus Notes client installed on the XPR 
server computer and the IBM/Lotus Domino server must run using the 
required gateway user ID (see also the information in Section 3.3.2.1, 
“Required Installation and Configuration Privileges”, on page 34).

If all conditions mentioned above are met, you may start the installation process. 
Proceed as follows:

1. Follow the installation process as described in the Server Installation manual.
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2. When the XPR setup program has reached the Select components dialog, 
you have to select the Lotus Notes Gateway component in the selection list 
under Messaging and Directory Integration. If you want to use TUM, select 
additionally the Lotus Notes True Unified Messaging Gateway component. 
Continue the dialog with Next.

3. Follow the XPR setup program until it displays the Lotus Notes Gateway 
Setup Wizard.

In this dialog you need to enter the local directory paths for the Lotus Notes 
client program, the Lotus Notes data directory and the Lotus Notes 
configuration file (notes.ini) on the XPR server computer. The Setup Wizard 
determines the data from the local IBM/Lotus Notes client installation. Only 
modify the paths if they are not conform with your system settings. 

Click the Next button. Up comes this dialog: 
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4. Specify the Lotus Notes Domain name, if it has not been correctly entered 
yet, and the Password for the User ID of the IBM/Lotus Notes Gateway. 
Check if the correct path has been entered in the user ID field and adjust it if 
necessary. 

The Hierarchical name of the Lotus Notes &server field already displays 
the correct name that the Setup Wizard has detected in the configuration file 
notes.ini. Check these specifications. 

If all specifications are correct, click on Next >. 

NOTE:  After you have clicked on Next, your settings and specifications are 
checked. If the setup routine detects errors here, you can correct them 
without having to interrupt the installation.

If, for example, the gateway ID does not have the required privileges, you can 
correct them on the Domino server and subsequently confirm the corre-
sponding error message. The setup routine then checks the settings for 
correction once more.

Up comes this dialog:

5. In the following dialog assign a name to the foreign domain that uses the IBM/
Lotus Notes Gateway for communication with the IBM/Lotus Domino server. 
By default, the field is preset with the name NOTESGATE. 

IMPORTANT:  When selecting the name, please note that the name of the 
foreign domain has to be unambiguous and must not be used by another 
foreign domain.

If the gateway installation was performed with restricted user privileges (see 
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Section 3.4.2, “Installation with restricted User Privileges”, on page 52), it is 
mandatory to enter the name here that has been assigned in the first step of 
this installation version for the foreign domain (see step 1 on page 52).

Click the Next button.

6. An explanatory text appears. Please read this text attentively and close the 
Setup Wizard with the Finish button.

7. Continue with the XPR setup program as described in the Server Installation 
manual.

8. After the successful XPR server software setup you can either install the IBM/
Lotus Notes plugins for conferences (see Section 3.4.1, “Installation of the 
Conference Plugin for Lotus Notes”, on page 40) or start the XPR server and 
the XPR monitor and subsequently continue with the IBM/Lotus Notes 
Gateway configuration (see Chapter 4).
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3.4.1  Installation of the Conference Plugin for 
Lotus Notes

The conference plugin for Lotus Notes enables initiating voice conferences, web 
conferences and combined voice/web conferences from IBM/Lotus Notes. How 
to install the plugin:

3.4.1.1  Installation on the Client Computer

1. Start the AddOn\Client\LotusNotes\LnConfPlugin\Setup.exe of 
the XPR installation medium from the client computer.

2. Click the Next button.
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3. Click the Install button.

4. The following dialog appears:

5. Click on the Finish button.

6. Verify that the line EXTMGR_ADDINS=extmgroc.dll was inserted in the 
notes.ini file. You typically find this file in the C:\Program 
Files\lotus\notes directory. 

7. Check whether the following files were added to the same directory:

• extmgrOC.dll,

• ndbOC.dll,

• toolbar_confagent.dxl,

• toolbar_conficon.dxl and

• toolbar_confoutline.dxl



Installation of the IBM/Lotus Notes Gateway

GatewayInstallation.fm

Installation Process

 A31003-S2370-M102-9-76A9, 08/2016
42 OpenScape Xpressions V7 IBM Notes Gateway, Installation and Administrator Documentation

         

3.4.1.2  Modifications to the IBM/Lotus Notes Mail Template

NOTE:  If you use IBM Notes 9.0 Social Edition (Basic Configuration) and IBM 
Domino 9.0 Social Edition, use the mail templates for Lotus Notes 8.

IMPORTANT:  The instructions are divided into the sections Script library, 
Recompilation, Conference menu, Code change and Activation. Be sure to follow 
the instructions in exactly this order.

1. Start the IBM/Lotus Domino Designer client on a computer from which you 
can access the IBM/Lotus Domino server that hosts the mail template 
databases of the IBM/Lotus Notes users. 

Script library

2. Open in the IBM/Lotus Domino Designer client the conf.ntf file in the
XpressionsInstall\AddOn\Client\LotusNotes\LnConfPlugin
directory of the XPR installation medium.

3. Click on the Code > Script Libraries library.

4. Mark the entry that, except for English, names the language to be used in the 
mailbox of the IBM/Lotus Notes user on the client computer.

Examples:

• English: cyConference

• German: cyConference_de-DE

• French: cyConference_fr-FR

• Italian: cyConference_it-IT

• Portuguese (Portugal): cyConference_pt-PT

• Portuguese (Brazil): cyConference_pt-BR

5. Copy this entry to the clipboard.

6. Open the mail template database of the client on the IBM/Lotus Domino 
server. The mail template database typically has the file name mail7.ntf, the 
title Mail (R7) and the template name StdR7Mail.

IMPORTANT:  If the mail template extensions (see Section 4.4, “Mail 
Template Extensions”, on page 75) are already installed, the mail template 
database typically has still the title Mail (R7), but it has, for example, the file 
name mail7_um.ntf and the template name StdR7Mail/de_um.
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For this step and up to step 10 on page 43 as well as from step 16 on page 
45 to step 26 on page 46 you need at least a developer's privileges to access 
the mail template database. You can modify the access privileges in the 
access control list (ACL). If you click this database in the workspace of the 
Notes client with the right mousebutton and select Database > Access 
Control..., the access control list opens. 

For the persons, servers and groups displayed in the field on the left hand 
side you can set the access privileges in the Access field and in the 
checkboxes thereunder.

7. After you have made your settings, click on the OK button.

8. Click on the Code > Script Libraries library.

9. Insert the clipboard. 

Recompilation

10. Select in the menu Tools > Recompile All LotusScript.
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Conference menu

11. Open in the IBM/Lotus Domino Designer client the conf.ntf file in the
XpressionsInstall\AddOn\Client\LotusNotes\LnConfPlugin
directory of the XPR installation medium.

12. Click on the Forms directory.

13. Doubleclick the Conf entry that names in the Language column the language 
used in the mailbox of the IBM/Lotus Notes user on the client computer.

14. Select the Conference action and copy it to the clipboard.

15. Open the mail template database of the client on the IBM/Lotus Domino 
server (compare step 6 on page 42). 
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16. Click on the Forms directory.

17. Click on the Alias column caption to sort according to this column. 
Doubleclick the entry for which the Alias column features the Appointment 
value and the Name column the _Calendar Entry value.

Example of other languages:

• English: _Calendar Entry

• French: _Entrée d’agenda

• Italian: Vo_ce del diario

• Spanish: E_ntrada de agenda

• Portuguese (Portugal): _Entrada da agenda

• Portuguese (Brazil): Entrada na_Agenda

• Dutch: _Agenda-item

IMPORTANT:  
Do not click the entry that has value _wCalendar Entry in the Name column.
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18. Select the Categorize action.

19. Insert the clipboard. The Conference action will then be inserted under the 
Categorize action.

20. Click with the left mousebutton on the Conference action just inserted, keep 
the mousebutton pressed, drag the mouse over the Categorize action and 
release the mousebutton again. The Conference action is now in top 
position.

Code change

21. Click the Objects tab beneath the form.

22. Select Appointment (Form) > (Options).

23. Enter the following code in the Appointment (Form) : (Options) area on the 
right:

Use “<script library>”

Here, <script library> is the name of the library you selected in step 4 
on page 42.

24. Click Appointment (Form) > Queryclose on the Objects tab.

Code is automatically created in the Appointment (Form) : Queryclose 
area.

25. In this code, prefix the line

End Sub

with the following line:

Call AutoUpdateConference(csEventObj)

26. Save the form.
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Activation

27. Open a IBM/Lotus Notes client from which you can access the mailbox of the 
IBM/Lotus Notes user.

28. This dialog prompts you to specify the password for the first time after the 
conference-plugin installation. This is the moment when the conference 
toolbar is provided to the IBM/Lotus Notes client.

Enter the password and click on OK.

29. Click in the workspace with the right mousebutton on the mailbox of the IBM/
Lotus Notes user who is to deploy the conference plugin.

30. Select the menu option Database > Refresh design.... This menu option 
reads in other languages:

• German: Datenbank > Gestaltung aktualisieren....

• French: Base de documents > Actualiser conception...

• Italian: Database > Aggiorna impostazione...

• Spanish: Base de dados > Actualizar diseno...

31. Select the IBM/Lotus Domino server on which the mail template is found that 
you just have modified and click the OK button. 

32. Click the Yes button.

33. Start IBM/Lotus Notes on the client computer. This step is necessary because 
the conference icon is installed during the initial IBM/Lotus Notes client start 
after the conference-plugin setup.

34. If there is no profile for the MSP, a dialog opens in which you are asked 
whether you want to create a new profile.
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a) Click the OK button.

b) Click the New... button.

c) Enter a profile name and, if required, also the user ID, server name and 
the password. Click the Add button.

d) Click on the Finish button.

35. The IBM/Lotus Notes client starts. You then need to start the IBM/Lotus Notes 
client a second time so that the conference icon appears in the toolbar:
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Via this icon you reach the Conferences dialog of the OpenScape Web 
Client. In this dialog you receive an overview of all scheduled telephone 
conferences and may make adjustments if required. Please obtain further 
information about editing conferences in the OpenScape Web Client from the 
OpenScape Web Client manual.

NOTE:  For a reinstallation of the icon, set the key 
HKCU\SOFTWARE\Siemens\optiClient\RunConfToolbarSetup in 
the registry to value RUN (type REG_Z).

If the icon is not displayed, perform the following steps:

a) Before you start IBM/Lotus Notes, set the following key (type REG_SZ) in 
the registry to value DONE:

HKCU\Software\Siemens\optiClient\RunConfToolbarSetup

b) Open in the IBM/Lotus Domino Designer client the conf.ntf file in the
XpressionsInstall\AddOn\Client\LotusNotes\LnConfPlugi
n
directory of the XPR installation medium.

c) Click on Shared Resources, then on Images.

d) Select the Toolbar_CfIcon.gif entry and copy it to the clipboard.

e) Open the mail template database of the client on the IBM/Lotus Domino 
server. The mail template database typically has the file name mail7.ntf, 
the title Mail (R7) and the template name StdR7Mail.

IMPORTANT:  If the mail template extensions (see Section 4.4, “Mail 
Template Extensions”, on page 75) are already installed, the mail 
template database typically has still the title Mail (R7), but it has, for 
example, the file name mail7_um.ntf and the template name StdR7Mail/
de_um.

f) First click on Shared Resources, then on Images.

g) Insert the clipboard.

h) Close the IBM/Lotus Domino Designer client.

i) Start the IBM/Lotus Notes client.

j) Select in the File menu Preferences.

k) In the navigator, on the left hand side, click on Toolbar > Customize.

l) Click the New button in the Available Buttons section and select the 
Button... menu option.
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m) Enter value Conference Overview in the Button caption text field.

n) Enter value Conference Overview in the Popup help text field.

o) Enter the following value in the Formula field:

URL:=@DbCommand(“OC”; “GETURL”; “OVERVIEW”); 
@If(@IsNull(URL[1]); ””; @Command([Execute]; 
@Right(URL[1]; “:”); ““))

NOTE:  
The word-wraps in the input are not required.

p) Click the Change Icon button.

q) Select the Toolbar_CfIcon.gif entry and click on OK.

r) Click the OK button.

s) Click the OK button.
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3.4.1.3  Conference Logging

Conference logging of the conference client

To create log outputs for the conference plugin for IBM/Lotus Notes, set in the 
registry on the client computer the key 

• HKLM\Software\Wow6432Node\Cycos AG\UnifiedLog\LogActive 
to 1 (type REG_DWORD) and value 

• HKLM\Software\Wow6432Node\Cycos AG\UnifiedLog\LogFilter 
to 65535 or 0xFFFF (type REG_DWORD).

Install Microsoft DebugView on the client computer.

Conference logging of the XPR server

The conference server log is stored on the XPR computer in the file <<XPR 
Install>\UCC\equinox\log\symphonia.log.
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3.4.2  Installation with restricted User Privileges

This section describes the IBM/Lotus Notes Gateway installation in an 
environment where no advanced user privileges were assigned to the user ID. 
The first three steps must be performed by the system administrator, since 
administrative user privileges are indispensable for these jobs. 

Proceed as follows:

1. The system administrator must create the foreign domain (e.g. 
NOTESGATE) as well as the alias domains (e.g. for FAXG3, VOICE, SMS) 
in the Domino Directory. 

IMPORTANT:  The name of the foreign domain assigned here must be 
entered in the Setup Wizard during the later IBM/Lotus Notes Gateway instal-
lation (cf. step 5 on page 38 of the installation description).

2. The mail database belonging to the foreign domain (e.g. notesgat.box) must 
be created by the system administrator. The user ID of the IBM/Lotus Notes 
Gateway must receive the Delete editor and documents privileges for this 
database. 

IMPORTANT:  In some IBM/Lotus Notes versions the Delete document 
privilege is not part of the editor access rights. Verify that the privilege is 
assigned at any rate. 

If the mail database of the foreign domain is to be cluster-replicated, its name 
must end in .nsf (e.g. notesgat.nsf), since in the cluster manager only 
databases with this suffix can be selected.

3. If TUM is to be used, the administrator must provide the user ID with Manager 
privileges to access the mail databases of the users.

When these steps have been performed by the system administrator, you may 
start with the IBM/Lotus Notes Gateway installation in the following steps:

1. Install the IBM/Lotus Notes client on the XPR server computer. Use the user 
ID designed for the IBM/Lotus Notes Gateway (the ID with the restricted user 
privileges).

2. After the IBM/Lotus Notes client installation you need to install the XPR server 
software with the IBM/Lotus Notes integration (see Section 3.4, “Installation 
Process”, on page 36).

3. If the installation of the XPR server software and the IBM/Lotus Notes 
Gateway has been performed successfully, the XPR server must not be 
started.
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4. Open the registry editor and perform the following settings:

Enter the name of the mail database of the foreign domain in the following key 
(e.g. notesgate.box): 

HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LnApl\
Notes_Connections\Notesgate\GatewayDatabase

5. You can optionally enter further alias domains via Edit > Add value:

How to enter an alias domain: 

a) Enter the Value Name in the corresponding field in the syntax 
AliasDomains[Service] (e.g. AliasDomainsFaxg3 for the alias 
domain of the FAXG3 service). 

b) Select REG_MULTI_SZ as data type. 

c) Confirm your entries with OK and enter one or several names for the alias 
domain in the following dialog (e.g. AnalogFax). 

d) Confirm this entry with OK. You have now created a value in the form 
AliasDomainsFaxg3=AnalogFax. 

e) Repeat the steps a to d for further alias domains.

6. After you have performed all necessary settings in the registry, you may close 
the registry editor.

7. Start the XPR server and the XPR monitor and continue with the IBM/
Lotus Notes Gateway configuration. Please refer to Chapter 4.
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Configuration and Extension

4  Configuration and Extension

Subsequent to the installation performed in Chapter 3, the configuration of the 
IBM/Lotus Notes connection will be completed and extended in this chapter. 

NOTE:  Since the extension of the IBM/Lotus Notes Gateway features depends 
on the customer requirement, in this chapter only a few practical examples will be 
given.

Proceed as follows:

1. Functionality check to ensure the basic functionality of the IBM/Lotus Notes 
Gateway (Section 4.1, “Basic Functionality Check”, on page 56).

2. Creation of an administration database on the IBM/Lotus Domino server 
(Section 4.2.1, “Creation of the Administration Database”, on page 61).

3. Activation of the administration database in the configuration dialog of the 
IBM/Lotus Notes Gateway (Section 4.2.2, “Activation of the Administration 
Database”, on page 64).

4. Creation of alias domains in the configuration dialog of the IBM/Lotus Notes 
Gateway (Section 4.2.3, “Creating an Alias Domain”, on page 66).

5. Create user in the administration database and synchronization with the XPR 
system (Section 4.2.4, “Creating User Data Records”, on page 68).

6. Functionality check to ensure the extended functionality of the IBM/
Lotus Notes Gateway (Section 4.3, “Extended Functionality Check”, on page 
74).

7. Simplification of message transmission and reception using Unified 
Messaging mail templates (Section 4.4, “Mail Template Extensions”, on page 
75).

8. Installation of IBM/Lotus Notes client components (Section 4.5, “Installing 
IBM/Lotus Notes Client Components”, on page 109).

9. Check of Unified Messaging mail databases for correct functionality (Section 
4.6, “Checking the Unified Messaging Mail Databases Functionality”, on page 
110).
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4.1  Basic Functionality Check

Before you perform further configuration steps, you should first check if the IBM/
Lotus Notes Gateway basic functions work correctly. After you have successfully 
completed the basic functionality check, you may start configuring or extending 
the IBM/Lotus Notes Gateway according to your requirements. 

4.1.1  Check-up Steps on the XPR Side

1. Start the XPR server.

2. Open the XPR monitor and check if the LnAPL starts correctly and connects 
with the gateway domain (e.g. NOTESGATE) on the IBM/Lotus Domino 
server.

Pay attention to all messages that are displayed in the windows Default 
Logging and Error Logging. 

• A successful LnAPL start is issued in the Default Logging with the 
following, green, message: 

LnAPL version 6.00.27(Win-NT)Release Build 4487,OK.

If the LnAPL has connected with the gateway domain on the IBM/Lotus 
Domino server, this is displayed in the Physical Lines window. 

NOTE:  If you have selected the LnUmAPL in addition to the LnAPL, it starts 
with an error message and is then stopped. However, this is not unusual, 
since the LnUmAPL requires a connection between the LnAPL and the 
administration database on the Domino server. This requirement is not yet 
met.
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3. If error messages come up during the start of the LnAPL, please check the 
following issues:

• Is the IBM/Lotus Notes client installed on the XPR server able to log in at 
the Domino server using the IBM/Lotus Notes Gateway user ID? 

• Is it possible to create a database and a foreign domain on the Domino 
server with the local IBM/Lotus Notes client using the IBM/Lotus Notes 
Gateway user ID?

• For TUM: Can the local IBM/Lotus Notes client open the users' Notes mail 
databases using the user ID of the IBM/Lotus Notes Gateway?

• If all these check-up steps were be performed successfully, but the LnAPL 
still does not start correctly, there might be an installation error. In this 
case, check whether all installation preparation requirements have been 
met (cf. Section 3.2, “Installation Requirements on the XPR Side”, on 
page 28) and, if required, perform the installation again (cf. Section 3.4, 
“Installation Process”, on page 36).

4. After a successful functionality check on the XPR side, continue with the 
check-up steps on the IBM/Lotus Notes side.
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4.1.2  Check-up Steps on the IBM/Lotus Notes Side

1. Check in the logging window of the IBM/Lotus Domino server, if the 
LnAPL could log in with the user ID. If the user ID has, for example, received 
the user name gateway and is registered in the IBM/Lotus Notes domain 
doc-test, you find the following entry in the server log:

Opened Session for gateway/doc-test (Release 6.5.1). 

2. Start the IBM/Lotus Domino Administration client and check if

• a foreign domain has been created in the Domino Directory of the IBM/
Lotus Domino server (e.g. the domain NOTESGATE) and

• if a gateway mailbox has been created (e.g. the mailbox notesgat.box).

IMPORTANT:  The default settings of the mailbox notesgat.box cause 
excess of the mail file quota, since deleted messages are first stored in the 
bin and are only deleted after the Soft Delete Expire Time has expired 
(default: 48h).

Make sure that the Allow soft deletions checkbox in the mailbox properties 
dialog on the Advanced tab is NOT selected. 

NOTE:  If you have performed an installation with restricted user rights, you 
can skip these check-up steps (see Section 3.4.2, “Installation with restricted 
User Privileges”, on page 52).

3. If errors come up on the IBM/Lotus Notes side, first check if the user ID of the 
IBM/Lotus Notes Gateway is provided with the required installation access 
rights (see Section 3.3.2.1, “Required Installation and Configuration 
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Privileges”, on page 34). Furthermore, you may perform the check-up steps 
from Section 4.1.1, “Check-up Steps on the XPR Side”, step 3 for trouble 
shooting.

4. After a successful functionality check on the IBM/Lotus Notes side, continue 
by sending a test message.
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4.1.3  Sending a Test Message

At present the IBM/Lotus Notes Gateway is able to send fax messages from 
within a IBM/Lotus Notes client to a recipient. 

Therefore you may perform a functionality check on the basis of a sent fax 
message. Proceed as follows:

1. Start the IBM/Lotus Notes client on a client computer. Do not use the IBM/
Lotus Notes client that is installed on the XPR server.

2. Log in with the user ID of a regular IBM/Lotus Notes user. Do not use the user 
ID of the IBM/Lotus Notes Gateway for login.

3. Open the IBM/Lotus Notes client mail interface and click the New Memo 
button to create a new message.

4. Send a message to a phone number connected to a fax device. Proceed as 
follows:

Example: Test message to a fax device

The test message is to be sent to the fax device with the phone number 02404/
1234-567. Therefore you must enter this phone number in the To: address field 
in the format: 

024041234567@FAXG3@NOTESGATE 

The parameter faxg3 determines the message format, the parameter 
notesgate is the foreign domain name.

5. Enter the phone number in the address field To: as explained in the example 
and write a short message text.

6. Click the Send button to start sending the message immediately.

7. After a short time, your fax device should put out the message that had been 
sent.

8. If sending the test message has been completed successfully, the basic 
functionality of the IBM/Lotus Notes Gateway has been ensured.

9. Continue the installation of the IBM/Lotus Notes Gateway by creating the 
administration database (see next section).
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4.2  The Administration Database

The administration database is used for the administration of user data (e.g. 
phone numbers for fax, voice mail etc.) under IBM/Lotus Notes. 

NOTE:  If the connection between the server and a client computer is too slow, 
the Notes templates use the local configuration data on the client computer 
instead of retrieving the configuration data from the server to open an XPR 
document. This reduces the waiting time until a document will be opened.

The XPR server controls the administration database and replicates changes or 
new user data automatically to its user database. Similarly, user data that has 
been changed in the XPR server is replicated back to the administration database 
and is thus available with IBM/Lotus Notes. 

Furthermore, the administration database is used for the creation of additional 
features of the Lotus Notes APL (True Unified Messaging, CTI support etc.).

4.2.1  Creation of the Administration Database

A database template is used for the creation of the administration database that 
comes with all supported IBM/Lotus Notes versions. The file name of this 
template is umAdmin.ntf for all versions. 

The database templates of the administration database are stored in the 
installation directory of the XPR server in the following path: 

<XPR Install>\RES\LnApl\TemplatesR6
<XPR Install>\RES\LnApl\TemplatesR7
<XPR Install>\RES\LnApl\TemplatesR8
...

NOTE:  If you use IBM Notes 9.0 Social Edition (Basic Configuration) and IBM 
Domino 9.0 Social Edition, use the mail templates for Lotus Notes 8.

NOTE:  The database template is multilingual. At the moment, 10 languages are 
supported. 

Please proceed as follows to create the administration database:

NOTE:  For the following steps you must have access rights on the IBM/Lotus 
Domino server allowing you to create databases.



Configuration and Extension

Konfiguration_Erweitern.fm

The Administration Database

 A31003-S2370-M102-9-76A9, 08/2016
62 OpenScape Xpressions V7 IBM Notes Gateway, Installation and Administrator Documentation

         

1. Start the IBM/Lotus Domino administration client or the IBM/Lotus Notes 
client and log in to the Domino server.

2. Copy the template file umAdmin.ntf from the XPR server installation 
directory to the IBM/Lotus Domino server data folder. This is the folder 
\Lotus\Domino\Data for a default installation. 

3. Create a new database (File > Database > New).

4. Select the Domino server the IBM/Lotus Notes Gateway cooperates with as 
the storage location of the new database . 

5. Enter a significant name for the new database in the Title field. 

6. If necessary, adjust the file name and storage location of the database in the 
File name field. Generally, nothing needs to be modified here. 

7. Select the Domino server the template has been copied to in step 2 as the 
Template server. The database template of the administration database is 
an advanced template, thus the check box Show advanced templates must 
be selected in the dialog. 

8. Confirm the settings by clicking the OK button. The creation of the 
administration database will then start.
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9. Select one or several languages in the following dialog and confirm your 
selection by clicking the OK button. 

10. After the new database has been created successfully, you need to configure 
the database access rights. Decide which persons are to have access to this 
database and determine their privileges. 

It is especially important to assign the appropriate access rights to the user 
ID which is used by the IBM/Lotus Notes Gateway. This ID needs at least 
editor access rights with the privilege delete documents on the 
administration database. 

IMPORTANT:  In some Lotus Notes R6 versions the Delete document 
privilege is not part of the editor access rights. Make sure that the privilege is 
assigned at any rate. 

NOTE:  If the database cannot be created, check the access rights of the 
template first. You must at least have Read rights for accessing the template.

Furthermore, you need to check if you generally possess the right to create 
databases on the IBM/Lotus Domino server you have selected (you can 
check this in the server document of the IBM/Lotus Domino server on the 
Security tab).

11. Continue the installation of the IBM/Lotus Notes Gateway by activating the 
administration database in the configuration dialog of the IBM/Lotus Notes 
Gateway (see next section). 
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4.2.2  Activation of the Administration Database

In this installation step the administration database on the IBM/Lotus Domino 
server is connected to the IBM/Lotus Notes Gateway of the XPR server.

This connection is required for the replication of user data between the 
administration database and the XPR server on the one hand. On the other hand, 
the Lotus Notes Unified Messaging APL (LnUmAPL) uses this connection to 
realize the True Unified Messaging feature (see Section 2.2.3, “True Unified 
Messaging (TUM)”, on page 22).

Proceed as follows:

1. Start the XPR monitor.

2. In the Components window open the configuration dialog of the LnAPL and 
therein the Administration tab. 

3. Activate the Use administration database option. The parameters that can 
be set will then be released. 

4. The hierarchical name of the IBM/Lotus Domino server on which the 
administration database is stored is normally already entered in the Domino 
Server field. If this is not the case, select the appropriate Domino server here.

5. Enter the file name of the administration database in the field database 
name. If the database is stored in the data directory of the Domino Server, 
you do not need to enter a path. If the entry includes the database name and 
also a path (e.g. XPR\XPRAdmin.nsf), this path is interpreted relatively to 
the data directory of the IBM/Lotus Domino server - if it does not contain a 
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drive name or leading backslashes. Paths with drive names or leading 
backslashes such as E:\XPR\XPRAdmin.nsf or \XPR\XPRAdmin.nsf) 
are not allowed.

6. Activate the Automatic synchronization of user database option.

Activating this option causes the synchronization of the user data records of 
the administration database with the user database. The LnAPL controls the 
administration database and synchronizes the user data records on both 
systems regularly.

7. Activate the Accept database replications option.

Activating this option enables the LnAPL to cooperate with replicas of the 
administration database. If the administration database should not be 
available e.g. when the Domino server breaks down, the LnAPL switches to 
a Domino server where a replica of the administration database is stored.

8. Optionally you may also activate the Restrict gateway access to registered 
users only option.

This function allows only IBM/Lotus Notes users that have been entered in 
the administration database to use the IBM/Lotus Notes Gateway. Users that 
have not been entered are then e.g. not able to send fax messages via the 
IBM/Lotus Notes client.

9. Save the settings via the Apply button and close the configuration dialog via 
the OK button. 

NOTE:  For information on the additional configuration possibilities of this 
dialog please refer to Chapter A, “Configuration of the IBM/Lotus Notes 
Gateway”.

The connection between the administration database and the IBM/
Lotus Notes Gateway has now been established.

10. It is also possible to create alias domains in the configuration dialog of the 
LnAPL that simplify the addressing of messages that are to be sent.

If you do not wish to create alias domains, continue the installation process in 
Section 4.2.4, “Creating User Data Records”, on page 68.
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4.2.3  Creating an Alias Domain

Creating an alias domain simplifies addressing because the syntax <Call 
number>@<Service>@<Foreign Domain> (e.g. 
02404901123@FAXG3@NOTESGATE to send a fax) no longer needs to be 
entered. If an alias domain with the designation FAXG3 is set up, then only the 
syntax <Call number>@<New Alias Domain> (e.g.02404901123@FAXG3) 
needs to be entered. 

To create alias domains proceed as follows:

1. Open the LnAPL configuration dialog in the XPR monitor.

2. Change to the Alias Domains tab in the configuration dialog.

3. Select the already existing foreign domain (in this case NOTESGATE). The 
Add button will thus become active.
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4. Click the Add... button and select the service you wish to create an alias 
domain for from the list field of the next dialog.

5. If you change the name created automatically in the Alias domain &name 
field, do not use an already existing alias domain name. Close this dialog via 
the OK button. 

6. The alias domain that has been created is now displayed in the List of the 
available alias domains.
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7. Proceed similarly to create additional alias domains.

8. You can remove a selected alias domain via the Delete button.

9. Save your settings by clicking on the OK button.

NOTE:  Check if the alias domains have been created as additional foreign 
domains on the IBM/Lotus Domino server via the IBM/Lotus Domino admin-
istration client.

10. Continue the installation process in the following section.

4.2.4  Creating User Data Records

Before you start creating user data records in the administration database, you 
need to check the following issues: 

• Which message types are the users allowed to send and receive?

• Have all scripts and extension ranges for these message types been 
configured?

Check if the scripts for the different message types have been created in the 
Telematic APL (ISDN or IP APL) of the XPR server. If users are to apply e.g. 
Voicemail, the Phonemail, VMS or ERGO protocol must exist in the Telematic 
APL and an extension range must have been set. For further information 
please refer to the manual Server Administration.

4.2.4.1  Administration Database for the supported IBM/
Lotus Notes Versions

To create user data records in an administration database for the supported IBM/
Lotus Notes versions please proceed as follows: 

1. Start the IBM/Lotus Domino administration client or the IBM/Lotus Notes 
client and log in to the Domino server.

2. Open the administration database.
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3. In the menu bar of the IBM/Lotus Notes client click the View menu and select 
the Domino Directory Sync menu option. A new configuration interface 
opens. 

4. Push the Create Domino Directory Sync button. A window opens in which 
you need to perform the synchronization process settings. 

• If you want to regularly synchronize the person documents with the Domino 
directory, the synchronization agent must be active (default setting in the 
Agent activated field). The initial activation of the agent opens a dialog in 
which you need to select the IBM/Lotus Domino server on which the 
synchronization agent is to be executed. 
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• The Last time active at field displays the date when the last synchronization 
was performed. 

• Click the link Select... in the Synchronize with field and select in the 
following window the IBM/Lotus Domino server and the Domino Directory 
(names.nsf) of this server. 

• In the Persons in section activate 

– the Group option and then push the Add Groups button, or

– activate the Person(s) option and then push the Add Persons button. 

In the following window select one or several entries from which you want 
to synchronize user data records. 

IMPORTANT:  
If your Notes directory contains a large number of users, the dialog capacity 
may be exceeded and an error message appears. In this case, use the Add 
Groups button in the document header. This button opens a dialog in which 
available groups can be selected. 

• Click the...Default link in the Copy fields section. With this setting, the most 
important user data is assumed from the address book entries. 
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• Then click the ...add Field in the same section. In the following selection 
dialog choose the ShortName parameter under Field in the Lotus directory 
and the MRS_USERID_INPUT parameter under Field in the server 
directory. Confirm the selection with OK. 

NOTE:  
By adding this additional field the automatic creation of a XPR user ID is 
suppressed. The ShortName of the corresponding user is then used as the 
user ID.

• You do not need to make a selection in the Options field.

5. Click the Save and Close button to complete the settings for the address 
book synchronization. You will now come to the main window again.

6. The created synchronization process is displayed in the list of the main 
window. Click the Synchronization button and select the Synchronize now 
option. 



Configuration and Extension

Konfiguration_Erweitern.fm

The Administration Database

 A31003-S2370-M102-9-76A9, 08/2016
72 OpenScape Xpressions V7 IBM Notes Gateway, Installation and Administrator Documentation

         

7. The synchronization process starts. The synchronization process can take a 
while depending on the number of the address book entries that need to be 
synchronized.

NOTE:  
After the synchronization process has been finished, you find the synchro-
nized user data records in the administration database user view.

8. After the synchronization process has been finished successfully, you may 
close the main window of the Domino directory synchronization and change 
to the administration database user view.

9. The user view now shows the following:

• A red dot is displayed in front of each user data record as these data 
records have not been selected for the address book synchronization to 
the XPR server.

• The XPR user ID has been entered in the UM User ID column. The XPR 
system uses this unique ID to identify each user. If the user ID is 
automatically created, an identification is entered in this field starting with 
LNUSER.... 

• In each user data record a FaxG3 number is entered since this phone 
number existed in the address book entry of the user. 



Konfiguration_Erweitern.fm

Configuration and Extension

The Administration Database

A31003-S2370-M102-9-76A9, 08/2016
OpenScape Xpressions V7 IBM Notes Gateway, Installation and Administrator Documentation 73

          

10. If you do not want to send the user data to the XPR server at this point of time, 
proceed as follows:

• Select all data records and click the Server button.

• Select the UM User Database Synch On option in the menu that pops 
up. 

• All data records that have been selected are now replicated to the XPR 
server and then marked with a green dot. 

NOTE:  
Check if the transmission of the user data records has been successful. 
Therefore, start the Communications client and check if all data records can 
be found in the user group.

11. The creation of the user data records is thus completed for now. You may then 
modify the data records according to your requirements.

• To perform global settings we recommend to create one or several user 
profiles first and to assign these to the users afterwards. The creation of 
user profiles is described in Section B.1.2.6, “The Profile Document”, on 
page 160.

• All parameters you can set in a user data record, and all additional 
configuration possibilities of the administration database are depicted in 
Chapter B.
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4.3  Extended Functionality Check

The following requirements must be met so that the extended functionality of the 
IBM/Lotus Notes Gateway can be checked. 

• The basic functionality of the IBM/Lotus Notes Gateway must be available 
(see Section 4.1, “Basic Functionality Check”, on page 56).

• The administration database must exist on the IBM/Lotus Domino server (see 
Section 4.2.1, “Creation of the Administration Database”, on page 61).

• The IBM/Lotus Notes Gateway must be connected with the administration 
database (see Section 4.2.2, “Activation of the Administration Database”, on 
page 64).

• Alias domains must exist (see Section 4.2.3, “Creating an Alias Domain”, on 
page 66).

• In the administration database user data records must exist (see Section 
4.2.4, “Creating User Data Records”, on page 68).

• The user data records must have been replicated to the XPR server (see 
Section 4.2.4, “Creating User Data Records”, on page 68).

When you have completed the steps in the previous two sections, you may now 
check the functionality according to the following example:

Example: IBM/Lotus Notes User with Fax and Voice Mail

A FaxG3 number and a voice mail number have been assigned to a IBM/Lotus 
Notes user. His/her user data record exists in the administration database and on 
the XPR server. The user shall now be able to send and receive fax messages 
via his/her IBM/Lotus Notes client as well as to receive and listen to voice 
messages. 

Proceed as follows:

1. Start a IBM/Lotus Notes client of a user who is to use the IBM/Lotus Notes 
Gateway. Do not use the IBM/Lotus Notes client that is installed on the XPR 
server.

2. Open the mail interface in this user's IBM/Lotus Notes client.

3. Send a fax message to a fax device by clicking the New Memo button in the 
IBM/Lotus Notes mail interface and entering an address with the following 
syntax in the address field To::

<Fax phone number>@<Name of the alias domain>. 

If the phone number of the fax device is e.g. 02404/1234-567 and the FaxG3 
alias domain name is FAXG3, you need to use the address 567@FAXG3.

4. Write a short message text and then click Send.
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5. After a short time, your fax device should put out the message that had been 
sent.

6. Send the message you have received on the fax device back to the user's fax 
number.

7. After a successful transmission the IBM/Lotus Notes user must find a 
message in his/her inbox with the attached fax message file.

8. A double-click on the attached file opens it in a new window.

9. If you have assigned the user a voice mail number, call this number from a 
telephone and record a message for this user.

10. The voice mail must be displayed in the IBM/Lotus Notes user inbox after a 
short time. Again a file is attached containing the voice mail.

11. A double-click on the attached file opens it in a media player that is installed 
on the client computer (e.g. Windows Media Player).

4.4  Mail Template Extensions

4.4.1  General Considerations

After you have performed all steps in the sections 4.1 to 4.3, you have 
successfully added the Unified Messaging features of your XPR system to your 
IBM/Lotus Notes system. 
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In order to simplify sending and receiving of the message types the XPR server 
provides for the users, you may add Unified Messaging design elements to their 
IBM/Lotus Notes mail interfaces.

The Unified Messaging design elements come with so-called mail template 
extensions for the supported IBM/Lotus Notes versions. 

NOTE:  You find an overview of all mail template extensions and of the design 
elements contained therein in Section C.1, “XPR Mail Template for the supported 
Versions of IBM/Lotus Notes”, on page 161.

Adding the Unified Messaging design elements to the user mail interfaces has the 
following advantages:

• Addressing is simplified. The recipient addresses no longer need to be 
entered in the form <Phone number>@<Service>@<Foreign Domain> 
or <Phone number>@<Alias Domain>. If a user wants to send e.g. a fax 
message, he/she opens a fax entry form in his/her IBM/Lotus Notes mail 
interface and enters the recipient address as a normal phone number. He/she 
can also use the IBM/Lotus Notes address book to select a recipient. 

• Received fax and voice mails are no longer delivered as file attachments that 
need to be opened with external programs. Thus a received voice message 
is opened in a form with an operating unit so that you can comfortably listen 
to the message. 

• Voice mails can be created and sent. It is not possible to create voicemails in 
the IBM/Lotus Notes mail interface without mail template extensions. 
Therefore a form is added to the mail interface including an operating unit to 
record voice messages. 

The following paragraphs describe the steps for the Unified Messaging 
extensions of the IBM/Lotus Notes mail interface.

The Unified Messaging design elements are added to a default IBM/Lotus Notes 
mail template (mail6.ntf or mail7.ntf). The procedures described are also 
applicable with mail templates already possessing company-specific extensions.

NOTE:  If you use IBM Notes 9.0 Social Edition (Basic Configuration) and IBM 
Domino 9.0 Social Edition, use the mail templates for Lotus Notes 8.

IMPORTANT:  Creating and extending a IBM/Lotus Notes mail template requires 
profound IBM/Lotus Notes knowledge. Thoughtless modifications might cause a 
breakdown of the IBM/Lotus Notes mail interface in the worst case.
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4.4.2  Extended Mail Templates for Lotus Notes R7.x 
and higher

You create extended mail templates for the supported versions of Lotus Notes 
R7.x and higher and IBM Notes using a setup. 

If the extended mail templates are to support several languages, the desired 
language packets must be installed on the Domino server. For the setup 
described here it is sufficient to merely expand the mail7.ntf template with the 
desired languages. For the time being, the Unified Messaging mail template 
(umMail.ntf) supports the following languages:

• German (DE)

• English (EN)

• French (FR)

• Italian (IT)

• Spanish (ES)

• Dutch (NL)

• Portuguese (PT)

• Brazilian (BR)

The extended mail templates created by the setup support the languages 
supported by the Notes mail template mail7.ntf as well as by the Unified 
Messaging mail template. 

The setup is managed via configuration documents. The scope of delivery 
contains some configuration documents that cover scenarios often used. Some 
tailored configuration documents may be defined. Most scenarios, however, are 
mapped via combinations of already existing configuration documents, so that 
some configuration documents are not necessarily required. 

The following configuration documents are already available:

• Complete: Contains a compilation of all functionalities

• Standard: Contains functionalities often used

• CTI: Contains all elements required for CTI

• Fax: Contains all elements required for Fax

• Fod: Contains all elements required for Fax-on-Demand

• IM: Contains all elements required for Integrated Messaging (may also be 
used for TUM)

• SMS: Contains all elements required for SMS
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• Voice: Contains all elements required for Voice

A configuration document is divided into three sections:

Basic Information: 

In this section you enter the Groupname and specify a Grouptype. The 
groupname is freely selectable. The following grouptypes are available:

• Basic: In a basic group all elements required for the basic functionality and/
or for Integrated or Unified Messaging are compiled. During the setup you 
may select several basic groups, so that you can, for example, choose one 
basic group for the basic functionality, and another one for e.g. Integrated 
Messaging.

• Extension: An extension compiles all elements that expand a basic group 
with specific functions. For example, an extension may expand an Integrated 
Messaging basic group with the Fax function. During the setup you can select 
several extensions, of which each only adds a subset of the possible 
functionality (Fax only or Fax and Voice or FoD and Fax ...).

List of design elements to be copied from UM template: 

This section displays all design elements (agents, forms, script libraries, 
subforms and views) that are a component of the configuration document and 
sorts them according to their index. The index complies with the sequence in 
which the design elements are added to the configuration document. 

The list can be folded out or in via the + and - checkboxes. Using the links Add... 
and Delete... you can add design elements to the list or remove them from there.
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Miscellaneous: 

In this section you can enter actions for having necessary modifications to default 
design elements performed. The following actions are available:

• Insert actions and form or view/folder: 
Using this action, menu options are added to the inbox, so that a user may 
access functions such as New Fax or Forward Fax. Adding this option 
requires the performance of further steps:

1. Select the design element (e.g. $Inbox), in which the menu options are to 
be inserted. Then click the OK button.

2. Select the menu options (actions) that are to appear in the above design 
element (e.g. Cycos New Fax, Cycos Forward Fax, Cycos Reply Fax). 
Then click the OK button.

• Modify database script: 
This action modifies the database script to that effect that deleting a 
document in the IBM/Lotus Notes inbox is replicated to the XPR server.

• Add entry in “NotesMailOutline”: 
This action adds the menu options Unified Messaging and Unified 
Messaging > Logging to the default design element $Inbox underneath the 
Tools menu option. 

• Modify Lotus script in the memo form: 
This action modifies the memo form to the effect that modifications to the 
status of a message (unread becomes read etc.) can be communicated to the 
XPR system. This enables the message status modification on the XPR 
server as well.

• Insert column in inbox: 
This action adds another column to the $Inbox default design element, in 
which an envelop icon displays that a message was sent or received via the 
XPR server.

The list can be folded out or in via the + and - checkboxes. Using the links Add... 
and Delete... you can add actions to the list or remove them from there.
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4.4.2.1  Defining individual Configuration Documents

Using your own configuration document you can configure a setup precisely 
adapted to a specific environment. Such a document can be used for a setup 
everywhere. 

We will illustrate the definition of a configuration document based on an example. 
The configuration document created in the example contains the necessary 
extensions for the Fax, Voice and CTI function and supports Integrated 
Messaging. Proceed as follows: 

1. Start IBM/Lotus Domino Administrator client and open the XPR administration 
database.

2. Switch to the configuration view of the administration database. Click on User 
Maintenance and select the Switch to configuration option in the context 
menu.

3. Select the Mail Template Setup entry in the list. An overview displays the 
already available configuration documents:
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4. Click on the New Configuration Document button. A new configuration 
document opens:

5. In the Basic Information section enter a group name and select the desired 
grouptype via the corresponding selection field. The groupname can be freely 
selected.
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6. Add the design documents to become components of your mail template. 
Click the Add... link. The following dialog opens:

Select the design documents that you want to add to the configuration 
document. We need the following elements for the example configuration 
document:

• Basic functionality (first table row)

• Sending and receiving fax messages (second table row)

• Sending and receiving voice mails (fourth table row)

• Integrated Messaging (penultimate table row) 

IMPORTANT:  
Verify that you select all elements in the table intended for the respective 
function. Missing elements lead to compilation errors and the extended mail 
template will not work. 

7. Click the OK button to copy your selection. The selected elements are 
entered in the list.

8. In the Miscellaneous section, add actions to have the setup perform special 
adaptions to default design elements. Click the Add... link. The following 
dialog opens:

9. Select the action Insert actions in form/folder and click on OK. This action 
requires further configuration specifications.

10. Select the design element (e.g. $Inbox), to which the menu options are to be 
added. Then click the OK button.
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11. Select the menu options (actions) to eventually appear in the design element 
(e.g. Cycos New Fax, Cycos Forward Fax, Cycos Reply Fax, ...). Then click 
on OK.

12. Specify the starting position (index) of the new menu options in the menu bar. 
The new menu options will then appear from this position in the menu bar. 
Example:

If you specify starting position 1, the first new menu option will appear 
leftmost in the menu bar, all other to the right of it. The already available 
menu options will be moved to the right.

Afterwards, click on OK. The action Insert actions in form/folder will now be 
entered in the Miscellaneous list.

13. In the Miscellaneous list click on the Add... link. 

14. Add the following actions to the list in succession:

• Modify database script 

• Insert column into inbox 

• Modify Lotus script in the memo form

The action Modify database script is added to the Miscellaneous list. 

15. Save the configuration document via the Save and Close button.



Configuration and Extension

Konfiguration_Erweitern.fm

Mail Template Extensions

 A31003-S2370-M102-9-76A9, 08/2016
84 OpenScape Xpressions V7 IBM Notes Gateway, Installation and Administrator Documentation

         

4.4.2.2  Creating an extended Mail Template

How to create an extended mail template: 

1. Start IBM/Lotus Domino Administrator client and open the XPR administration 
database.

2. Switch to the configuration view of the administration database. Click on User 
Maintenance and select the Switch to configuration option.

3. Select the Mail Template Setup entry in the list.

4. Click the Setup button. Up comes this dialog:
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5. In this dialog you specify the Unified Messaging template (UM template) and 
the Notes mail template on the basis of which the extended mail template is 
to be created. 

The UM template is found in the <XPR install>/res/LnApl/
TemplateR7 respectively <XPR install>/res/LnApl/TemplateR8 
directory. In the Unified Messaging Mail Template section of the dialog click 
on the Select... link to find and select the UM template. 

You find the Notes mail template mail7.ntf in the data directory of the 
Domino server. In the Notes Mail Template section of the dialog click on the 
Select... link to find and select the Notes template. 

After you have selected both templates, click on the arrow icon in the dialog's 
bottom right corner. Up comes this dialog:
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6. This dialog summarizes the languages that are installed. If not all desired 
languages are displayed, click on the arrow icon pointing to the left and select 
in the previous dialog a Notes template that contains all desired languages. 

When all desired languages are displayed, click on the arrow icon pointing to 
the right. Up comes this dialog:

7. Select the basic functionality and the services to be installed. Then click the 
Install button. 

Two actions will now be executed in succession: the selected design 
documents are copied and the default element of the new template are 
modified. Completed actions are indicated in the dialog's top section by a tick. 
The status of all upcoming actions is displayed by the progress bar. 
Depending on your selection, the actions may take a few minutes. When the 
actions are complete, the following dialog is displayed: 
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8. Click on the arrow icon pointing to the right. The Lotus ScriptCode compilation 
starts and the following dialog is displayed:

9. Depending on the computer performance, the ScriptCode compilation may 
take some time. The dialog shows, which component is being compiled. The 
compilation status is indicated by a progress bar. When the compilation is 
complete, the following dialog opens:

See that no errors occur during the compilation. Click on the arrow icon. A 
summary of the setup is displayed:
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10. Click on the Finish button to complete the mail template setup.

11. Replace the user mail-databases design with the design of the just created 
mail template to provide the new functionalities to the users.
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4.4.3  Mail Template Extensions for Lotus Notes R6.x

This section describes the extension of a Unified Messaging mail template with 
the help of an example. This example uses the Lotus Notes default mail template 
(mail6.ntf). 

This template will first be extended with the basic design elements. Depending on 
the requirement, the following Unified Messaging functions can subsequently be 
integrated in the extended mail template. 

• Sending and receiving fax messages

• Polling fax documents (fax-on-demand)

• Sending and receiving voice mails

• Sending and receiving SMS messages,

NOTE:  
Please note that the SMS APL needs to be installed and configured on the 
XPR server for using the SMS service. For detailed information please refer 
to the Server Administration manual.

• SimpleDialer usage 

NOTE:  
Integrating the SimpleDialer in a mail template is only required if you do not 
want to use the additional CTI software optiClient 130 for Notes.

In further sections you learn how to add extensions for Integrated Messaging (see 
Section 4.4.3.5, “Creating Integrated Messaging Mail Templates”, on page 102) 
and/or True Unified Messaging functions (see Section 4.4.3.6, “Creating True 
Unified Messaging Mail Templates”, on page 104) to a mail template already 
extended by Unified Messaging functions.

4.4.3.1  Multi-Language Capability

The mail template extension umMail.ntf for Lotus Notes R6.x/R7.x is multilingual 
and thus contained in the res\LnApl\TemplatesR6 folder only once. 
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For each supported language (see also Section C.1.1, “General Considerations”, 
on page 161) a design element is contained in the umMail.ntf file. 

IMPORTANT:  Always create a separate mail template for each desired language 
(see steps 3 and 4 of the basic steps)!

You may determine the distinction of the national languages in the Lotus Domino 
Designer client on the basis of the Language column.

4.4.3.2  Preparations

To create Unified Messaging mail templates you need the following items: 

• A Lotus Domino Administrator Client of version R6.x/R7.x .

• A Lotus Domino Designer Client of version R6.x/R7.x .

• The default Lotus Notes mail template mail6.ntf (for R6.x) or mail7.ntf (for 
R7.x).

• The mail template extension umMail.ntf. You find it in the setup directory of 
the XPR server in the folders res\LnApl\TemplatesR6 respectively 
res\LnApl\TemplatesR7 

4.4.3.3  Procedure

The table on the following page gives an overview of the design elements that 
must be integrated into a mail template in order to receive a certain functionality.

The Basic Function row features elements that must always be included in a 
mail template. Starting from these basic elements, design elements for different 
functions can be integrated in the mail template.

Example: Creating a Mail Template

You want to create a mail template that has the functions Sending/receiving fax 
messages and Sending/receiving voice mails. The template should also 
enable Integrated Messaging (inbox replication).

First integrate all design elements from the Basic Function row in the new 
template. This process is described in Section 4.4.3.4, “After completing the 
design update, open the following templates in the Lotus Domino Designer 
client:”, on page 95.

Furthermore you need to integrate
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• all design elements from the Sending/receiving fax messages (forms, 
subforms and actions) in the mail template (see Section 4.4.3.4, “Creating 
a mail template for sending and receiving fax messages”, on page 98).

• all design elements from the Sending/receiving voice mails (forms, 
subforms and actions) in the mail template (see Section 4.4.3.4, “Creating 
a mail template for receiving and sending voice messages”, on page 100).

To support the Integrated Messaging function you need to implement the required 
design element (agent) from the Integrated Messaging row in the template and 
perform the steps for creating an Integrated Messaging mail template (see 
Section 4.4.3.5, “Creating Integrated Messaging Mail Templates”, on page 102). 

4.4.3.4  Basic Steps

1. Start the Lotus Notes Client and open the mail template extension umMail.ntf 
from the directory <XPR-Inst>\res\LnApl\TemplatesR6. 

2. Save a copy of this template in the data directory of the local Lotus Notes 
Client (default: C:\Program Files\lotus\notes\data).

3. Create a language reduced mail template extension. Therefore you need to 
create a new database on the Domino server first. Use the locally stored 
mail template extension Mail Tmpl X.x as template for the new database. 
X.x represents one of the following template versions:

• Mail Tmpl 5.5

• Mail Tmpl 6.0

• Mail Templ 7.0
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IMPORTANT:  Make sure to assign the extension *.ntf to the new 
template.

NOTE:  In this example the file name UmMailDE.ntf is assigned to the 
template and contains only Unified Messaging design elements in German. If 
you create a template for another language, select the file name accordingly.

4. Save your settings by clicking on the OK button.

5. In the following dialog select only one template language in the Available 
languages field and copy it with the help of the Add button to the Selected 
languages field. Save your settings by clicking on the OK button. 
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6. Open the Properties dialog of the template you have just created and change 
to the Design tab.

7. Activate the Database file is a master template option and enter a name for 
this template (in this example the file UmMailDE). If necessary, disable the 
Inherit design from master template option. 
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8. Create a new database template in your local work environment. Name the 
new database template for example companymail.ntf. Select the entry 
Blank as the template for the new database. Confirm with OK.

IMPORTANT:  Make sure to assign the extension *.ntf to the new 
template.

9. Open the Properties dialog of the created template (in this example the file 
companymail.ntf) and change to the Design tab.

10. Activate the Inherit design from master template option and enter 
StdR6Mail as template name. Close the Properties dialog.
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11. Select the templates in your work environment and update the design with 
File > Database > Refresh design with the design of the mail template 
extension UmMailDE.ntf created in step 2.

12. After completing the design update, open the following templates in the 
Lotus Domino Designer client:

• companymail.ntf 

• UmMailDE.ntf

13. Now you have to copy several script libraries and design elements from the 
UmMailDE.ntf file to the respective folder of the companymail.ntf file. 

Therefore select the elements listed below in the UmMailDE.ntf file, copy it 
to the clipboard before adding them to the respective folder of the 
companymail.ntf file.

NOTE:  After each copying process your are asked in a dialog whether the 
inserted design elements are to be updated if they are modified in the 
umMail.ntf template. Do confirm this prompt for all design elements with 
Yes. 
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
Please consider the notes for the multilingual feature in Section 4.4.3.1, 
“Multi-Language Capability”, on page 89.

a) Copy the following script libraries from the Shared Code\Script 
Libraries folder in the UmMailDE.ntf file to the respective folder of the 
companymail.ntf file: 

– cyFec-de_DE

– cyBec-de_DE

– cyCfg-de_DE

– cyRes-de_DE

– cyUtl-de_DE

– cyLog-de_DE

– cyDoc-de_DE

b) Copy the following design elements from the Masks folder in the 
UmMailDE.ntf file to the respective folder in the companymail.ntf file. 
We refer to the names of the Alias column: 

– cyMemo

– cyReply

– cyUmPerson

– cyChooseDatabase

– cyLogDoc

c) Copy the following design elements from the Views folder in the 
UmMailDE.ntf file to the respective folder in the companymail.ntf file. 
We refer to the names of the Alias column: 

– cyUnifiedMessaging

– cyLogging

– cyAllUmPerson

– cyUmPersonAsMemo

d) Copy the following design elements from the Shared Code\Agents folder 
in the UmMailDE.ntf file to the respective folder of the companymail.ntf 
file. We refer to the names of the Alias column: 

– cyUmLoggingOff

– cyUmLoggingOn
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– cyUmSettings

14. Open the folder Shared Code\Outlines in the companymail.ntf file and 
delete the default design element named NotesMailOutline in the Alias 
column. 

IMPORTANT:  If your default design element NotesMailOutline already 
contains other modifications, you must not delete or override it. In this case 
you must perform the Unified Messaging modification manually. A description 
on this is provided in Section 4.4.3.8, “Modifying the Default Outline 
MailOutline manually”, on page 107.

15. Copy the following design elements via the clipboard from the folder Shared 
Code\Outline in the file UmMailDE.ntf to the folder Shared Code\Outline of 
the file companymail.ntf. Use the names from the Alias column: 

– NotesMailOutline (NotesMailOutline65)

IMPORTANT:  Use the outline NotesMailOutline in connection with 
Lotus Notes 6 and the outline NotesMailOutlin65 in connection with 
Lotus Notes 6.5. Then rename the outline NotesMailOutline65 as 
NotesMailOutline.

16. Copy the following design elements via clipboard from the folder Shared 
Code\Subforms in the UmMailDE.ntf file to the folder Shared 
Code\Subforms of the file companymail.ntf. Use the names from the Alias 
column: 

– cyDelOptionSubform

– cyRecipient

– cyMessageDlg

17. In the Tools menu call the Recompile All LotusScript option.

18. Save the companymail.ntf template.

19. At this point you can extend the mail template by one of several functions. 

• Sending and receiving fax messages (see Section 4.4.3.4, “Creating a 
mail template for sending and receiving fax messages”, on page 98)

• Retrieving fax documents (see Section 4.4.3.4, “Creating a mail template 
for Fax-on-Demand”, on page 99)

• Sending and receiving voice mails (see Section 4.4.3.4, “Creating a mail 
template for receiving and sending voice messages”, on page 100)
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• Sending/receiving SMS messages (see Section 4.4.3.4, “Creating a mail 
template for sending and receiving SMS messages”, on page 100)

• SimpleDialer usage

NOTE:  Integrating the SimpleDialer in a mail template is only required if 
you do not want to use the additional CTI software optiClient 130 for 
Notes.

• Integrated Messaging (see Section 4.4.3.5, “Creating Integrated 
Messaging Mail Templates”, on page 102)

• True Unified Messaging (Section 4.4.3.6, “Creating True Unified 
Messaging Mail Templates”, on page 104TUM)

Creating a mail template for sending and receiving fax messages

1. Make sure that the basic steps for creating a mail template have been 
executed (see Section 4.4.3.4, “Basic Steps”, on page 91). 

2. Open the Masks folder in the UmMailDE.ntf file and copy the following 
design elements via the clipboard to the Masks folder of the 
companymail.ntf file. Use the names from the Alias column: 

• Mask cyFax 

• Mask cyFaxReply 

• Mask cyControlMaster 

• Mask cyControlSlave 

3. Open the Subforms folder in the UmMailDE.ntf file and copy the following 
design elements via the clipboard to the Subforms folder of the 
companymail.ntf file. Use the names from the Alias column: 

• Subform cyFaxViewer 

• View cyJournals 

4. Open the Shared Code\Actions folder in the UmMailEN.ntf file and copy 
the following shared actions via the clipboard to the Shared Code\Actions 
folder of the companymail.ntf file. 

• Cycos New Fax 

• Cycos Forward Fax 

• Cycos Reply Fax 

• Cycos Reply All Fax 

• Cycos History Reply Fax 
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• Cycos History Reply All Fax 

5. Extend the mail template as described in Section 4.4.3.7, “Extending the Mail 
Template by Shared Actions”, on page 105.

6. In the Tools menu call the Recompile All LotusScript option.

7. Save the modifications performed in the companymail.ntf file.

• If you want to provide your users with this template, continue reading in 
Section 4.4.3.9, “Assigning created Mail Template”, on page 108 .

Creating a mail template for Fax-on-Demand

1. Make sure that the basic steps for creating a mail template have been 
executed (see Section 4.4.3.4, “Basic Steps”, on page 91). 

2. Open the Masks folder in the UmMailDE.ntf file and copy the following 
design elements via the clipboard to the Masks folder of the 
companymail.ntf file. Use the names from the Alias column: 

• Mask cyFod 

• Mask cyFodReply (optional)

3. Open the Shared Code\Actions folder in the UmMailEN.ntf file and copy 
the following shared actions via the clipboard to the Shared Code\Actions 
folder of the companymail.ntf file. 

• Cycos New FoD 

• Cycos Forward FoD 

• Cycos Reply FoD 

• Cycos Reply All FoD 

• Cycos History Reply FoD 

• Cycos History Reply All FoD 

4. Extend the mail template as described in Section 4.4.3.7, “Extending the Mail 
Template by Shared Actions”, on page 105.

5. In the Tools menu call the Recompile All LotusScript option.

6. Save the modifications performed in the companymail.ntf file.

• If you want to provide your users with this template, continue reading in 
Section 4.4.3.9, “Assigning created Mail Template”, on page 108 .
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Creating a mail template for receiving and sending voice messages

1. Make sure that the basic steps for creating a mail template have been 
executed (see Section 4.4.3.4, “Basic Steps”, on page 91). 

2. Open the Masks folder in the UmMailDE.ntf file and copy the following 
design elements via the clipboard to the Masks folder of the 
companymail.ntf file. Use the names from the Alias column: 

• Mask cyVoice 

• Mask cyVoiceReply 

• Mask cyControlMaster 

• Mask cyControlSlave 

3. Open the Subforms folder in the UmMailDE.ntf file and copy the following 
design elements via the clipboard to the Subforms folder of the 
companymail.ntf file. Use the names from the Alias column: 

• Subform cyWavePlayerShallow 

4. Open the Shared Code\Actions folder in the UmMailEN.ntf file and copy 
the following shared actions via the clipboard to the Shared Code\Actions 
folder of the companymail.ntf file. 

• Cycos New Voice 

• Cycos Forward Voice 

• Cycos Reply Voice 

• Cycos Reply All Voice 

• Cycos History Reply Voice 

• Cycos History Reply All Voice 

5. Extend the mail template as described in Section 4.4.3.7, “Extending the Mail 
Template by Shared Actions”, on page 105.

6. In the Tools menu call the Recompile All LotusScript option.

7. Save the modifications performed in the companymail.ntf file.

• If you want to provide your users with this template, continue reading in 
Section 4.4.3.9, “Assigning created Mail Template”, on page 108 .

Creating a mail template for sending and receiving SMS messages

1. Make sure that the basic steps for creating a mail template have been 
executed (see Section 4.4.3.4, “Basic Steps”, on page 91). 

2. Open the Masks folder in the UmMailDE.ntf file and copy the following 
design elements via the clipboard to the Masks folder of the 
companymail.ntf file. Use the names from the Alias column: 
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• Mask cySms 

• Mask cySmsReply 

3. Open the Shared Code\Actions folder in the UmMailEN.ntf file and copy 
the following shared actions via the clipboard to the Shared Code\Actions 
folder of the companymail.ntf file. /7

• Cycos New SMS 

• Cycos Forward SMS 

• Cycos Reply SMS 

• Cycos Reply All SMS 

• Cycos History Reply SMS 

• Cycos History Reply All SMS 

4. Extend the mail template as described in Section 4.4.3.7, “Extending the Mail 
Template by Shared Actions”, on page 105.

5. In the Tools menu call the Recompile All LotusScript option.

6. Save the modifications performed in the companymail.ntf file.

• If you want to provide your users with this template, continue reading in 
Section 4.4.3.9, “Assigning created Mail Template”, on page 108 .

SimpleDialer Usage

NOTE:  For using the SimpleDialer the CTI Light script must be installed and 
configured in the XPR server telematic APL. Information on this is found in 
Section 2.4, “CTI Light”, on page 26 and in the Server Administration manual.
Usage of the SimpleDialer is described in the Lotus Notes Extensions manual.

Integrating the SimpleDialer in a mail template is only required if you do not want 
to use the additional CTI software optiClient 130 for Notes.

1. Make sure that the basic steps for creating a mail template have been 
executed (see Section 4.4.3.4, “Basic Steps”, on page 91).

2. Open the Masks folder in the UmMailDE.ntf file and copy the following 
design elements via the clipboard to the Masks folder of the 
companymail.ntf file. Use the names from the Alias column: 

• Mask cySimpleDialer 

3. Open the Shared Code \ Agents folder in the UmMailEN.ntf file and copy 
the following design elements via the clipboard to the Agents folder of the 
companymail.ntf file. Use the names from the Alias column: 
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• Agent cyDialerAgent 

4. Extend the mail template as described in Section 4.4.3.7, “Extending the Mail 
Template by Shared Actions”, on page 105.

5. In the Tools menu call the Recompile All LotusScript option.

6. Save the modifications performed in the companymail.ntf file.

• If you want to provide your users with this template, continue reading in 
Section 4.4.3.9, “Assigning created Mail Template”, on page 108 .

4.4.3.5  Creating Integrated Messaging Mail Templates

NOTE:  To create an Integrated Messaging mail template the design elements of 
the mail template extension UmMailDE.ntf are necessary.

If you would like to create a mail template which is able to use the Integrated 
Messaging features, you need to proceed as follows: 

1. Perform the basic steps to create a Unified Messaging mail template (see 
Section 4.4.3.4, “Basic Steps”, on page 91).

2. Add further design elements to the mail template from the UmMail.ntf file 
(e.g. Sending and receiving fax and voice mails etc.).

3. Open the Shared Code \ Agents folder in the UmMailEN.ntf file and copy 
the following design elements via the clipboard to the Agents folder of the 
companymail.ntf file. Use the names from the Alias column: 

• Agent mrsDisp 

4. Delete the design element Memo in the Masks folder in the 
companymail.ntf file.

5. Copy the Memo mask from the UmMailDE.ntf file to the Masks folder of the 
companymail.ntf file.

6. In the Folder folder open the design element ($Inbox) in the 
companymail.ntf file with a double-click.

IMPORTANT:  Do not copy the complete Inbox folder from the UmMailDE.ntf 
file to the companymail.ntf file. This could lead to malfunctions of the mail 
template.

7. Add another column to the Inbox folder and enter the parameters described 
in Section C.1.9, “Design Elements for IM and TUM Functions”, on page 172.
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8. Save the modifications of Inbox folder of the companymail.ntf file.

9. Open the Properties dialog of the design element Database Script in the 
companymail.ntf file of the ...Other\Database resources folder with 
a right mouseclick. 

10. Change to the Design tab and activate the option Prohibit design refresh 
or replace to modify . 

11. Close the Properties dialog.

12. In the folder ...Other\Database resources open the database script 
in the file companymail.ntf with a double-click.

13. Modify the database script in the companymail.ntf file by manually entering 
the parameters described in Section C.1.9, “Design Elements for IM and TUM 
Functions”, on page 172. 

IMPORTANT:  Do not copy the complete Database Script from the umMail.ntf 
file to the file companymail.ntf. This could lead to malfunctions of the mail 
template.

14. Save the modifications of the Database Script of the companymail.ntf file.

15. In the Tools menu call the Recompile All LotusScript option.

16. Save the modifications you have made until now in the companymail.ntf file.

• If you want to provide your users with this template, continue reading in 
Section 4.4.3.9, “Assigning created Mail Template”, on page 108 .
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4.4.3.6  Creating True Unified Messaging Mail Templates

NOTE:  For the creation of a True Unified Messaging mail template, design 
elements of the mail template extension UmMailDE.ntf are required.

If you would like to create a mail template which is able to use the True Unified 
Messaging features, you need to proceed as follows: 

1. Perform the basic steps to create an Integrated Messaging mail template (see 
Section 4.4.3.5, “Creating Integrated Messaging Mail Templates”, on page 
102).

2. Add further design elements to the mail template from the UmMail.ntf file 
(e.g. Sending and receiving fax and voice mails etc.).

3. Additionally, the following requirements must be met for using True Unified 
Messaging: 

• the LnUmApl must be installed and functional

• when using the notification feature, the Notification APL must be 
installed and functioning (see the Server Administration manual)

• in the Web Assistant the notification feature must be active for each 
user (see the Web Assistant user manual),

• in the administration database the supported forms must be entered in the 
Notification tab for each user data record (see Section B.1.2.4, 
“Notification tab”, on page 153).

If True Unified Messaging and/or the notification features do not work, 
please do check:

• if the LnUmApl is working properly (check the XPR monitor for error 
messages)

• if the Notification APL is working correctly (check the XPR monitor for 
error messages)

• the access rights of the IBM/Lotus Notes Gateway user ID being used 
(see also Section 3.3.2, “User ID for the IBM/Lotus Notes Gateway”, 
on page 34)

• if the XPR dispatcher agent included in the mail template is operated 
on the correct Lotus Domino server (see Appendix C.1.9.4, 
“cyDispatcher Agent Settings”)

• the status of the notification function in the Web Assistant (enabled or 
disabled for the respective user). If the notification function is 
enabled, also check for a bell icon in front of the relevant user data 
record in the main window of the administration database.
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• the correct spelling and selection of the masks entered for the 
notification function in the administration database (Unified 
Messaging - Notification tab).

4. Save the modifications performed in the companymail.ntf file.

• If you want to provide your users with this template, continue reading in 
Section 4.4.3.9, “Assigning created Mail Template”, on page 108 .

4.4.3.7  Extending the Mail Template by Shared Actions

In the Inbox folder of a mail template you can create shared actions to simplify 
routine tasks (e.g. opening the fax send form). The created actions are then 
displayed e.g. as menu. 

NOTE:  You will find a list of all available shared actions and their functions in 
Section C.1.8, “Shared Actions”, on page 170.

The following example describes the creation of shared actions in the Inbox 
folder of a mail template:

1. Open the mail template to be created in the Lotus Domino designer client.

2. Open the ($Inbox) design element in the Folder folder with a doubleclick.

3. Select the menu item Create > Action > Action with Sub Action... in the 
Lotus Domino Designer client menu. 

4. Assign a name for the new action in the appearing Properties dialog (e.g. 
New UM Message). Then close this dialog.

5. Delete the Sub Action named (untitled).

6. Right-click on the newly created action and select the option Insert Shared 
Action.

7. In the subsequent dialog select the Shared Actions you would like to apply 
and click Insert. 

NOTE:  To integrate all the supported Unified Messaging functions, i.e., 
Sending and receiving fax messages, Polling fax documents (fax-on-
demand), Sending and receiving voice mails, and Sending and receiving 
SMS messages, in the extended mail template, you need to select all the 
Shared Actions listed below.

- Forward\Cycos Forward Fax

- Forward\Cycos Forward FoD
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- Forward\Cycos Forward SMS

- Forward\Cycos Forward Voice

- New\Cycos New Fax

- New\Cycos New FoD

- New\Cycos New SMS

- New\Cycos New Voice

- Reply\Cycos Reply Fax

- Reply\Cycos History Reply Fax

- Reply\Cycos Reply FoD

- Reply\Cycos History Reply FoD

- Reply\Cycos Reply Voice

- Reply\Cycos History Reply Voice

- Reply\Cycos Reply SMS

- Reply\Cycos History Reply SMS

- Reply To All\Cycos Reply Fax

- Reply To All\Cycos History Reply Fax

- Reply To All\Cycos Reply FoD

- Reply To All\Cycos History Reply FoD

- Reply To All\Cycos Reply Voice

- Reply To All\Cycos History Reply Voice

- Reply To All\Cycos Reply SMS

- Reply To All\Cycos History Reply SMS

8. The selected shared actions are now displayed as sub actions of the newly 
created action.

9. Proceed as described in step 3 to 7 if you want to insert further shared 
actions.

10. After inserting all desired actions, call the Recompile All LotusScript option 
in the Tools menu.
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4.4.3.8  Modifying the Default Outline MailOutline manually

If your MailOutline contains modifications already, you need to perform the 
Unified Messaging modifications at this design element manually. 

Proceed as follows:

1. Open the mail template to be created in the Lotus Domino designer client.

2. Switch to the Shared Code\Outlines folder and open the 
NotesMailOutline design element.

3. Open the Tools entry with a click on the + character to the left of the entry.

4. Select the Stationery subentry.

5. Click on New Entry and enter Unified Messaging in the Label field.

6. In the Type selection field choose the Named Element option. Next to this 
field another selection field is now displayed, in which you need to pick the 
View option.

7. Enter the ( (cyUnifiedMessaging) parameter in the Value field.

8. Switch to the Entry Hide When tab and remove the tick for Notes 4.6 or 
later. Close the entry dialog.

9. If the Unified Messaging subentry is selected, click New Entry again and 
subsequently on Indent Entry to create a subentry of Unified Messaging. 
Enter Logging as label in the entry dialog.

10. In the Type selection field choose the Named Element option. Next to this 
field another selection field is now displayed, in which you need to pick the 
View option.

11. Enter the (cyLogging) parameter in the Value field.

12. Switch to the Entry Hide When tab and remove the tick for Notes 4.6 or 
later. Close the entry dialog.

13. Accomplish the entry with a click on the minus character to the left of the 
Unified Messaging entry. Close the Tools entry as well.

14. Save the modified design element and close it.
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4.4.3.9  Assigning created Mail Template

This chapter includes a description of how to assign a created mail template to a 
Lotus Notes user mail database. After the assignment the user is able to use all 
services provided by the XPR server via his Lotus Notes mail interface. 

NOTE:  For the assignment process you need administrative access rights to the 
Lotus Notes mail databases of the users that are to use the mail template. for the 
assignment process.

Perform the following steps:

1. Start the Lotus Domino Administrator client. Apply a user ID with 
administrative access rights to log on.

2. In the working interface of the Lotus Domino Administrator client change to 
the Files tab and set the All DB Types option to Show.

3. Make sure that the created Unified Messaging mail template 
(companymail.ntf) is in the \Lotus\Domino\Data folder.

4. Open the folder storing the mail databases of the Lotus Notes users. For a 
default installation, this is the \Lotus\Domino\Data\mail folder.

5. Right-click on a user mail database and select the option Properties.

6. In the Properties dialog of the user mail database to the Design tab.

7. Check if the Inherit design from template option is activated and enter UM 
Mail Template as template name.

8. Save the settings and close the Properties dialog of the user mail database.

9. Select the user's mail database and select the option File > Database > 
Refresh design... in the menu bar of the Lotus Domino Administrator client.

10. The refreshing process starts.

11. After a successful refreshing process check if all design elements from the 
Unified Messaging mail template are available in the user mail database. 
Therefore you need to open the mail database of the corresponding user. 

NOTE:  If the update process has not been successful, you should first check 
all notifications logged in the status line of the Lotus Domino Administrator 
client. Furthermore check if the template name that has been assigned in 
step 7 is written correctly.
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4.5  Installing IBM/Lotus Notes Client Components

Depending on the features you have integrated in the Unified Messaging mail 
template, IBM/Lotus Notes Client components are necessary on a user computer. 

NOTE:  You will find a description of the installation and configuration for the 
different client components in Section C.2, “Installation of the IBM/Lotus Notes 
Client Components”, on page 180.

IBM/Lotus Notes Client components must be installed on a user computer for the 
following features: 

• Viewing received fax messages:
For this, you need the ActiveX client components (see Section C.3, 
“Installation of the ActiveX Components”, on page 180).

• Creating voice mails / Listening to received voice mails:
For this you need the ActiveX client components (see Section C.3, 
“Installation of the ActiveX Components”, on page 180).

• Replying to messages with a voice annotation:
For this you need the ActiveX client components (see Section C.3, 
“Installation of the ActiveX Components”, on page 180).

If you have installed the appropriate IBM/Lotus Notes client component, you may 
check in the following section if the user mail database that has been extended 
with the Unified Messaging features works correctly.
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4.6  Checking the Unified Messaging Mail Databases Functionality

For this functionality check the following requirements must be met: 

• The basic functionality of the IBM/Lotus Notes Gateway must be available 
(see Section 4.1, “Basic Functionality Check”, on page 56).

• The administration database must exist on the IBM/Lotus Domino server (see 
Section 4.2.1, “Creation of the Administration Database”, on page 61).

• The IBM/Lotus Notes Gateway must be connected with the administration 
database (see Section 4.2.2, “Activation of the Administration Database”, on 
page 64).

• Alias domains must exist (see Section 4.2.3, “Creating an Alias Domain”, on 
page 66).

• In the administration database user data records must exist (see Section 
4.2.4, “Creating User Data Records”, on page 68).

• The user data records must have been replicated to the XPR server (see 
Section 4.2.4, “Creating User Data Records”, on page 68).

• The advanced functionality of the IBM/Lotus Notes Gateway must have been 
checked successfully (see Section 4.3, “Extended Functionality Check”, on 
page 74).

• A Unified Messaging mail template must have been created. This template 
must be assigned to a IBM/Lotus Notes user mail database (see Section 4.4, 
“Mail Template Extensions”, on page 75).

• IBM/Lotus Notes client components must be installed and configured on the 
user computers (see Section 4.5, “Installing IBM/Lotus Notes Client 
Components”, on page 109).

If you have completed the steps in the sections 4.1 to 4.5, you may now check 
the functionality according to the following example:

Example: Fax G3 and voice mail for a Notes user

A FaxG3 number and a voice mail number have been assigned to a IBM/Lotus 
Notes user. His/her user data record exists in the administration database and on 
the XPR server. The user shall now be able to send and receive fax messages 
and voice mails via his/her IBM/Lotus Notes client. The user shall be able to listen 
to received voice messages on his telephone. 

NOTE:  The following functionality check will refer to the IBM Notes Extensions 
user manual.

Proceed as follows:
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1. Start a IBM/Lotus Notes client of a user who is to use the IBM/Lotus Notes 
Gateway. Do not use the IBM/Lotus Notes client that is installed on the XPR 
server.

2. Open the mail interface in this user's IBM/Lotus Notes client.

3. Send a fax message to a fax device. Follow the description in the IBM/
Lotus Notes Gateway user manual.

4. After a short time, your fax device should put out the message that had been 
sent.

5. Send the message you have received on the fax device back to the user's fax 
number.

6. After a successful transmission the IBM/Lotus Notes user must find a 
message in his inbox.

7. A double-click on the received message opens it in a fax view window. The 
form for viewing received fax messages works.

8. Send a voice mail to the user's own voice mail number. Follow the description 
in the IBM/Lotus Notes Gateway user manual.

9. After a successful transmission the IBM/Lotus Notes user must find a voice 
mail in his inbox.

10. A double-click on the received message opens it in a form containing an audio 
operating unit. Play the received voice mail as described in the IBM/
Lotus Notes Gateway user manual.

11. If you were able to listen to the voicemail on the user's phone, the functionality 
check has been successful.

NOTE:  On the basis of the procedures described in the IBM/Lotus Notes 
Gateway user manual, you may perform further functionality checks (e.g. 
check CTI features etc.).
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4.7  Error Messages

If the IBM/Lotus Notes Gateways (LN APL) setup fails with reference to the 
notes.ini file, check the following:

• Do old, faulty setups exist?

• Is a multiuser setup available?

• Is a notes.ini or lotus.ini file used by old setups?

If the LN APL starts but cannot connect to the IBM/Lotus Domino server, check 
the following:

• If the user ID was newly certified or the password changed you need to 
perform a new installation.

• If the user ID is unchanged, perform the following:

1. Stop the LN APL.

2. Create in the IBM/Lotus Notes client a connection document to the server.

3. Restart the LN APL.

4. Create a complete log. Here you can see which databases can be 
accessed or which servers cannot be reached.

• If none of the two above points applies you need to reinstall the LN APL.
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Configuration of the IBM/Lotus Notes Gateway

Global Settings Tab

A  Configuration of the IBM/Lotus Notes Gateway

In this chapter you will find an overview of all parameters that can be set via the 
configuration dialog of the IBM/Lotus Notes Gateway. 

A.1  Global Settings Tab

 

Parameters / Button Description

Current Lotus Notes user ID: Displays the name of the user ID that is used by the IBM/
Lotus Notes Gateway.

Lotus Notes domain: This field contains the name of the IBM/Lotus Notes 
domain the IBM/Lotus Notes Gateway is connected with.
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A.1.1  Connections Tab

In this dialog every connection to a foreign domain that exists on a IBM/Lotus 
Domino server is displayed. Via the buttons on the right hand side it is possible 
to create a new connection or remove an existing one. You can disable and 
enable existing connections. 
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If a foreign domain has been selected, the Properties... button is activated. A 
click on this button opens a dialog in which the connection properties may be 
configured. 

Parameters / Button Description

External domain name: Name of the foreign domain to which this connection exists 
(Default: NOTESGATE).

Domino server Hierarchical name of the IBM/Lotus Notes server that 
administers the foreign domain.

Mail database Database name of the gateway mailbox (Default: 
notesgat.box)

Activate privilege 
verification on server 

If this option is activated, the XPR server checks the send 
privileges that have been assigned in the XPR system for 
their authorization.

Query interval (time 
stamp method):

Indicates the time interval during which the IBM/Lotus Notes 
Gateway searches the gateway mailbox on the IBM/Lotus 
Domino server for new messages in seconds.

Query interval (mail list 
method) 

This value is only used with a connection to a IBM/Lotus 
Domino server of the versions R4.x.

Reconnection delay: The value entered here determines how many seconds are 
to pass between two connection attempts. The minimum 
time interval is 15 seconds.
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A.1.2  Alias Domains Tab

Alias domains can be installed on every connection to simplify the addressing of 
the various services. Each alias domain corresponds to an XPR service e.g. 
FAXG3, FAXG4, SMS or VOICE. 

By default, only the alias domain NOTESGATE is configured during the 
installation. Further alias domains can be generated via the Add button. The 
name of an additional alias domain must not match the name of an alias domain 
already used. Obsolete entries can be deleted with the Remove button. The alias 
domains display can be sorted by connections or services. 
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A.1.3  Administration Tab

Parameters / Button Description

Use administration 
database 

Enables / Disables the usage of the administration 
database.

Domino server In this field the hierarchical name of the IBM/Lotus Domino 
server where the administration database is stored is 
entered.

Database name File name of the administration database. If the database is 
stored in the data directory of the Domino server, you do 
not need to enter a path. If the entry includes a path in 
addition to the database name (e.g. XPR\admindb.nsf), 
this path is interpreted relatively to the data directory of the 
IBM/Lotus Domino server - if it does not contain a drive 
name or leading backslashes. Paths with drive names or 
leading backslashes are not allowed (such as 
E:\XPR\admindb.nsf or \XPR\admindb.nsf). 

Automatic 
synchronization of user 
database 

Activating this option causes the synchronization of the user 
data records of the administration database with the user 
database. The LnAPL controls the administration database 
and synchronizes the user data records on both systems 
regularly.

Accept database 
replications 

Activating this option enables the LnAPL to cooperate with 
replicas of the administration database. If the administration 
database should not be available e.g. when the Domino 
server breaks down, the LnAPL switches to a Domino 
server where a replica of the administration database is 
stored.
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Allow gateway 
configuration via the 
administration database 

This parameter is reserved for future applications.

Restrict gateway access 
to registered users only 

This function allows only IBM/Lotus Notes users that have 
been entered in the administration database to use the IBM/
Lotus Notes Gateway. Users that have not been entered are 
then e.g. not able to send or receive fax messages via the 
IBM/Lotus Notes client.

Use Integrated 
Messaging 

Enables / Disables the Integrated Messaging Feature.

Note 'Principal' Field in 
Notes Mail 

When the option is enabled, the IBM/Lotus Notes Gateway 
enters the user form the principal field as originator. This 
check box must be active for sending a fax on behalf of 
another user.

Forward non-deliverable 
documents to 
postmaster 

Documents that could not be delivered are forwarded to the 
IBM/Lotus Notes user entered in the Postmaster Account.

'Save Configuration' 
button in configuration 
document 

When the option is enabled the a button is integrated in the 
configuration document you receive during a change of 
configuration via e-mail. Clicking this button saves the 
changed configuration parameters.

Postmaster Hierarchical name of a IBM/Lotus Notes user who is to 
receive messages that could not be delivered as 
postmaster.

Parameters / Button Description



Gatewaykonfiguration.fm

Configuration of the IBM/Lotus Notes Gateway

Global Settings Tab

A31003-S2370-M102-9-76A9, 08/2016
OpenScape Xpressions V7 IBM Notes Gateway, Installation and Administrator Documentation 119

          

A.1.4  File Formats Tab

 

The file formats for voice and fax messages which are supported by the client 
used on the IBM/Lotus Notes side are specified here. If a message arrived that 
was not supported by the user client, it would be converted to a format which is 
can be read by the user client. 

Only one conversion is performed at a time, even if several formats have been 
selected. The system automatically evaluates the selected formats and selects 
the conversion that the converter considers the “cheapest“.

Formats not supported by the client are converted into one of the selected file 
formats by the XPR server.

If your client is able to display postscript or telex files, you should prevent the 
conversion of these files to a graphic or text format (section Do not convert the 
following document formats). 

The following Fax formats are available: 

Format Description

Server Fax FG3 Proprietary fax format of the manufacturer (XPR Viewer).

Fax (DCX) Multipage PCX graphic format. Used by Microsoft Fax.

Windows Bitmap BMP Each individual fax page is converted into a Windows bitmap.

Windows Bitmap 
Grayscale BMP 

Individual fax pages are converted in a Windows Bitmap, 
where a trilinear grayscale interpolation is performed.
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The internal Notes Viewer cannot display asymmetrical TIFF files, e.g. low 
resolution fax messages (200 x 100 dpi).

The following voice mail formats are available: 

Grayscale JPEG Fax data is converted in a 9-color JPEG grayscale format. 
This format is particularly suitable for viewing the HTML mail 
client.

TIFF bitmap Each individual fax page is converted into a standard TIFF 
bitmap.

TIFF fax TIFF Fax => External Converter Support
Selecting this format activates an external converter. You find 
the preferred Fax2PDF converter in the 
XpressionsInstall\AddOn directory on the XPR 
installation medium. For this feature, you must make the 
following registry entries under the key 
[HKLM\SOFTWARE\Wow6432Node\PP-COM\mrs\Mrs 
Globals\Converter\]:
• TiffToExternalConverter REG_SZ  <program name with 

parameters> 
• TiffToExternalExtension REG_SZ <extension> 

Example of <program name with parameters>:
D:\xpr\res\convert\Fax2PDF\Fax2Pdf %1 %2
Example of <extension>: pdf
The format TIFF DIB-MONO (TIFF single page) is no longer 
used and is replaced by the external converter.

TIFF multipage Fax according to TIFF standard (multipage).

Format Description

Windows Wave Windows sound format

Compressed Windows 
Wave 

Compressed Windows sound format. The audio codec used 
for compression is set via the MTA configuration. The 
appropriate codec to playback compressed files is also 
required on the client computer.

Windows Wave A-law Wave sound file with A-Law encoding.

Windows Wave µ-law Wave sound file with µ-Law encoding.

Macintosh AIFF Audio format, mainly used on Apple Macintosh computers.

Unix AU Unix Audio Format.

Format Description
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A.1.5  Reports Tab

 

You can set here whether the IBM/Lotus Notes Gateway demands a delivery 
report from XPR for fax documents and other message types, even if the IBM/
Lotus Notes user did not request such a report in the delivery options. 

Reports can always be generated, i.e. even if the user explicitly deactivates this 
setting. The user may also switch off the delivery report or limit it e.g. to mistakes. 
The third option disables the automatic sending of a delivery report. 
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A.1.6  Fax Cover Pages Tab

 

In case of the XPR system, fax cover pages are created using the 
Communications client and stored on the XPR server.

The name of the fax stationary you would like to use must be entered in the 
Default MRS fax stationary field. Please note that the name of the fax cover 
page must be written in the same way as it has been entered in the 
Communications client under Tools > Fax Stationery.... 

NOTE:  For further information on the creation of fax covers and fax stationery 
please refer to the Communications user manual.

In the Default Fax Form (Lotus Notes) field you may implement a IBM/Lotus 
Notes fax form for all IBM/Lotus Notes users. 

NOTE:  Information on creating IBM/Lotus Notes fax forms can be obtained from 
the IBM/Lotus Notes help.
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A.1.7  Export Tab

Export filters can be set for e-mail as well as fax transmission from IBM/
Lotus Notes to the XPR server. The export filters create a Rich Text display format 
for each message that leaves the IBM/Lotus Notes system.

IMPORTANT:  If you use a fax cover sheet, the text fields contained therein will 
only be correctly filled in if you set the ASCII Text option as Filter for mail export 
and the .TXT option in the File extension field of this tab. Otherwise, some fields 
may appear on individual pages of the resulting fax.

The following filters are available for fax message export:

• Lotus Notes Mail Export Filter
Export filter that is integrated in IBM/Lotus Notes. Notes to the configuration 
and operation can be found in the IBM/Lotus Notes help. 

• NDL Exporter
Export filter that is integrated in the IBM/Lotus Notes Gateway. Notes for the 
installation and configuration of the NDL Exporter can be found in Section 
E.3, “Integration in a IBM/Lotus Domino Cluster Environment”, on page 214. 

IMPORTANT:  The registry key NDLConversion_FormPrintMode is active by 
default (see Section F.1.1.5, “Import and Export”, on page 246).
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There are three ways to access the printing feature:

• Menu option File > Print

This is only possible if the NDLConversion_FormPrintMode registry key 
is inactive (see Section F.1.1.5, “Import and Export”, on page 246).

If the NDL exporter is used, the Shortcut for 'File menu' and Shortcut 
for 'Print' selection fields determine with which key combinations the file 
menu and subsequently the print function is to be automatically invoked 
(e.g. combination ALT + F for invoking the File menu). Subsequently a 
key combination for the print function must be defined (e.g. combination 
ALT + P for the Print option). Which key combination is used for the 
single menu options depends on the program and language version of the 
IBM/Lotus Notes client. The German client of version 7.0 expects the 
combination Alt-D for the Datei menu as well as for the Drucken menu 
option. An English client of version 7 expects Alt-F for the File menu and 
Alt-P for the Print menu option.

• Menu option Action > Print.

This is only possible if the NDLConversion_AgentPrintMode registry key 
is active and the NDLConversion_FormPrintMode registry key is inactive. 

The values described in Section F.1.1.5, “Import and Export”, on page 246 
for the NDLConversion_AgentPrintMode registry key must be set in the 
combo boxes Shortcut for ’File menu’ and Shortcut for ’Print’.

• Opening the document

This is only possible if the NDLConversion_FormPrintMode registry key 
is active (see Section F.1.1.5, “Import and Export”, on page 246). In this 
case the values set in the Shortcut for ’File menu’ and Shortcut for 
’Print’ combo boxes are irrelevant.

In the selection fields Filter for mail export and File extension the export format 
can be set. For a Rich Text export, the Microsoft RTF filter and the file extension 
RTF must be set. 
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A.1.8  Import Tab

 

An existing RTF representation can be imported for the import of messages that 
originate from the XPR server. In case of complex document formats this may fail. 
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A.1.9  Mail Forms Tab

IBM/Lotus Notes uses default forms for messages and reports. All of these 
standard forms can be replaced by an individually adapted mail form. 

IBM/Lotus Notes administrators are responsible for ensuring that alternative mail 
forms are placed in the user’s mail database. Since mail databases are generally 
configured in a way that they automatically inherit their design from a template, it 
is sufficient to integrate alternative forms into this template. 

NOTE:  
If you use Unified Messaging mail templates, the Server default forms option 
must be selected. 
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A.1.10  CTI Parameters Tab

Parameters / Button Description

Create CTI journal records This option has the effect that a system user receives 
a journal document for incoming and outgoing 
telephone calls. It must always be active if the CTI 
function under IBM/Lotus Notes is used (this applies 
to the usage of optiClient 130 for Notes as well).

Add 'Dial' button to CTI journal 
record 

Lotus Notes R5.x is not supported.

Suppress non-audio mail 
components when forwarding 
to phone: 

Lotus Notes R5.x is not supported.

XPR protocol used to establish 
phone connections 

Lotus Notes R5.x is not supported.
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A.1.11  Compatibility Tab

The Reestablish connection option is the standard method for reestablishing a 
connection if the IBM/Lotus Notes Gateway loses contact with the IBM/Lotus 
Domino server. The Hard Mode should only be selected if the Standard Mode 
fails to reestablish a connection with the server. 

The Notes Reply Tracking option should be activated if clients other than IBM/
Lotus Notes are to be used. For messages that are sent from the XPR system to 
IBM/Lotus Notes and read in IBM/Lotus Notes, a message with a "read” flag is 
sent from IBM/Lotus Notes to the XPR system. 

NOTE:  This option is not activated by default. Activate it if you use neither TUM 
nor IM. If you use the NOT APL also, you need the TUM/Ergo or PhoneMail rules 
described in the Server Administration manual.
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Configuration of the Administration Database

Administration Database for the supported versions of IBM/Lotus Notes

B  Configuration of the Administration Database 

B.1  Administration Database for the supported versions of IBM/
Lotus Notes

B.1.1  General Information

Default values in forms

For some configuration options, default values can be loaded. This is done via an 
option next to the section header (e.g. ...Default). 

The person document (user entries)

The person documents contain all IBM/Lotus Notes and Unified Messaging user 
data. The procedure of creating new person documents with user data is 
described in Section 4.2.4.1, “Administration Database for the supported IBM/
Lotus Notes Versions”, on page 68. 

Change permission for users

Next to some of the fields you will find a red cross or a green tick. A green tick 
enables the user to modify this value in the user profile of his/her mail database. 
A red cross shows that the user is not allowed to change this value. With a 
mouseclick on the cross or tick the IBM/Lotus Domino administrator client may 
change the privilege. 

Deleting a user

If a user is deleted from the administration database, he/she will no longer be 
replicated via the synchronization agent. Otherwise it would not be possible for 
an administrator to remove a user permanently. To replicate a deleted user from 
the Domino Directory to the administration database again, you are required to 
synchronize manually. This can e.g. take place via a synchronization document. 
It is also possible to make a pseudo-modification (e.g. add a space) to the person 
document of this user. The synchronization agent enters the modified user in the 
administration database during the next run. 

Tool tips

Tool tips exist for each option that can be configured in a person or profile 
document. To display the tool tips you need to move the mouse pointer towards 
an option until the mouse pointer changes to a hand icon. Then click the left 
mouse button once and keep pressing it. The corresponding tool tip is displayed 
in a yellow window. 
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B.1.2  Main Window

The main window of the administration database is divided into two sections.

The area on the left side is used for navigation in the three configuration tabs 
User Maintenance, Profile Maintenance and Configuration. In the top part of 
the navigation panel you will find a button (flagged with an arrow) via which you 
may call each of the three configuration sections.

A list of the database entries is provided in the display area on the right. In the 
top part of the display section you will find a toolbar with the buttons Server and 
Person document. If you click on one of these buttons a menu is displayed 
showing further selection possibilities.

B.1.2.1  User Maintenance 

The user data of the administration database are displayed in the navigation area 
in a sorted manner according to different criteria. If you select the sorting criterion 
All Persons by Fax G3 number, all person documents are displayed sorted 
according to FAXG3 numbers in the display area on the right. A double-click on 
a person document opens it. The particular fields of the person document are 
described in Section B.1.2.4, “The Person Document”, on page 142.

The tool bar buttons in the display area have the following functions:
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NOTE:  
If the notification function is enabled, also check for a bell icon in front of the 
relevant user data record in the main window of the administration database.

Button Description

Server This button opens a menu wherein the following features may 
be performed.
• UM User Database Synchronization On / Off

Enables or disables the synchronization of user data records 
between the administration database and the user database.

• Inbox Replication On / Off
Enables or disables the inbox replication between the IBM/
Lotus Domino server and the XPR server. If the inbox 
replication is active, an icon is displayed next to the 
corresponding person document.

Person document This button opens a menu wherein the following features may 
be performed.
• New Person

Opens a guideline for creating new person documents. New 
persons can only be created via the synchronizing document.

• Edit document
Opens the person document of a selected user for editing.

• Use profile
Applies a profile to the selected person documents.
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B.1.2.2  Profile Maintenance 

In the navigation section it is possible to select the User Profiles option. The 
created user profiles are displayed on the right hand side. The creation of user 
profiles is described in Section B.1.2.6, “The Profile Document”, on page 160.

The tool bar buttons in the display area have the following functions:

Button Description

New User Profile Via this button a profile document will be opened where a new 
profile document can be created.

Edit Document Via this button the profile document of a selected user profile 
can be opened in order to edit it.
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B.1.2.3  Configuration

In the navigation section you can select the options Domino Directory Sync, 
Server Configuration, Mail Template Setup, Reference addresses, Cleanup 
Reference addresses and Logging. 

Domino Directory Sync

The user entries from the IBM/Lotus Notes address book are synchronized with 
the user entries of the administration database via the Domino Directory 
Synchronization option. The configuration of the synchronization procedure is 
described in Section 4.2.4.1, “Administration Database for the supported IBM/
Lotus Notes Versions”, on page 68. 

The tool bar buttons in the display area have the following functions:

Button Description

Create Domino 
Directory Sync 

Via this button a document will be opened where a new 
synchronization process can be created.

Edit Document Via this button a selected synchronization process can be 
opened in order to modify it.

Synchronization Via this button a selected synchronization process can be 
activated, deactivated or directly started. 

A document is indicated with a green tick, when the 
agent has been activated for this document and this 
entry has been selected for synchronization. If a 
document is indicated with a red cross, the agent has 
not become active for this document.
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Server Configuration

Via the Server Configuration option a list of the available XPR servers is 
displayed in the right display area. The Server column shows the name of the 
XPR server, the Version column shows the XPR software version used and the 
Build column shows the build version used. 

NOTE:  If questions should occur concerning the XPR server and/or IBM/
Lotus Notes Gateway you have to indicate the XPR version number and the build 
version number in any case!

A doubleclick on an entry opens the corresponding server document where you 
can see the whole IBM/Lotus Notes Gateway configuration. The tabs are identical 
with the tabs in the IBM/Lotus Notes Gateway configuration dialog on the XPR 
server (cf. Chapter A, “Configuration of the IBM/Lotus Notes Gateway”). 
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Modifications cannot be made in this document.
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Reference addresses

The option Reference addresses shows a list referencing the IBM/Lotus Notes 
mail addresses in contrast to the XPR mail addresses. The IBM/Lotus Notes mail 
addresses are listed in the Reference Addresses column. The column Mail 
Addresses shows the corresponding XPR mail address. 

NOTE:  The entries in this view are automatically administered by the IBM/
Lotus Notes Gateway. They may also be maintained by an administrator.

The reference addresses specified here serve for the communication with the 
XPR server. The XPR server has an internal length restriction of 64 Byte for mail 
addresses. IBM/Lotus Notes addresses can be of any length. 
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Cleanup Reference addresses

With this function you can clean up the list of reference addresses. This is 
performed by an agent that is activated and configured via a cleanup document. 

NOTE:  
Only one cleanup document can be created. If a cleanup document already 
exists, it must be edited.

How to create a cleanup document:

1. Open the Configuration section in the administration database.
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2. Select the Cleanup Reference addresses entry or doubleclick on the 
already existing document. The following view opens:

3. Click on Edit Document.

4. Activate the agent in the Agent activated section via the Yes option.

5. In the Last time active at section set a day from which the interval for the 
agent is to be calculated. The current date is entered here by default. 

If, for example, you create the cleanup document on a Tuesday, but the agent 
is to run on every other Sunday, enter here the date of the last Sunday and 
set the interval to 14 days. 

6. Enter the number of days from which old reference addresses that were not 
used in this period are to be removed. 

7. Click on Save and Close.

Creating a cleanup document is complete. 
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Logging

Via the Logging option all system activities on the IBM/Lotus Notes side in the 
context of the XPR connection to IBM/Lotus Notes can be logged. Logging is a 
helpful tool for recording system states in case of errors. 

NOTE:  The logging output is exclusively created in English.

Logging can be configured for each user in his person document in the XPR 
administration database. Global logging can be performed for activities that are 
not user-related (e.g. Domino Directory Synchronization or Searching a person 
document). Logging is divided into three views:

• Configuration

In this view all logging configurations that have been set are displayed. You 
may create a Global configuration document in which you can determine 
the logging settings for the administration database global activities. 

After a person document has been created for a user, the logging 
configurations contained therein are visible in the Person Documents area.

A double-click on a logging configuration opens the corresponding 
configuration document. The creation of a global configuration document is 
described in Section B.1.2, “Main Window”, on page 130. The logging 
configuration within a person document is described in Section B.1.2.4, 
“Logging tab”, on page 157. 

Logging by Date 

In this view all logging output documents are sorted by their creation date. A 
double-click on a logging document opens it for viewing. 
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Logging by Type 

In this view all logging output documents are sorted by output type (see also 
Section B.1.2.4, “Document type”, on page 157). A double-click on a logging 
document opens it for viewing. 
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Creating a global logging configuration document

To create a new global logging configuration document please proceed as 
follows: 

1. Click the New global configuration button in the Configuration view.

2. A configuration document opens where you can perform settings for global 
logging. Possible settings are described in Section B.1.2.4, “Logging tab”, on 
page 157.

3. Save the document after successful configuration.
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B.1.2.4  The Person Document

Document header 

In every person document the corresponding IBM/Lotus Notes user name can be 
found in the head area of the person document (Person Document:). The 
corresponding IBM/Lotus Notes e-mail address can be found under the user 
name. Modifications on the person document can be made via the Edit 
document button. 
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Basics tab 

Basics section: 

Server Connection section: 

Access Control area: 

Remark section: 

The Remark field provides information. The notes entered here will be displayed 
in the user data of the XPR server in the Remarks field.

Option Description

First name The first name of the user.

Middle initial The middle initial of the user.

Last name The surname of the user.

User name The hierarchical IBM/Lotus Notes user name.

Option Description

UM server Here the Unified Messaging server (XPR server) that has 
been used is displayed. If more than one UM server is 
used, the server name this user data record is to belong 
to can be selected here. In case of a server name 
alteration, server-dependent fields are automatically 
adapted (one message window per adapted field appears 
then).

UM gateway (foreign 
domain) 

Displays the foreign domain name the IBM/Lotus Notes 
Gateway is connected to.

UM user id This is the XPR user name which is used to synchronize 
the user data with the XPR server. 

UM Notes alias address If the hierarchical user name exceeds the length of 64 
characters, an alias entry will be generated automatically 
that will be entered to the XPR user data.

Option Description

Authors Displays the users that have at least author access privileges for 
this user data record. Author access privileges allow the 
modification of all fields indicated with a green tick.
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Mail section: 

State section: 

Profile section: 

Option Description

Domain The IBM/Lotus Domino domain where the user is registered 
in.

Mail Server The IBM/Lotus Domino server where the mail database of the 
user is stored on.

Mail database The name of the mail database of the user.

Forward Address Users have the possibility to forward their mail to another 
address via a forwarding address.

Option Description

UM synchronization Displays whether address book synchronization with the XPR 
server is activated or deactivated. 

Inbox replication Displays whether inbox replication is available or 
unavailable.

Option Description

... apply profile Opens a dialog wherein an existing profile can be selected. 
This profile will then be applied to the person document.

... remove history Deletes the protocol for profile application.

Profile protocol Shows when and by whom the selected profile has been 
applied to the person document.
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Standard Messaging tab 

Basics tab 

The following fields correspond to entries in the user database and affect the 
processing of documents in the XPR system.

Unified Messaging Options section: 

Option Description

User status Here you can select whether the current user has user status 
or postmaster status. All messages that could not be 
delivered are sent to the postmaster account.

UM user id A value defined here replaces the unambiguous ID which 
was generated automatically for the user during the creation 
of the person document. This value corresponds to the XPR 
user ID. If an existing XPR user account is indicated, it has 
to be considered that the values in the IBM/Lotus Notes 
person document have priority during the user data 
replication.

UM Notes alias address The IBM/Lotus Notes alias address used by the XPR server 
can be entered here.

Message Waiting ON The order sequence necessary for the message waiting 
function is entered here (e.g. CIT_BASIC/123).

Message waiting OFF If a value is entered in this field it will be used for deactivating 
the message waiting signal otherwise CIT would be used for 
deactivating it.

Representative If an XPR user account is entered in this field, all documents 
are automatically forwarded to this.
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Security section: 

Preferred delivery The preferred service for the delivery is entered here. The 
value LN is entered by default (when using the Integrated 
Messaging feature the value MAILBOX is given) if the user 
works with IBM/Lotus Notes.

Telephone The extension of the user.

Charges The cost center for call detail recording (CDR) the user is 
assigned to.

Printer The department printer configured.

UM group The user group (name) this user is assigned to on the XPR 
server.

Option Description

UM password The password for access via the XPR client. Via the ...Change 
Password link the password can be modified.

UM PIN The password (a set of digits) for access via the voice mail 
menu. Via the ...Change PIN link the PIN can be modified.
When an XPR user is created, he/she is assigned a default PIN 
for accessing the Telematic APL, which he/she needs to change 
upon the initial login. If this user is a IBM/Lotus Notes user and 
a IBM/Lotus Notes administrator changes this user's PIN before 
the user changes the PIN himself/herself, the user need not 
change the PIN upon the initial login.

Windows account In this field the name of a Windows user account can be 
entered. Thus it is possible to use this user account for login to 
the XPR system as well (single-sign-on). For further information 
on login via the Windows user account please refer to the Server 
Administration manual.

Option Description
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Send Options section: 

Telematic & Mail tab 

Numbers section: 

The calling numbers that are assigned to the different telephone-based services 
have to be entered here.

NOTE:  
Multiple entries in a field are separated by semicolon, for example 
49240490181300;49240490181301.

Option Description

Privileges denied In this field you may determine for which message types (fax, 
fax-on-demand, SMS or voice mail) the send privilege is to be 
denied.

Send as memo In this field you may determine for which message types (fax, 
fax-on-demand, SMS or voice mail) the IBM/Lotus Notes 
memo format is to be used.
This selection is only possible for messages that are sent 
internally within IBM/Lotus Notes. External messages are sent in 
a default form via the IBM/Lotus Notes Gateway.

Option Description

Fax G3 The calling number for Fax G3 messages.

Fax G4 The calling number for Fax G4 messages.

Voicemail The calling number for voice mails.

SMS The calling number used for SMS messages.
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Headers and IDs section: 

Mail Addresses section: 

Option Description

Fax G3 ID The Fax G3 identification is the calling number of the fax device 
and will be sent to the counterpart during the transmission. It 
should be identical with the Fax G3 calling number.

Fax G3 header This text is inserted in the headline of a fax message and generally 
contains a reference to the originator of the fax message.

Fax G4 ID The Fax G4 identification is the calling number of the fax device 
and will be sent to the counterpart during transmission. In 
comparison to Fax G3 there is no header in Fax G4 but the 
identification may also contain letters. It is a combination of both 
fields for Fax Group 3.

Max. SMS length Indicates the maximum number of characters that may be used in 
an SMS message. Default is 160 characters.

Option Description

UM mailbox The name of the XPR mailbox.

SMTP Address The address of an internet mail server.

MS Exchange The address of the Microsoft Exchange mail account.
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Fax Cover Page tab

Information required for the transmission of fax messages by means of the XPR 
send form can be configured in this tab. The send form makes all possibilities of 
the XPR server available for the user. It enables searching for a fax number by 
means of the recipient’s name. If possible, originator and recipient information is 
entered automatically in the corresponding fields on the cover page. The XPR 
send form itself can be used as a cover page or else it can be used in connection 
with a XPR cover page or another IBM/Lotus Notes form. 

NOTE:  Installation and usage of the XPR fax covers is described in Chapter E, 
“Using Fax Templates in IBM/Lotus Notes”.

Active Fax Cover Page section: 

Option Description

Active fax cover 
type 

Here you can select if the user shall deploy no fax cover page, 
the default fax cover page (see IBM/Lotus Notes Gateway 
configuration dialog on Section A.1.6, “Fax Cover Pages Tab”, on 
page 122) or a IBM/Lotus Notes fax cover page.

Template Setting the usable templates according to the type of cover page 
selected. The final selection of the template occurs with sending 
a fax message. 
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Originator tab 

The following fields store user information set in the corresponding fields by the 
XPR send form and thus being available for the cover page. Fields: Name, 
Company, Department, Address line 1, Address line 2, Zip, City,State, 
Country and Keyword.

Reply Address area: 

Option Description

Send Reply to If the transmission report or the error report is to be sent to another 
address than to the originator.
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Border tab 

In this tab you can perform settings for the exact arrangement of the rendered fax 
message. Fields: Upper Border, Left Border, Lower Border and Right Border. 
All values are given a pixel.
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Address Book Search tab 

The search option of the XPR send form looks for the name specified in the To: 
address field in all configured, public address books known to the local IBM/Lotus 
Notes client. This takes effect when leaving the field. As soon as an adequate 
person document is found, the information needed for the send form will be 
retrieved by searching the corresponding list of the field names. If the document 
contains the corresponding field and if a field value exists the next information will 
be searched in the document. The different field names of each configuration 
option are separated by a semicolon. 

Default values can be loaded via the Add Default button. The default values can 
be used for extracting the information required from the Domino address book 
(names.nsf). Fields: Name, Last name, Department, Telephone number, 
SMS number, Fax number, Fax on Demand number, Company, Address, Zip, 
City, State/Province, and Country. 
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Notification tab

Basics section: 

Option Description

Supported forms Here you can set the IBM/Lotus Notes forms to which a 
response is to occur in the form of a notification when a new 
message comes in (e-mail, fax, voice mail etc.). Notification 
can take place as MWI (Message Waiting Indication) or with 
an SMS to a mobile phone.
Prerequisite for using the notification function is that it is 
activated for the corresponding user in the Web Assistant 
(see the Web Assistant manual). 
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Integrated Messaging tab

NOTE:  This tab is only displayed if the Integrated Messaging Feature is 
activated in the IBM/Lotus Notes Gateway configuration dialog (see Section 
A.1.3, “Administration Tab”, on page 117).

Basics section: 

Option Description

Inbox replication Shows whether the inbox replication is enabled or disabled 
for this user data record (see also Section B.1.2, “Main 
Window”, on page 130).

Replicated forms All Notes forms listed here are allowed for replication if the 
feature “Integrated Messaging” is activated. This setting 
concerns the XPR dispatcher agent functionality in the user's 
mail database.
Only documents containing one of the listed form names in 
the 'form' field are replicated to the XPR server. Via the Add 
Default button the default values can be loaded. The default 
values are: Memo, cyMemo, cyReply.

Replicate documents 
without form 

Via this option you can set whether documents are replicated 
to the XPR server with or without form.

Replicate all 
attachments: 

This option configures whether attachments are replicated. If 
you select No here, further settings can be made via the 
following options.

Replicate only 
attachments smaller 
than: 

You can realize a restriction of the attachment size via this 
option. Enter the maximum size for attachments in kB.
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True Unified Messaging tab

In this tab you can perform settings for the support of foreign systems such as fax 
server, voice server etc. In the Basics area enter the IBM/Lotus Notes forms that 
the system is to respond to and under Support for other Systems you can set 
parameters for processing a message from a foreign system. 

Example: Fax Legacy Support 

If fax messages are to be processed by other fax message systems, a 
field definition must be entered in the Fax Service option so that the 
document coming in from the foreign system can be identified as a fax 
message. Select the ...Add field definition option for this purpose and in 
the following window enter e.g. “ServiceType” in the Field Name entry 
field and e.g. “Fax“ in the Required content field. Thus every document 
that comes in from a foreign system and contains the “Fax“ value in the 
ServiceType field is recognized as fax message and processed. Several 
field definitions may be entered.

Add notification for 
removed attachments: 

Via this option you can decide whether to inform the user 
about an attachment having been removed, e.g. because of 
its size. If you select Yes here, the notification text must be 
entered in the entry field below, as the user would not receive 
any notification otherwise.

Process UM messages 
only: 

If you select Yes here, only UM messages are processed 
here.

Option Description
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Computer Telephony Integration tab 

NOTE:  This tab is only displayed if the CTI Feature is activated in the IBM/
Lotus Notes Gateway configuration dialog (see Section A.1.10, “CTI Parameters 
Tab”, on page 127).

Basics tab 

Journal section: 

The XPR server is capable of logging all activities of a local telephone. This 
information can be transmitted to the user mail database.

In the header section of the tab, you can activate and deactivate the transfer of 
call information with the Not active option.

According to the settings chosen, further settings for the information to convey 
can be configured in the following fields.

Option Description

Incoming calls Successful: Yes /No
Not successful: Yes /No

Outgoing calls Successful: Yes /No
Not successful: Yes /No
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Logging tab

The logging options that can be set in this tab refer to all user-relevant activities. 
These take place in the user mailbox on the one hand and in the administration 
database on the other hand.

Logging section: 

Via the option Set Standard all entry fields can be preset with default settings. 
The link ...from performs default logging. The error messages (Fatal Error and 
Error) are logged in the status line. The link ...to performs default logging The 
Error messages, Warnings and Infos are logged in a logging document.

In the Error and Info area you can determine for which error and info types a 
logging entry shall be created.

Option Description

Target • Document in Database
A logging document is created that is stored in the 
administration database.

• Status Line
Logging output is logged in the status line. No logging 
document is created.

Document type If Document in Database has been selected as the target, you 
may determine here if a logging document is to be created per 
Action or per Person. One document type can also be defined 
for all logging documents.
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Message Box section: 

In this area you can set which error types are to be displayed in a message 
window. The message window then shows a system message in English. 

The Document Size area can only be configured when you have set Document 
in Database as output target.

In the Debugging area you can determine four levels of debug outputs.

Option Description

Fatal errors A fatal error that normally finishes the execution of a program. 
Logging this error type cannot be deactivated.

Error An error during the execution of the program that does, 
however, not lead to its immediate closing. Logging this error 
type cannot be deactivated.

Warning A critical program situation that does not directly lead to an error 
but could cause an error later on. Warnings can be hints for 
following errors.

Info Normal program states are logged.

Enter/Exit Logs the program stack. For example, if you invoke a 
subfunction, an invocation message is logged. This logging 
option may be used to localize a faulty program location.

Option Description

Number of items Each logging entry is inserted as a rich text field in the logging 
document. Here you can set how many rich text fields the 
logging document shall have. If all fields are filled in, the first one 
is deleted in used anew.

Bytes per item Number of bytes to be used per logging entry. The smallest size 
of a byte is 500 byte.

History capacity Shows the minimum and maximum capacity of the logging 
document in kilobyte, before old reports are overwritten.
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B.1.2.5  Prevent Deletion of the Person Document by a User

To prevent a user from deleting their person document, several lines of code must 
be added to the template. Proceed as follows: 

1. Open the mail template that is used as template for the user mail databases 
and the delivered mail template umMail.ntf in the designer.

2. In umMail.ntf open the Database Script in the Other > Database 
Resources folder and here the Querydocumentdelete object.

3. Copy the following piece of code to the clipboard:

Call cyFEC_Event_DbScript_QueryDocumentDelete ( Source, 
bCancelOperation ) 

If bCancelOperation Then 

continue=False 

Exit Sub 

End If 

4. Open the Database Script in the Other > Database resources folder and 
here the Querydocumentdelete object.

5. Search the following text in this script:

Main: 

6. Copy the code from the clipboard below this line so that the code looks like 
this:

Main: 

Call cyFEC_Event_DbScript_QueryDocumentDelete ( Source, 
bCancelOperation ) 

If bCancelOperation Then 

continue=False 

Exit Sub 

End If 

7. Save the modification and update the design of the user mail databases.

If a user now tries to delete their person document, they receive an error message 
in the status line of the IBM/Lotus Notes client.
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B.1.2.6  The Profile Document 

Global Unified Messaging settings can be made in the profile document. These 
can be applied to one or several person documents. 

NOTE:  
The person document is not directly related to the profile document. Modifications 
at the profile document are not automatically assumed by the person document. 
In this case, the modified profile document needs to be applied to the person 
document again (see also Section B.1.2.4, “The Person Document”, on page 
142).

Most of the fields that have been described in Section B.1.2.4, “The Person 
Document”, on page 142 are available here as well. Fields that are not editable 
are filled with values during the Domino Directory Synchronization (see 
Section 4.2.4.1, “Administration Database for the supported IBM/Lotus Notes 
Versions”, on page 68).
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Design Elements of the XPR Mail Template

XPR Mail Template for the supported Versions of IBM/Lotus Notes

C  Design Elements of the XPR Mail Template

C.1  XPR Mail Template for the supported Versions of IBM/Lotus Notes

C.1.1  General Considerations

The mail template for the supported versions of IBM/Lotus Notes is stored on the 
XPR server in the folder <XPR Install>\res\LnApl\TemplatesR6, <XPR 
Install>\res\LnApl\TemplatesR7 respectively <XPR 
Install>\res\LnApl\TemplatesR8 etc. after the IBM/Lotus Notes Gateway 
installation. 

NOTE:  If you use IBM Notes 9.0 Social Edition (Basic Configuration) and IBM 
Domino 9.0 Social Edition, use the mail templates for Lotus Notes 8.

This folder contains one multilingual mail template entitled ummail.ntf including 
all design elements for all available languages. This template is merged with a 
multilingual IBM/Lotus Notes mail template. 

NOTE:  All licensed languages can be used as long as they exist also in the 
Notes mail template. The language can be selected during the later design 
update.

The user mail database can inherit a language from the complete template. The 
following languages are available at the moment:

• German

• English

• French

• Italian

• Spanish

• Dutch

• Portuguese (Portugal)

• Portuguese (Brazil)

• Russian

• Turkish
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Names:

The single design elements of the mail template are described in detail in the 
following paragraphs.

C.1.2  Script Libraries

The mail template for the supported versions of IBM/Lotus Notes contains script 
libraries representing the basis for all other mail templates used with IBM/Lotus 
Notes. 

File name ummail.ntf

Database name Mail Tmpl 6.0, Mail Tmpl 7.0

Template name umMail_Tmpl_6.0_R6, umMail_Tmpl_7.0_R7, 
umMail_Tmpl_8.0_R8

Name Function Miscellaneous

cyBec (Backend Classes) 

• Unified Messaging Backend 
features that are used e.g. for 
server agents.

• Requires script library cyLog 
• Requires script library cyCfg 
• Must always be installed.

cyFec (Frontend Classes) 

• Unified Messaging Frontend 
features that are uses for agents 
with graphic user interface.

• Requires script library cyLog 
• Requires script library cyCfg 
• Requires script library cyRes 
• Requires script library cyBec 
• Must always be installed.

cyCfg (Configuration Library) 

• Access to configurations in the 
administration database.

• The features are used to identify 
configuration settings or modify 
them on the user side.

• Requires script library cyLog 
• Requires script library cyRes 
• Use the cyAllUmPerson view if it 

exists.
• Use the cyUmPersonAsMemo 

view if it exists.
• Must always be installed.

cyDoc (Document Library) 

• Unified Messaging extensions to 
the IBM/Lotus Notes documents 
such as Memo and Reply that are 
used within the Unified 
Messaging documents cyMemo, 
cyReply, cyFax, cyVoice, 
cyFaxReply etc.

• Requires script library cyLog 
• Requires script library cyCfg 
• Requires script library cyRes 
• Requires script library cyUtl 
• Requires form Control Master 
• Requires form Control Slave 
• Requires subforms Fax Viewer 

Control and Wave Player Control 
• Requires subforms Recipient Info 

and UM Message Dialog 
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C.1.3  Forms

The Unified Messaging forms are based on the two main forms cyMemo and 
cyReply. 

All other forms such as cyFax or cyVoiceReply set their specific parameters in 
QueryOpen during creation and then open the document with the form cyMemo 
or cyReply.

cyLog (Logging Library) 

• Class for selected output of 
errors, warnings and information 
on system level. Can be used to 
write program run protocols into 
documents.

• All messages that are logged via 
the logging class are system 
messages in English.

• Must always be installed.

cyRes (Response Strings) 

• Collection of messages for the 
user that are translated into all 
available languages.

• Must always be installed.

cyUtl (Utilities Library) 

• Collection of basic tools that can 
be used at different locations.

• Requires script library cyLog 
• Requires script library cyCfg 
• Requires script library cyRes 
• Requires form 

cyChooseDatabase 
• Must always be installed.

Name Function Miscellaneous
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Name Function Miscellaneous

Unified Messaging Memo alias cyMemo

• Creates documents and 
displays them. Their look 
(fax, SMS, voice mail, etc) is 
stored in the document or is 
determined during the 
creation of the document.

• The form is the Unified 
Messaging representation of 
the IBM/Lotus Notes memo 
form.

• E.g. entering of Unified 
Messaging configurations 
and the address and phone 
number search.

• Shows fax and voicemail in 
the opened document in a 
separate ActiveX control.

• Contains special buttons e.g. 
for the playback of 
voicemails on a local user 
telephone.

• Requires subforms mrsFaxViewer, 
mrsWavePlayer and 
mrsWavePlayerShallow, if fax 
messages are to be displayed e.g. voice 
mails played back via sound card.

• Requires subform cyRecipient 
• Requires subform 

cyDelOptionSubform 
• Requires script library cyFec 
• Requires script library cyDoc 
• Requires script library cyLog 
• Requires script library cyCfg 
• Requires script library cyRes 
• Requires script library cyBec 
• Requires script library cyUtl 

Unified Messaging Reply alias cyReply

• Creates reply documents 
and displays them. Their look 
(fax reply, SMS reply, voice 
mail reply, etc) is stored in 
the document or is 
determined during the 
creation of the document.

• The form is the Unified 
Messaging representation of 
the IBM/Lotus Notes reply 
form. 

• Additional features see 
Unified Messaging Memo 
(cyMemo). 

• See Unified Messaging Memo 
(cyMemo). 

Unified Messaging\Fax alias cyFax

• Is required for the creation of 
fax messages. The fax 
document is created as 
cyMemo and sent via the 
XPR server.

• Requires form cyMemo and the design 
elements mentioned there.

Unified Messaging\Fax-on-Demand alias cyFod

• Is required for the creation of 
a fax-on-demand document. 
The fax-on-demand 
document is created as 
cyMemo and sent via the 
XPR server.

• Requires form cyMemo and the design 
elements mentioned there.
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Unified Messaging\SMS alias cySms

• Is required for the creation of 
SMS messages. The SMS 
document is created as 
cyMemo and sent via the 
XPR server.

• Requires form cyMemo and the design 
elements mentioned there.

Unified Messaging\Voicemail alias cyVoice

• Is required for the creation of 
a voice mail. The voicemail 
document is created as 
cyMemo and sent via the 
XPR server.

• Requires form cyMemo and the design 
elements mentioned there.

Unified Messaging\Fax Reply alias cyFaxReply

• Is required for the creation of 
a fax reply document. The 
document is created as 
cyReply and sent via the 
XPR server.

• Requires form cyReply and the design 
elements mentioned there.

Unified Messaging Reply\Fax-on-Demand alias cyFodReply

• Is required for the creation of 
a fax-on-demand reply. The 
document is created as 
cyReply and sent via the 
XPR server.

• Requires form cyReply and the design 
elements mentioned there.

Unified Messaging\SMS Reply alias cySmsReply

• Is required for the creation of 
an SMS reply message. The 
document is created as 
cyReply and sent via the 
XPR server.

• Requires form cyReply and the design 
elements mentioned there.

Unified Messaging\Voicemail Reply alias cyVoiceReply

• Is required for the creation of 
a voice mail reply. The 
document is created as 
cyReply and sent via the 
XPR server.

• Requires form cyReply and the design 
elements mentioned there.

cyUmPerson alias cyUmPerson

• The form serves to open the 
person document in the 
administration database by 
double-clicking the copy in 
the user's mail database.

• Opening the copy is diverted 
to opening the original in the 
administration database as 
long as a connection exists.

• It is not possible to open the 
copy itself.

• Requires the agent cyUmSettings and 
the design elements mentioned there.

Name Function Miscellaneous
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(cyChooseDatabase) alias cyChooseDatabase

• Form for a dialog box 
wherein a database may be 
selected. It is required to 
open the person document in 
the administration database.

• If there is no copy in the mail 
database and thus the 
location in the administration 
database is unknown, the 
database can be selected 
manually here.

• - / -

(cyLogDoc) alias cyLogDoc

• This form is used to view 
logging output documents. 
Logging output documents 
are generated when the 
logging has been configured 
to write the output in a 
document. The documents 
are displayed in the 
cyLogging view and can be 
opened with the form 
cyLogDoc there.

• - / -

(ControlSlave) alias cyControlSlave

• This form is used to provide a 
$REF field for the cyMemo 
document.

• Is required for fax and voice 
functionality.

• Works with installed ActiveX-Controls 
only.

cySimpleDialer alias cySimpleDialer

• This form is used 
OpenScape Xpressions to 
use the SimpleDialer in a 
mail template.

• Requires the cyDialerAgent agent.

Name Function Miscellaneous
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C.1.4  Views 

Name Function Miscellaneous

(cyUnifiedMessaging) alias cyUnifiedMessaging

• The view shows the copy of the 
person document, in exceptional 
cases also some older copies that 
could not be deleted.

• From this view it is possible to 
modify the person document in the 
administration database, but only 
to the extent the user privileges and 
settings by the system 
administrator permit.

• The user can switch logging on and 
off via this view.

• Requires the agent 
cyUmSettings and the design 
elements mentioned there.

• Requires the extended outline 
NotesMailOutline. 

(cyLogging) alias cyLogging

• This view displays all logging 
documents that have been 
generated by activated logging in 
the mail database.

• The documents can be opened and 
removed.

• The form cyLogDoc is required 
for opening.

• This view requires the extended 
outline NotesMailOutline. 

(cyAllUmPerson) alias cyAllUmPerson

• Via this view copies of person 
documents that can be used or 
possibly deleted are searched in 
the mail database.

• This view must always be 
installed. If it does not exist, the 
search is performed via Database 
search.

(cyUmPersonAsMemo) alias cyUmPersonAsMemo

• Via this view copies of person 
documents are searched in the mail 
database that have been sent via 
mail to the administration database 
and that have not been 
transformed automatically into a 
person document by the running 
dispatcher cyDispatcher agent.

• The mail is converted to a person 
document and used or possibly 
removed.

• This view must always be 
installed. 

(UM Debug View) alias cyDebug

• Is required for debugging. • This view must always be 
installed.

cyJournals

• Displays fax message delivery 
reports.

• This view must be installed for 
sending and receiving fax 
messages.
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C.1.5  Agents 

Name Function Miscellaneous

cyDispatcher alias mrsDisp

• In the context of Unified 
Messaging functionality the agent 
transforms the person 
documents coming in from the 
administration database via mail 
back into a person document.

• If this step is skipped, the user 
can see the mail in his inbox. 
However, it disappears as soon 
as he accesses his configuration 
in the person document.

• Requires script library cyBec
• See also feature description of the 

XPR dispatcher agent in Section 
C.1.9, “Design Elements for IM and 
TUM Functions”, on page 172.

(cyUmLoggingOff) alias cyUmLoggingOff

• The agent switches logging off for 
a user in a document. The agent 
is called via the 
cyUnifiedMessaging view.

• Requires script library cyCfg
• Requires script library cyUtl

(cyUmLoggingOn) alias cyUmLoggingOn

• The agent switches logging on for 
a user in a document. The agent 
is called via the 
cyUnifiedMessaging view.

• Requires script library cyCfg
• Requires script library cyUtl

(cyUmSettings) alias cyUmSettings

• The agent opens the original 
person document in the 
administration database.

• The user can modify the 
configurations activated in this 
document.

• For finding the administration 
database a copy of the person 
document (also in mail format) 
must be available in the mail 
database of a user. The user will 
otherwise be prompted to specify 
the memory location of the 
administration database.

• If the connection to the 
administration database is 
interrupted, the configurations 
cannot be modified or viewed. In 
this case the system works with a 
copy of the person document, 
e.g. if the user is away on 
business with his/her notebook.

• Requires script library cyCfg
• Requires script library cyUtl
• Requires script library cyRes
• Requires form cyChooseDatabase
• Requires additional design 

elements from the administration 
database.

(Reset UM Parameters) alias cyUMReset

• Is required for debugging. • Should always be installed as well.
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C.1.6  Outlines 

C.1.7  Subforms 

(Document Dump) alias cyDump

• Is required for debugging. • Should always be installed as well.

Dialer Agent alias cyDialerAgent

• With OpenScape Xpressions this 
agent is used for the 
SimpleDialer.

• Requires form cySimpleDialer.

Name Function Miscellaneous

NotesMailOutline alias MailOutline

• Advanced IBM/Lotus Notes outline 
(MailOutLine) with an additional 
folder Unified Messaging under 
Tools.

• Here the two views 
cyUnifiedMessaging and 
cyLogging can be viewed.

• The default IBM/Lotus Notes 
outline can be exchanged for this 
extended outline or manually 
supplemented with the contained 
parameters.

Name Function Miscellaneous

(Browser Control) alias cyBrowser

• ActiveX Control for browser display 
for the forms cyMemo and 
cyReply.

• Is currently not used.

(Fax Viewer Control) alias cyFaxViewer

• ActiveX Control for fax display for 
the forms cyMemo and cyReply.

• - / -

(Wave Player Control ) alias cyWavePlayerShallow

• ActiveX Control for wave playback 
feature for the forms cyMemo and 
cyReply.

• - / -

cyDelOptionSubform alias cyDelOptionSubform

• Subform for additional Unified 
Messaging options for the forms 
cyMemo and cyReply.

• Derived from the Notes default 
form DelOptionSubform.

(Recipient Info) alias cyRecipient

• The subform shows recipient 
information.

• Is currently only used for fax.

Name Function Miscellaneous
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C.1.8  Shared Actions

(UM Message Dialog) alias cyMessageDlg

• Display box for dialog with the user. • - / -

Name Function Miscellaneous

Cycos New Fax

• Calls the cyMemo form in the fax generation version. • - / -

Cycos New FoD

• Calls the cyMemo form in the Fax-on-Demand 
generation version.

• - / -

Cycos New SMS

• Calls the cyMemo form in the SMS generation version. • - / -

Cycos New Voice

• Calls the cyMemo form in the voice mail generation 
version.

• - / -

Cycos Forward Fax

• Calls the cyMemo form in the fax forward version. • - / -

Cycos Forward FoD

• Calls the cyMemo form in the Fax-on-Demand forward 
version.

• - / -

Cycos Forward SMS

• Calls the cyMemo form in the SMS forward version. • - / -

Cycos Forward Voice

• Calls the cyMemo form in the voice mail forward 
version.

• - / -

Cycos Reply Fax

• Calls the cyReply form in the fax reply version. • - / -

Cycos Reply FoD

• Calls the cyReply form in the Fax-on-Demand reply 
version.

• - / -

Cycos Reply SMS

• Calls the cyReply form in the SMS reply version. • - / -

Cycos Reply Voice

• Calls the cyReply form in the voice mail reply version. • - / -

Cycos Reply All Fax

• Calls the cyReply form in the fax reply version. • Reply to all 
originators.

Name Function Miscellaneous
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Cycos Reply All FoD

• Calls the cyReply form in the Fax-on-Demand reply 
version.

• Reply to all 
originators.

Cycos Reply All SMS

• Calls the cyReply form in the SMS reply version. • Reply to all 
originators.

Cycos Reply All Voice

• Calls the cyReply form in the voice mail reply version. • Reply to all 
originators.

Cycos History Reply Fax

• Calls the cyReply form in the fax reply version. • The content of 
the received 
message is 
sent as well.

Cycos History Reply FoD

• Calls the cyReply form in the Fax-on-Demand reply 
version.

• The content of 
the received 
message is 
sent as well.

Cycos History Reply SMS

• Calls the cyReply form in the SMS reply version. • The content of 
the received 
message is 
sent as well.

Cycos History Reply Voice

• Calls the cyReply form in the voice mail reply version. • The content of 
the received 
message is 
sent as well.

Cycos History Reply All Fax

• Calls the cyReply form in the fax reply version. • Reply to all 
originators. The 
content of the 
received 
message is 
sent as well.

Cycos History Reply All FoD

• Calls the cyReply form in the Fax-on-Demand reply 
version.

• Reply to all 
originators. The 
content of the 
received 
message is 
sent as well.

Name Function Miscellaneous
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C.1.9  Design Elements for IM and TUM Functions

Using IM and TUM requires additional design elements. Furthermore, design 
elements already available in the IBM/Lotus Notes default mail template must be 
modified, so that the features can be used. 

C.1.9.1  Default Form Memo 

The default form Memo must be modified for IM and TUM features. The changes 
are necessary so that message status changes (e.g. from unread to read), etc. 
can be communicated to the XPR system because the message status must also 
be changed there. 

IMPORTANT:  If you modify a mail template showing company-specific modifi-
cations already, you must manually integrate the values listed in the following 
table in the template.

In case of a mail template that exclusively contains IBM/Lotus Notes default 
design elements you can copy the memo form over the existing one.

Cycos History Reply All SMS

• Calls the cyReply form in the SMS reply version. • Reply to all 
originators. The 
content of the 
received 
message is 
sent as well.

Cycos History Reply All Voice

• Calls the cyReply form in the voice mail reply version. • Reply to all 
originators. The 
content of the 
received 
message is 
sent as well.

Object Event Added

Memo (form) (Globals) Memo Options Use "cyFec"

Memo (form) Queryopen as 1. instruction Call 
cyFEC_Event_Form_QueryOpen(Sourc
e, Mode, IsNewDoc)

Memo (form) Postopen as 1. instruction Call cyFEC_Event_Form_PostOpen

Name Function Miscellaneous
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To manually integrate the values listed in the table above to the mail template 
showing company-specific modifications - based on Section 4.4.3.4, “Basic 
Steps” procedures - proceed as follows:

1. Open the following mail templates in the Lotus Domino Designer client:

• companymail.ntf

• UmMailEN.ntf

2. Open the Message (Memo) Element inside the FORM folder of the 
UMMailEN.ntf and add the following script code to the corresponding 
Message (Memo) Element inside FORM folder of the file companymail.ntf:

- FORM Message (Memo)

Object: (Globals)Memo 

Event: Options

Use "cyFec"

Object: Memo (Form) 

Event: Queryopen 

Call cyFEC_Event_Form_QueryOpen(Source, Mode, 
IsNewDoc)

Object: Memo (Form)

Event: Postopen 

Call cyFEC_Event_Form_PostOpen

3. Save the modifications performed in the companymail.ntf file.

C.1.9.2  Default Design Element ($Inbox) 

A number of modifications must be made to this standard IBM/Lotus Notes design 
element to transfer status changes from documents in the IBM/Lotus Notes inbox 
to the XPR server and to be able to display the actual 'Read/Unread' status for 
documents which were replicated to the XPR system.

Among other graphic elements, a column must be inserted displaying whether the 
message has been read or not via a symbol (open or closed envelope). This 
displays the status both in XPR and in IBM/Lotus Notes.
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A message shown without an envelope icon is a message which is not replicated 
with the XPR system. This can be configured via the mask used in the messages 
(XPR administration database). 

IMPORTANT:  The default design element ($Inbox) in FOLDERS folder of the 
file companymail.ntf must be modified manually! Therefore you need to enter 
the parameters described in the following section manually in the design element.

Do not copy the complete design element to the mail template you wish to create.

The default shared action RemoveFromFolder must be exchanged for the 
modified shared action CycosRemoveFromFolder. 

C.1.9.3  Default design element Database Script 

To ensure that documents deleted in the inbox are also deleted in the XPR system 
the above IBM/Lotus Notes events are used. Thus it is necessary to modify this 
default IBM/Lotus Notes design element manually with the IBM/Lotus Domino 
Designer client. 

NOTE:  Since it is not possible to copy the design element Database Script itself, 
the following modifications must be made manually.

Object Event Added

Add additional column at second position:
Column value formula:
@If ( ! @IsAvailable (MRS_ORIGINALID); 0;
@If (MRS_Read = "True"; 125; 122) )
Important information on the design of the new column:
Width=2, Display values as icons = Yes

Object Event Added

<Template name> 
(Database Script)

Options Use "cyFec" 

<Template name> 
(Database Script)

Querydocumentdelete In the lower part next to the instruction
If Not(profiledoc Is Nothing)
Then Delete profiledoc
the instruction
If (Not bCancelOperation) Then 
Call
cyFEC_Event_DbScript_PostDocume
ntDelete(Source)
 needs to be inserted.
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To manually integrate the values listed in the table above to the mail template 
showing company-specific modifications - based on Section 4.4.3.4, “Basic 
Steps” procedures - proceed as follows:

1. Open the mail template companymail.ntf in the Lotus Domino Designer 
client.

2. In the companymail.ntf file, go to the Other > Database Resources folder 
and open the Database Script.

3. In the Database Script, add the following code to the Options event.

Use "cyFec"

4. In the Database Script, locate the Querydocumentdelete event, and:

1. Search for the following instruction:

If Not(profiledoc Is Nothing) Then Delete profiledoc

2. In the lower part next to this instruction, add the following code:

Call cyFEC_Event_DbScript_QueryDocumentDelete ( 
Source, bCancelOperation )

If bCancelOperation Then

continue=False

Exit Sub

End If

If (Not bCancelOperation) Then Call 
cyFEC_Event_DbScript_PostDocumentDelete(Source)

5. Save the modifications.
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C.1.9.4  cyDispatcher Agent Settings

The settings of the cyDispatcher agent must be, also, modified for IM and TUM 
features.

1. Open the created mail template companymail.ntf - based on Section 4.4.3.4, 
“Basic Steps” procedures - in the Lotus Domino Designer client.

2. Change to the Agents view and open the cyDispatcher Agent with a double-
click.

3. Configure a schedule (e.g., Periodically: daily) and click on the Schedule 
button. Select the option Any Server under Where the Agent Runs - Run 
on. Finish this dialog by clicking OK and reset the schedule to On event - 
Before new mail arrives.

4. On Security tab set the agent to Run on Behalf of the Xpressions Connector 
user.

5. Set the runtime security level to level “3. Allow restricted operations with 
full administrator rights”.

6. Save your settings.

NOTE:  Please note that possibly the security settings of the IBM/Lotus Domino 
server must be adapted so that the agent can be executed. 
You must also ensure that the agent runs in the security context of a IBM/Lotus 
Notes user ID, which contains the appropriate access privileges.

IMPORTANT:  The cyDispatcher agent must be signed in the server context or 
executed, since otherwise no replication of messages and message states is 
possible. 

C.1.9.5  Minimum Security for the Signer of the Notes Template

To ensure that the Notes client can execute all commands, scripts and agents 
developed for TUM and IM you need to check the security settings of the Notes 
client under File > Security > User Security > What Others Do. 
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The signer of the Notes Template must activate the following check boxes:

• Allow access to:

– File system

– Network

– External code

– External programs

– Current Notes database

– Non-Notes databases

– Environment variables

• Allow ability to:

– Send mail

– Export data

– Read other Notes databases

– Modify other Notes databases

– Modify your Execution Control List

If you do not set the above options, the Notes clients will show the Notes 
Security Alert dialog and ask for permission to execute them.
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C.1.9.6  Steps to manually create a UM Mail template

To manually create a UM Mail template, you need to use the mail templates for 
the supported versions of the IBM/Lotus Notes, which are stored in the setup 
directory of the XPR server in the folders <XPR 
Install>\res\LnApl\TemplatesR6, <XPR 
Install>\res\LnApl\TemplatesR7, or <XPR 
Install>\res\LnApl\TemplatesR8 etc., respectively, after the IBM/Lotus Notes 
Gateway is installed.

NOTE:  You need to create a separate UM Mail template for each desired 
language.

Proceed as follows:

1. Copy the mail template extension umMail.ntf to the data directory of the local 
Lotus Notes Client (default: C:\Program Files\lotus\notes\data).

2. Create a language-reduced mail template extension on the Lotus Domino 
server. Therefore you need to create a new database on the Lotus Domino 
server and apply the locally stored mail template extension Mail Tmpl X.x as 
template for the new database. X.x. represents the template version.

3. Go to Application - New menu

4. Name the new template file UmMailEN.ntf for English, for example.

5. Select the umMail.ntf as New database template. Confirm with OK.

6. Select the desired template language on the next screen. e.g English. 
Confirm with OK.

7. On database properties activate the Database file is a master template and 
enter a name for the template (e.g. UmMailEN)

8. Deactivate the option Inherit design from master template

9. Create a new database template in your local work environment. Name the 
database template e.g. companymail. Select the entry Empty as the template 
for the new database. Confirm with OK.

10. Open the Properties dialog of the created template (in this example the file 
companymail.ntf) and change to the Design tab.

11. Activate the Inherit design from master template option and enter StdR86Mail 
as template name.

12. Activate the Database file is a master template option and enter 
Companymail as template name. Close the Properties dialog.
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13. Select the template in your work environment and update the design with File 
> Database > Refresh design.

14. After the design update has been completed, open the companymail.ntf 
template in the Lotus Domino Designer client.

15. In the Designer client, open the mail template extension UmMailEN.ntf you 
have created in addition to the companymail.ntf template.
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C.2  Installation of the IBM/Lotus Notes Client Components

You find the setup files of the IBM/Lotus Notes client components on the XPR 
installation medium in the 
XpressionsInstall\AddOn\Client\LotusNotes directory. The following 
folders are filed there: 

• Folder ActiveX:

The installation files for the ActiveX components can be found here.

• Folder LnFax:

The installation files for the client component XPR fax can be found here.

• Folder LnConfPlugin:

Here you find the installation files for the conference plugin.

C.3  Installation of the ActiveX Components

The ActiveX components are used for viewing fax messages and for the playback 
of voice mails (in WAV format or via the telephone) under IBM/Lotus Notes. 

Therefore, you have to install the files CycosFaxView.ocx and CycosWav.ocx 
during the setup. The installation program stores these files in the folder 
C:\Programs\Common Files\Siemens\Controls by default.

NOTE:  
Section E.7, “Configurable Parameters in setup.ini Files”, on page 226 describes 
how to configure the installation options.

If you work in a terminal server environment, you need to unregister and 
subsequently register the OCX files by executing the following steps.

1. Open a Microsoft command prompt with administrator privileges.

• Execute the following substeps on Windows 7 for this purpose:

a) Open Start > All Programs > Accessories.

b) Rightclick the menu option Command Prompt.

c) Select Run as administrator.

d) In the User Account Control dialog, answer the question Do you 
want to allow the following program to make changes to this 
computer? with a click on Yes.

• Execute the following substeps on Windows XP for this purpose:
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a) Open Start > Programs > Accessories.

b) Rightclick the menu option Command Prompt.

c) Select Run as....

d) Select the account with administrator privileges that should execute 
the command prompt.

e) Enter a password if required.

f) Click on OK.
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2. In this command prompt, enter two commands according the ensuing pattern 
for the files CycosWav.ocx and CycosFaxView.ocx to unregister them:

regsrv32 /u “<path>\CycosWav.ocx”
regsrv32 /u “<path>\CycosFaxView.ocx”

Examples:

3. Now you need to register both files again:

regsrv32 “<path>\CycosWav.ocx”
regsrv32 “<path>\CycosFaxView.ocx”

Examples:

regsrv32 /u “C:\Programs\Common Files\Siemens\Controls\CycosWav.ocx“
regsrv32 /u “C:\Programs\Common Files\Siemens\Controls\CycosFaxView.ocx“

regsrv32 “C:\Programs\Common Files\Siemens\Controls\CycosWav.ocx“
regsrv32 “C:\Programs\Common Files\Siemens\Controls\CycosFaxView.ocx“
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C.4  XPR Fax Installation

The XPR fax printer driver is used to send fax messages from other applications 
via IBM/Lotus Notes. The printer driver has to be installed on each workstation. 

You find the setup program on the XPR setup medium in the path 
XpressionsInstall\AddOn\Client\LotusNotes\LnFax. The setup 
installs two new printer drivers on the user workstation (Fax G3/G4). The printer 
driver creates documents in Tiff format, calls the IBM/Lotus Notes client after 
having created a fax document and opens a configurable mask via the fax 
document file attachment.

NOTE:  Section E.7, “Configurable Parameters in setup.ini Files”, on page 226 
describes how to configure the installation options.

The mask to be used by the IBM/Lotus Notes client can be selected from the 
newly added XPRfax menu item in the Actions menu. The IBM/Lotus Notes 
password also has to be entered in this dialog so that the printer driver is capable 
of creating a document via the IBM/Lotus Notes API.

Furthermore, you should activate the option Don’t prompt for a password from 
other Notes-based programs File > Tools > User ID. By this means, the 
password is not queried when the IBM/Lotus Notes client is already running.

You have to enter the IBM/Lotus Notes user password in the Authentication 
area. It is used for opening the IBM/Lotus Notes client. If you activate the option 
Remember Password you do not have to enter your password at the start of the 
IBM/Lotus Notes client via the fax printer driver.

You can select the fax template you want to use in the Send Form area. If the 
advanced mail templates are installed, you have to enter cyMemo here. Click the 
Default button to have the server default form entered (see also Section A.1.9, 
“Mail Forms Tab”, on page 126). 
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C.4.1  Configuration of the Printer Driver

After a successful installation of MRS Fax, the printer driver Tiff Fax G3 
TurboBits Printer has been added to the system. Normally, the printer driver is 
readily configured after the installation so that no changes are required. 

If you want to change the settings of the printer driver proceed as follows:

1. Open the window with the view of the printers installed (Start > Settings > 
Printer).

2. Right-click on the entry Tiff Fax G3 TurboBits Printer and select the 
Properties menu item.

3. The properties of the printer driver are shown.

4. Move to the Ports tab and select the printer driver from the list. Press the 
Configure Port... button.

5. Select the option Lotus Notes in the Client area.

6. Configure the path to the files CycosExt.dll and CycosMenu.dll in the 
Directory area. These files are by default installed in the Directory 
C:\Lotus\Notes.

7. Confirm your entries with OK.

File name Explanation

CycosExt.dll This file calls the IBM/Lotus Notes client with user name and 
password from the Notes.ini.

CycosMenu.dll Expands the Actions menu in the IBM/Lotus Notes client by the 
MRS Fax entry. Via this entry the fax printer driver can be 
configured. See also Section C.4, “XPR Fax Installation”, on 
page 183
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Installing and Integrating optiClient 130

Requirements for the Integration into IBM/Lotus Notes

D  Installing and Integrating optiClient 130

IMPORTANT:  The present optiClient 130 version already contains program 
modules the functions of which have not been completely tested yet. Therefore 
they remain inactive after the optiClient 130 standard installation. Activation of 
these modules at a later date is exclusively permitted for testing purposes.

The scope of optiClient 130 features as well as the function performance depend 
on the communication system at which optiClient 130 is operated and on the 
optiClient 130 modules configured on the user-PC.

optiClient 130 configuration modifications performed at runtime will not be saved 
in the configuration files until the program has been properly shut down.

Among configuration modifications particularly concerned you find: information 
about newly added, removed or modified contacts as well as information about 
newly added, removed or modified modules.

D.1  Requirements for the Integration into IBM/Lotus Notes

To set up the IBM/Lotus Notes integration, a IBM/Lotus Notes client must already 
be installed on the user computer. If such a client does not exist, the IBM/Lotus 
Notes integration is not available during the optiClient 130 setup.

The existence of a IBM/Lotus Notes client is checked on the basis of the following 
key in the Windows registry: 

HKLM\Software\Wow6432Node\Lotus\Notes

This key is searched for the value Path. If this value exists, the optiClient 130 
setup assumes an installed IBM/Lotus Notes client.

D.2  Concept of the Integration into IBM/Lotus Notes

The IBM/Lotus Notes integration expands the IBM/Lotus Notes client by 
optiClient 130 functions and makes these features available to the IBM/
Lotus Notes user.

The following functions are added to the IBM/Lotus Notes client:

• Initiating a call

• Phone number resolution based on IBM/Lotus Notes address books
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You find additional information in the OpenScape Xpressions optiClient 130 
manual.

D.3  Installing optiClient 130

This section contains information about the following topics: 

D.3.1  General Installation Information

D.3.1.1  Quality of Service (QoS) 

Voice information transmission is considered a time-critical service in data 
networks. This means that the quality of such a voice transmission depends very 
much on the load conditions in the respective network. 

Three network parameters in particular influence the voice information 
transmission in a network:

• The average delay by the network (Delay)

• The temporal delay change (Jitter)

• The loss of voice information within the network (Loss) 

The extent of negative influence by these three factors during a voice 
transmission depends mostly on the average and temporal load in the network.

To optimize transmission of voice information via a data network, optiClient 130 
can use the Windows QoS-packet scheduler. If this service is used, voice 
information is higher prioritized in the network than normal data information. The 
result is in most cases a significant increase in voice quality.

Selected QoS Methods 

QoS comprises different methods to ensure specific quality characteristics in a 
transmission. Since the IP-protocol is meanwhile first choice for voice information 
transmission, we will in the following only deal with the QoS mechanisms realized 
by this selected protocol.

With transmitting voice information via data-networks it is important to ensure a 
sufficient, constant transmission bandwidth for the entire duration of the 
transmission.

• General Installation Information page 186

• Configuring the QoS Service page 189

• Performing the Installation page 192
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If several applications operate via the IP-protocol at the same time, the available 
transmission bandwidth of a transmission network is divided among these 
applications. Under specific conditions it may happen that e. g. not all applications 
receive the same transmission bandwidth. Especially with applications that 
receive a low transmission bandwidth, data may be transferred with massive 
delays. If this is the case with an application transmitting voice information, a poor 
voice quality is the result.

To avoid the suppression of voice traffic by classic data traffic in such a way or 
similar, voice traffic can be higher prioritized in the IP-protocol. These 
specifications are made on Layer 2 and 3 of the OSI 7-Layer model:

• The three bits are used in the 802.1p field on Layer 2. This field is part of 
802.1Q-Tag. 

• On Layer 3 the six bits of the DiffServ Code Point (DSCP) field in the IP 
protocol header are used. 

If these IP protocol mechanisms are used, it must be ensured that the network 
infrastructure used evaluates and converts the prioritization information into an 
actual transmission prioritization. Beyond that it is important that sufficient 
bandwidth is available in the prioritization classes each.

You will find further information on DiffServ Code Point and 802.1p/Q in the 
following standards:

• RFC 2474- Definition of the Differentiated Services Field in the IPv4 and 
IPv6 Headers of the IETF (http://www.rfc-editor.org/)

• RFC 2475- An Architecture for Differentiated Services
of the IETF (http://www.rfc-editor.org/)

• 802.1Q - Virtual LANs
of the IEEE (http://www.ieee.org/)
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General QoS Activation Steps 

NOTE:  
QoS mechanisms should only be configured if optiClient 130 is used as 
softphone, thus directly operated at a PBX, the provider module used in 
optiClient 130 supports QoS mechanisms and the network infrastructure used 
evaluates QoS information.

IMPORTANT:  
It is not possible to use QoS and VPN together with a SIP connection of 
optiClient 130.

To activate QoS mechanisms in an optiClient 130 environment , perform the 
following settings:

• In the optiClient 130 provider module used, QoS must be activated for 
usage.

• The QoS Scheduler service must be  installed and configured on the 
relevant PC.

• An unused QoS service for controlling the network traffic must be 
deactivated on the relevant user-PC.

D.3.1.2  General optiClient 130 Installation Steps 

optiClient 130 is set up via the following steps: 

IMPORTANT:  
Perform the following installation steps in the indicated sequence. Otherwise the 
installation may be corrupt and lead to optiClient 130 malfunctions.

• Installation and configuration of the QoS packet scheduler on the user 
PC 

The QoS packet scheduler ensures optimum quality for the transmission of 
voice information via the local network (cf. Section D.3.2, “Configuring the 
QoS Service”, on page 189).
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• Installation of the optiClient 130 software on the user PC 

In this step the basic installation of the optiClient 130 on the user PC is 
performed. All available optiClient 130 modules will be installed in this 
process. However, only those required for connecting the optiClient 130 to an 
XPR server will be automatically activated.

• If required, configuration of communication system parameters 

Individual settings may have to be performed for specific communication 
systems. If optiClient 130 is e.g. directly operated at a HiPath 4000, so-called 
AMOs must be configured on the HiPath 4000.

D.3.2  Configuring the QoS Service

NOTE:  
Only configure the QoS packet scheduler, if optiClient 130 is used as softphone, 
thus directly operated at a PBX, QoS mechanisms are supported by the provider 
module used in optiClient 130 and the network infrastructure used evaluates QoS 
information

For using QoS mechanisms the QoS packet scheduler must be installed and 
correctly configured on the user-PC. How to proceed:

1. Under Windows open Start > Settings > Control Panel > Network 
Connections > Local Area Connection. The following dialog pops up: 

2. Select the Properties button. The following dialog pops up: 
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If the QoS packet scheduler is already contained in the list of elements used, 
please continue with step 7 on page 191. 

3. Click the Install button. Up comes this dialog:

4. In the list select the Service entry and click on Add.... The following dialog 
opens:
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5. Select the QoS Packet Scheduler entry and click the OK button. Up comes 
this dialog: 

6. Verify that a tick precedes the QoS Packet Scheduler entry in the list of 
elements used. Click the Close button.

7. In the General tab select the Properties button again. The Local Area 
Connection Properties dialog opens.

8. Select the Configure button. The properties dialog appears for the network 
card installed.

9. Switch to the Advanced tab. Up comes this dialog:

10. Make sure that the two properties 802.1p Support and FlowControl are set 
to value Enable each.
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11. Copy the performed settings with the OK button.

12. Close the Local Area Connection Properties dialog with the OK button.

13. Then close the Local Area Connection Status dialog with the Close button.

The QoS packet scheduler configuration on the user PC is thus successfully 
completed.

D.3.3  Performing the Installation 

Before you install optiClient 130, please heed the following important notes:

• optiClient 130 only supports the operating systems specified in the release 
notice

• You must close IBM/Lotus Notes to install optiClient 130.

During the optiClient 130 basic setup, the Message Service Provider (MSP) is 
automatically installed on the user PC. It is required for connecting an XPR 
server.

optiClient 130 is installed with a setup wizard, which guides you through the 
single installation steps.

How to install optiClient 130:

1. Start the setup.exe in the 
XpressionsInstall\AddOn\Client\OptiClientExtensions\
OptiClient directory of the XPR installation medium.

If a version of the optiClient 130 is already installed on the user PC, the setup 
program queries whether this version is to be updated with optiClient 130. If 
you continue the installation at this point, the following modifications will be 
the result:

• the Server Connection Provider is set as default provider. 

• the available color patterns are replaced with the optiClient 130 versions.

• the available online helps are replaced with the optiClient 130 versions.

• support of the program languages German, English, French, Italian, 
Spanish, Dutch, Portuguese and Brazilian

All existing user settings will be maintained during the update.

2. The setup procedure is being prepared and a welcome dialog appears.

3. Confirm this dialog with the Next button. Up comes this dialog:
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4. Enter the appropriate information in the Full Name and Organization fields. 
Select the options Anyone who uses this computer or Only for me.... Then 
click Next. Up comes this dialog: 

5. Set here the features to be installed or copy the presettings.

All listed languages are generally installed for the user interface. The 
following languages are currently available:

• German

• English

• French

• Italian

• Spanish

• Dutch

• Portuguese
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• Brazilian

• Turkish

• Russian

The following components are offered for installation:

• Application 
This option installs optiClient 130 with its basic scope of functions.

• Lotus Notes Integration 
This option installs additional components on the user PC required for 
integrating optiClient 130 into IBM/Lotus Notes Client.

NOTE:  This installation option is only displayed if the setup finds a IBM/
Lotus Notes client on the user-PC. You find additional information in the 
OpenScape Xpressions optiClient 130 manual.

• Outlook Integration 
This option installs additional components on the user PC required for 
integrating optiClient 130 into a local Outlook client.

6. Set the Location via the Browse button or copy the default. Click the 
Continue button. Up comes this dialog: 
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7. If you want to use an available central configuration, select the Use Central 
Configuration option. In case you select this setting you also need to specify 
the server name respectively the IP address of the central configuration 
server. 

IMPORTANT:  
A central configuration via DLS is not supported with connection to an XPR 
server.

NOTE:  
The manual selection of the default provider is always deactivated. During the 
optiClient 130 installation the Server Connection Provider is always 
configured as default provider. 

Click the Continue button.

8. Confirm the installation readiness message with the Next button. The 
installation is being performed. If the Microsoft .NET Framework is not 
installed yet, this setup is performed first. On a 64-bit operating system 
Microsoft .NET Framework must be installed manually. For this purpose, 
download the NetFx64.exe file from the following internet page:

http://www.microsoft.com/downloads/details.aspx?familyid=B44A0000-
ACF8-4FA1-AFFB-40E78D788B00&displaylang=en

Subsequently, the actual optiClient 130 installation follows.

9. Confirm the success message with the Finish button.

The optiClient 130 installation is thus complete.

Installed program shortcuts

During the installation a shortcut is defined for optiClient 130 under Start > 
Programs.

Furthermore, the following shortcut icon for starting optiClient 130 appears on the 
desktop. 
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D.4  Modifying, repairing and uninstalling optiClient 130

This section provides information on the following topics:
 

D.4.1  Modifying an existing optiClient 130 Installation

If you want to change a setting for an optiClient 130 installation that is only 
accessible during the installation, you need to employ the optiClient 130 setup 
wizard for this modification.

Proceed as follows:

1. Start the setup.exe in the 
XpressionsInstall\AddOn\Client\OptiClientExtensions\
OptiClient directory of the XPR installation medium.

2. Confirm the welcome dialog with Next. Up comes this dialog:

3. Select the Modify option and click on Next.

4. The installation wizard subsequently leads you through the installation 
modification (cf. Section D.3, “Installing optiClient 130”, on page 186).

• Modifying an existing optiClient 130 Installation page 196

• Repairing an existing optiClient 130 Installation page 197

• Uninstalling a optiClient 130 Setup page 198
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D.4.2  Repairing an existing optiClient 130 Installation

The setup wizard provides a repair function for the case that optiClient 130 
program files get damaged, are deleted or become corrupt.

How to repair an existing installation:

1. Start the setup.exe in the 
XpressionsInstall\AddOn\Client\OptiClientExtensions\
OptiClient directory of the XPR installation medium.

2. Confirm the welcome dialog with Next. Up comes this dialog: 

3. In the application maintenance select the Repair option.

4. The installation wizard subsequently leads you through the restoration of the 
damaged optiClient 130 installation. 
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D.4.3  Uninstalling a optiClient 130 Setup

If you want to remove optiClient 130 from the user-PC, do so by means of the 
optiClient 130 setup wizard.

Proceed as follows:

1. Start the setup.exe in the 
XpressionsInstall\AddOn\Client\OptiClientExtensions\
OptiClient directory of the XPR installation medium.

2. Confirm the welcome dialog with Next. Up comes this dialog: 

3. In the application maintenance select the Remove option.

4. The installation wizard subsequently leads you through the optiClient 130 
uninstallation.
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D.5  Integrating optiClient 130 into IBM/Lotus Notes

This is described in chapter Settings for the Lotus Notes Integration in the 
Administrator Documentation and Operating Instructions OpenScape Xpressions 
optiClient 130.

D.6  Integrating the optiClient 130 View

IMPORTANT:  Please familiarize yourself with the IBM/Lotus Notes integration 
function, before you execute the following procedures. You find appropriate infor-
mation in the Administration Manual and User Instructions for optiClient 130.

On the optiClient 130 installation source, in the Administration directory, you 
find the IBM/Lotus Notes database cyPhone.nsf, which contains the view 
$CyUsers. This view is required for phone number resolution in the IBM/
Lotus Notes integration. 

This section describes:

• how a provided view is copied to a IBM/Lotus Notes address book

• how location information of the delivered view is set.

NOTE:  Performing the following procedures requires a IBM/Lotus Domino 
Designer client as well as sufficient privileges on the address books to be 
modified.

D.6.1  Copying a View to an Address Book

So that the phone numbers can be normalized in the view, they must be copied 
to the address book. Here, proceedings depend on whether the target is a server 
address book or a user address book.

D.6.1.1  Copying a View to a central Server Address Book

How to copy the view to a central server address book (Domino Directory):

1. Start the IBM/Lotus Domino Designer client and log on with a sufficiently 
privileged user ID. 

2. Open the cyPhone.nsf database from the Administration directory on 
the optiClient 130 installation source. 
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3. Open the central server address book that you would like to use.

4. Copy the $CyUsers view from the View folder of the cyPhone.nsf 
database to the View folder of the server address book. 

NOTE:  If required, you can rename the $cyUSERS  view. Which view 
optiClient 130 uses to access a selected IBM/Lotus Notes address book is 
specified by the settings for the relevant address book in the IBM/Lotus Notes 
provider.

5. Verify that the location information of the view have already been configured 
(cf. Section D.7, “Setting Location Information”, on page 202).

Copying the view to the central server address book is thus complete.

D.6.1.2  Copying the View to a local User Address Book

You need the IBM/Lotus Domino Designer client to copy the view to a user 
address book. Proceed as follows:

1. Open the cyPhone.nsf database in the IBM/Lotus Domino Designer client.

2. Make a copy of the pernames.ntf design. 

3. Copy the view $cyUsers from the cyPhone.nsf database to the just 
created copy of the design pernames.ntf. 

NOTE:  If required, you can rename the $cyUSERS  view. Which view 
optiClient 130 uses to access a selected IBM/Lotus Notes address book is 
specified by the settings for the relevant address book in the IBM/Lotus Notes 
provider.

4. Verify that the location information of the view have already been configured 
(cf. Section D.7, “Setting Location Information”, on page 202).

5. Expand the corresponding user address books using the Replace Design 
function. Proceed as follows:

a) Open the user address book to which you want to assign the new design. 

b) Select the menu option File > Database > Replace Design.

c) Select the server that provides the new design.
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d) Select the new design and click on Replace.

NOTE:  You find detailed information about assigning a new design to a 
database in the IBM/Lotus Notes documentation.
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D.7  Setting Location Information

The view's location information determines how phone numbers of a IBM/Lotus 
Notes address book are normalized. The location information needs to describe, 
in which format the phone numbers were entered in the address book. Do 
external phone numbers have e.g. a 0  for an external line prefix? Or, how is the 
national prefix structured?

How to set a view's location information:

1. Open the view, the location information of which you would like to set, in the 
IBM/Lotus Domino Designer client.

2. In the view select the Phone column. The script will then be displayed.

3. Adapt the different items of the script's location information. You find these 
items at the beginning of the script. 

NOTE:  You find recommended settings for the location information of 
different countries in Section D.8, “Recommended Location Information”, on 
page 203).

4. Close the view.

You have thus successfully configured the location information. 
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D.8  Recommended Location Information

In the following you find recommended settings for the location information of the 
countries:

• Germany

• France

• Italy

• Austria

• Switzerland

Individual settings that result from the location's phone number are given in 
pointed brackets.

D.8.1  Germany

 

D.8.2  Austria

 

ExternalPrefix <Prefix >

NationalPrefix 0

InternationalPrefix 00

InternalLength <Extension length>

SubscriberCode <Subscriber code >

AreaCode <Area code >

CountryCode 49

ExternalPrefix <Prefix >

NationalPrefix 0

InternationalPrefix 00

InternalLength <Extension length>

SubscriberCode <Subscriber code >

AreaCode <Area code >

CountryCode 43
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D.8.3  Switzerland

 

D.8.4  France

 

D.8.5  Italy

 

ExternalPrefix <Prefix >

NationalPrefix 0

InternationalPrefix 00

InternalLength <Extension length>

SubscriberCode <Subscriber code >

AreaCode <Area code >

CountryCode 41

ExternalPrefix <Prefix >

NationalPrefix 0

InternationalPrefix 00

InternalLength <Extension length>

SubscriberCode <Area code><Subscriber code >

AreaCode No entry

CountryCode 33

ExternalPrefix <Prefix >

NationalPrefix No entry

InternationalPrefix 00

InternalLength <Extension length>

SubscriberCode <Area code><Subscriber code >

AreaCode No entry

CountryCode 39
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Miscellaneous

Using Fax Templates in IBM/Lotus Notes

E  Miscellaneous

E.1  Using Fax Templates in IBM/Lotus Notes

This chapter describes the configuration of fax template usage. There are 
generally the following options to configure fax templates:

• XPR fax templates (cf. Section E.1.1, “Using XPR Fax Templates”)

• IBM/Lotus Notes forms as fax template (cf. Section E.1.2, “Using IBM/
Lotus Notes Forms as Fax Template”)

If only one fax template is to be used for all fax messages of all users, only one 
XPR fax template or IBM/Lotus Notes form needs to be created, which is then 
specified in the LnAPL configuration dialog.

If several fax templates are to be used, several XPR fax templates or IBM/
Lotus Notes forms must be created, which are then provided via the 
administration database and from which a user may select a template when 
creating a fax message. 

E.1.1  Using XPR Fax Templates

In this scenario, fax templates are created in the Communications client program. 
Messages are converted into the fax format on the XPR server. 

E.1.1.1  A single XPR Fax Template as global Fax Template 

In this case only one fax template used for all outgoing fax messages is available 
in the entire system. How to configure the use of a single XPR fax template as 
global fax template:

1. Create an XPR fax template using the Communications client program. You 
find information about this in the OpenScape Xpressions Communications 
manual.

2. Enter the XPR fax template name in the LnAPL configuration dialog on the 
Fax cover sheets tab in the Default MRS fax stationery field (cf. Section 
E.1.3, “Configuring a global Fax Template”, on page 208). The name of the 
XPR fax template must match the one assigned in Communications. Then 
save the LnAPL configuration.
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E.1.1.2  Several XPR Fax Templates as Fax Templates for 
Selection

This enables users to choose a template for their messages from an assortment 
of fax templates. 

Proceed as follows:

1. Create the required number of XPR fax templates using the Communications 
client program. You find information about this in the OpenScape Xpressions 
Communications manual. The templates thus created are automatically 
provided in the person documents or in a profile document via the gateway.

2. Enter the corresponding XPR fax templates in the users' person documents 
or in a corresponding user profile (cf. Section E.1.4, “Configuring Fax 
Templates via Person Documents or User Profiles”, on page 208). 

E.1.2  Using IBM/Lotus Notes Forms as Fax Template

IMPORTANT:  To use IBM/Lotus Notes forms as fax template, the NDL converter 
must have been configured and be operable (cf. Section E.2, “NDL Converter”, 
on page 212).

Fax templates based on IBM/Lotus Notes forms exclusively support the fields 
listed in the table in Section E.1.5, “Creating your own Fax Templates”, on page 
210, step 2. For example, it is not possible to specify the total number of pages, 
since this information cannot be provided by IBM/Lotus Notes when the fax 
message is converted by the NDL converter. 

When a user creates a fax message with the cyMemo form, the name of the form 
to be used as fax template is automatically entered in the MRS_Fax_Form field, 
which is a component of this form and thus also of the message. Which fax 
template this is will be determined via the user's person document respectively 
via a corresponding user profile (cf. Section E.1.4, “Configuring Fax Templates 
via Person Documents or User Profiles”, on page 208), or via the LnAPL 
configuration. If a user has several fax templates at his/her disposal, he/she can 
select the desired template when creating the message. 

When the message is edited in the XPR server, the LNApl first checks whether in 
the administration database or, in case of the corresponding configuration, in the 
conversion database a form is available the name of which matches the entry in 
the MRS_Fax_Form field of the message. If the Apl finds such a form, the NDL 
converter converts the message into this fax format using this form, so that the 
layout of the form is copied.
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During the conversion by means of the NDL converter the administration 
database must be opened on the IBM/Lotus Domino server. Depending on the 
database's size and the number of fax messages to be converted, the network 
may be loaded to a relatively high extent. As alternative to using the 
administration database, the conversion database MrsCnv.nsf may be used as 
well. This database must be available on the client that is installed on the XPR 
server computer and receive the IBM/Lotus Notes fax templates. So that the 
conversion database can be used instead of the administration database, the 
following key in the Windows registry of the XPR server computer must be set to 
1:

HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl\Import and 
Export\RenderInConversionDB

NOTE:  If you want to use the conversion database, please also store the IBM/
Lotus Notes forms to be used as fax template in the administration database just 
the same, so that the system can use them as fallback. 

E.1.2.1  A single IBM/Lotus Notes Form as global Fax Form 

In this case only one IBM/Lotus Notes form used as fax template for all outgoing 
fax messages is available in the entire system. How to configure this form:

1. Create a IBM/Lotus Notes form to serve as fax template.

The form available in the administration database mrsFaxLayout may be 
used as example. Please also note on this Section E.1.5, “Creating your own 
Fax Templates”, on page 210 and the IBM/Lotus Notes documentation.

2. Store the created IBM/Lotus Notes form in the administration database on the 
IBM/Lotus Domino server and in the conversion database MrsConv.nsf on 
the XPR server computer. 

3. Verify that the NDL converter has been configured and is operable (cf. 
Section E.2, “NDL Converter”, on page 212).

4. Enter the form's name in the LnAPL configuration dialog on the Fax Cover 
Sheets tab in the Default fax form (Lotus Notes) and save the configuration 
(cf. Section E.1.3, “Configuring a global Fax Template”, on page 208). 

E.1.2.2  Several IBM/Lotus Notes Forms as Fax Templates for 
selection

This enables users to choose a template for their messages from an assortment 
of fax templates. 

Proceed as follows:
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1. Create the required IBM/Lotus Notes forms to serve as fax templates. Please 
also read Section E.1.5, “Creating your own Fax Templates”, on page 210 on 
this as well as the corresponding chapters in the IBM/Lotus Notes 
documentation.

The form available in the administration database mrsFaxLayout may be 
used as example.

2. Store the created IBM/Lotus Notes forms in the administration database on 
the IBM/Lotus Domino server and in the conversion database MrsConv.nsf 
on the XPR server computer. 

3. Verify that the NDL converter has been configured and is operable (cf. 
Section E.2, “NDL Converter”, on page 212).

4. Enter the corresponding IBM/Lotus Notes forms in the users' person 
documents or in a corresponding user profile (cf. Section E.1.4, “Configuring 
Fax Templates via Person Documents or User Profiles”, on page 208). 

E.1.3  Configuring a global Fax Template

When using a global fax template, all outgoing fax messages of all users copy the 
layout of this fax template. In the following we will describe the configuration of a 
global fax template via the LNApl configuration dialog. Proceed as follows:

1. Open the LNApl configuration dialog in the XPR monitor.

2. Open the Fax Cover Sheets tab.

3. If you want to use a fax template that you have created using the 
Communications client program, enter the name of this template in the 
Default MRS fax stationery field. In doing so ensure that the entered name 
matches the one you have specified in Communications. You find information 
about creating fax templates with Communications in the OpenScape 
Xpressions Communications manual.

If you want to use a IBM/Lotus Notes form as fax template, enter the name of 
this form in the Default fax form (Lotus Notes) field. 

4. Click OK.

E.1.4  Configuring Fax Templates via Person 
Documents or User Profiles

Which fax templates a user may use is determined via the user's person 
document or via a corresponding user profile document. 
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Configuring a fax template via person document 

Proceed as follows:

1. Open the administration database and in there the User Maintenance 
portion.

2. Doubleclick the entry of the user whom you want to assign fax templates. The 
person document for this user opens.

3. Open the tab Standard Messaging -> Fax Cover Page and click on Edit 
Document.

4. If you want to use XPR fax templates, select the Standard entry from the 
Active fax cover type pull-down menu. Then click on the downward arrow 
next to the Stationery field. A dialog opens. Select the XPR fax templates 
that the user may use and click on OK.

If you use IBM/Lotus Notes forms as fax templates, select the Notes form 
entry from the Active fax cover type pull-down menu. Subsequently, enter 
under Notes form the name of the IBM/Lotus Notes form to be used as fax 
template.

5. Click on Save and Close.

6. Repeat steps 2 to 5 for each user whom you want to provide a fax template.

Configuring a fax template via user profile 

This type of configuration requires an existing user profile (cf. Section B.1.2.6, 
“The Profile Document”, on page 160). 

How to configure a fax template via a user profile:

1. Open the administration database and in there the Profile Maintenance 
portion.

2. Doubleclick the entry of the user profile via which you want to provide a fax 
template.

3. Open the tab Standard Messaging -> Fax Cover Page and click on Edit 
Document.

4. If you want to use XPR fax templates, select the Standard entry from the 
Active fax cover type pull-down menu. Then click on the downward arrow 
next to the Stationery field. A dialog opens. Select the XPR fax templates 
that the user may use and click on OK.

If you use IBM/Lotus Notes forms as fax templates, select the Notes form 
entry from the Active fax cover type pull-down menu. Subsequently, enter 
under Notes form the name of the IBM/Lotus Notes form to be used as fax 
template.

5. Enter under Notes form the name of the IBM/Lotus Notes form to be used as 
fax template.
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6. Click on Save and Close.

E.1.5  Creating your own Fax Templates

XPR is able to fill fax templates with useful information and prefix a message with 
a fax cover page. Information concerning the originator and the recipient are 
automatically inserted in the corresponding fields of the cover page. 

Originator information is automatically read out of the person document of the 
sending user, where it is maintained on the tab Standard Messaging -> Fax 
Cover Page -> Originator. Information about the originator is copied from the 
contact data in IBM/Lotus Notes or can be entered or supplemented by the 
sending user when creating the fax message. 

You can use the form provided by XPR or you can use this form together with a 
XPR fax cover page or an individual IBM/Lotus Notes form. 

If IBM/Lotus Notes forms are to be used, the form (mrsFaxForm) can be used as 
default or it is possible to use an individual form. The NDL converter is used to 
allow using IBM/Lotus Notes forms as fax cover page. Please refer to Section 
E.2, “NDL Converter”, on page 212.

NOTE:  The table in step 2 shows all fields that can be automatically filled in. 
Further fields are not intended.

To design your own fax template please proceed as follows:

1. Firstly, create a IBM/Lotus Notes form that defines the layout and contains the 
fields necessary to display information. 

NOTE:  The administration database contains the form MrsFaxLayout, 
which you can use as visual aid.

2. The form-field values must correspond to the field names XPR inserts into 
messages:

Originator Recipient

MRS_NAME MRS_NAME_REC[@ToNumber(MRS_USER_INDEX)]

MRS_COMPANY MRS_COMPANY_REC[@ToNumber(MRS_USER_INDEX)]

MRS_DEPARTMENT MRS_DEPARTMENT_REC[@ToNumber(MRS_USER_INDEX)]

MRS_ADDRESS1 MRS_ADDRESS1_REC[@ToNumber(MRS_USER_INDEX)]

MRS_ADDRESS2 MRS_ADDRESS2_REC[@ToNumber(MRS_USER_INDEX)]

MRS_ZIP MRS_ZIP_REC[@ToNumber(MRS_USER_INDEX)]

MRS_CITY MRS_CITY_REC[@ToNumber(MRS_USER_INDEX)]
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The formula in square brackets must be entered into the individual fields 
exactly as shown here together with the brackets. This formula is inevitable 
in order to be able to create a personal cover page for each recipient in case 
several recipients are entered.

3. Save the new form and add it to the administration database. 

MRS_STATE MRS_STATE_REC[@ToNumber(MRS_USER_INDEX)]

MRS_COUNTRY MRS_COUNTRY_REC[@ToNumber(MRS_USER_INDEX)]

MRS_PHONE MRS_PHONE_REC[@ToNumber(MRS_USER_INDEX)]

MRS_FAXG3 MRS_FAX_REC[@ToNumber(MRS_USER_INDEX)]

MRS_FAXG4 MRS_FAX_REC[@ToNumber(MRS_USER_INDEX)]

Originator Recipient
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E.2  NDL Converter

The NDL Converter uses the local XPR database converter so all masks to be 
printed should be copied to this database. Before starting we recommend to test 
the print process since often, in addition to the masks, other design elements e.g. 
Script Libraries or Shared Fields must be copied to the XPR converter database 
as well. 

IMPORTANT:  The NDL Converter cannot be used when you use fax stationery 
that contains text fields (see the Communications user manual). In this case IBM/
Lotus Notes fax stationery must be used or the text export filter employed, so that 
the XPR server MTA adopts the conversion.

Further configuration parameters are described in Section F.1.1.5, “Import and 
Export”, on page 246.

E.2.1  Installation

• Copy the XPR converter database (MrsCnv.nsf) to the local notes\data 
directory.

• Activate the NDL Converter in the Lotus Notes APL configuration (see 
Section A.1.7, “Export Tab”, on page 123).

E.2.1.1  Evading the Password Query

If the IBM/Lotus Domino Server needs to be accessed during the print process, 
a password query is usually performed. In order to have this query answered 
automatically by the APL use the following tools: 

• SrvCycosMenu.dll

• SrvCycosExt.dll 

Both files need to be copied to the binary directory of the local IBM/Lotus Notes 
client (default: Lotus\Notes). Furthermore the following entries must be made 
in the local notes.ini:

• ExtMgr_Addins=SrvCycosExt.dll 

• AddinMenus=SrvCycosMenu.dll 

After starting the IBM/Lotus Notes client a “non”-IBM/Lotus Notes password 
dialog appears. When you have entered the password it can be saved by 
activating the corresponding check box. 
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Shut down the IBM/Lotus Notes client and start it again. A password query must 
not appear anymore.
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E.3  Integration in a IBM/Lotus Domino Cluster Environment

The IBM/Lotus Notes connectors are linked by means of a foreign domain. If a 
connector is to be integrated in a cluster environment, the mail database of this 
foreign domain must be available on all cluster servers under the same name. 

NOTE:  No settings need to be performed in the LnAPL configuration dialog for 
the Domino cluster support, since the APL receives all cluster-relevant infor-
mation via the IBM/Lotus Notes client.

There are two options to ensure a trouble-free failover: 

Defining the foreign domain and its mail database by the connector

A failover case is simulated for each potential failover domino server. The 
connector consequently links to each domino server once and defines in this 
process the foreign domain and the associating mail database. In this scenario, 
the operation of the IBM/Lotus Notes connector requires the user ID used by the 
connector to have the NetModifier and Author Access privilege for the global 
name and address book. In the failover case the user ID can then define the 
foreign domain and modify the path in the global name and address book. The 
simulated failover cases increase the effort after the installation and replication of 
the foreign domain mail database to the single domino servers must still be 
ensured.

The foreign domain mail database is cluster-replicated

The foreign domain mail database is configured via the cluster manager for 
replication to the other domino servers in the cluster. The replication is event-
controlled, so that the database is always replicated when a new message 
arrives. This ensures the data records of the replications to be identical on the 
single domino servers in the cluster in a failover case. This scenario does not 
require any extended privileges for operating the Lotus Notes connector. 

IMPORTANT:  If the mail database of the foreign domain is to be cluster-repli-
cated, its name must end in .nsf (e.g. notesgat.nsf), since in the cluster 
manager only databases with this suffix can be selected.

To utilize the cluster functionality of Lotus Notes connectors, the following 
prerequisites must be met: 

• The cluster mechanism of the Domino cluster must function without 
problems. Check carefully that the failover settings for mail routing are 
correct. For information on this please refer to the IBM/Lotus Domino 
documentation.

• The IBM/Lotus Notes connectors must work correctly.
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• The user ID of the Lotus Notes connectors must have the “Author Access” 
user privilege and the “NetModifier” role.

• On each server in the Domino cluster a replica of the administration database 
must exist (this database must be “clustered”).

E.3.1  Failover Functionality

If the domino server, on which the foreign domain is configured, fails or cannot be 
reached, the Lotus Notes connector automatically attempts to link up with another 
domino server in the cluster. This case is called failover. 

If the connection to another domino server is successful, the connector attempts 
to open the foreign domain database on the new domino server under the name 
it knows. If the connector does not find this database, it will attempt to define it 
with this name. In addition the connector will attempt to enter the new path to the 
foreign domain database in the document of the foreign domain in the global 
name and address book. 

NOTE:  In case of a failover it is not obvious which of the foreign domains is used 
by which domino MTA or which foreign domain document is actually used to 
locate the storage location of the foreign domain mail database. One of the influ-
ential factors can be a document that affects the mail routing on the basis on 
costs. Another influence can be the load balancing used by IBM/Lotus Notes.

The error messages that occur in the XPR monitor in the failover case can mostly 
be ascribed to this and ignored.

For these steps the LnAPL user ID needs the setup user rights described in 
Section 3.3.2, “User ID for the IBM/Lotus Notes Gateway”, on page 34. After this 
process has been completed, the original LnAPL functionality has been 
reestablished.

The connection to this Domino server remains until the next failover.
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E.4  Fax Systems by other Manufacturers (Legacy Fax Support)

The XPR system is able to interpret and process fax messages that originate from 
fax systems by other manufacturers. At the moment, the products “Fax Sr.” and 
“LightningFAX” are supported. In these products, incoming fax messages are 
saved in a user’s IBM/Lotus Notes mailbox. The Lotus Notes Unified Messaging 
APL (LnUmApl) can retrieve fax messages from the user’s IBM/Lotus Notes 
mailbox and send them to the XPR server for further processing, e.g. via TUI. 

After installing the XPR server, you must make the following modifications to the 
Lotus Notes APL in order to support the use of legacy fax messages:

1. Open the Windows registry editor.

2. Insert the following values in the HKLM\Software\Wow6432Node\PP-
COM\LnApl\
Globals path:

a) Value name: FaxLegacySupport, Data type: REG_DWORD, VALUE: 1 
(enabled), 0 (disabled).

b) Value name: FaxLegacySupportNumberLocalize, Data type: 
REG_DWORD, VALUE: 1 (enabled), 0 (disabled).

c) Value name: FaxLegacySupportForeignDomain, Data type: REG_SZ.

d) Value: The name of the foreign domain the legacy fax system uses for 
data transmission must be entered here.

3. Start the LnAPL.

When the LnAPL is started, an address of the format NVS:FAXG3.LN will be 
created that can be used to send fax messages from the XPR system via the 
Lotus Notes APL to the legacy fax system (this will use the legacy fax system’s 
foreign domain).
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E.5  Prevent Assist Mails for Fax and Voicemails

If a IBM/Lotus Notes user has enabled the absence assistant, each incoming 
message is answered by an automatically created reply message (a so-called 
assist mail). 

If the user makes use of the Unified Messaging services fax and/or voice mail, 
these messages are answered with an assist mail sent as fax or voice mail as 
well.

This behavior might cause great transmission costs (e.g. telephone charges). 
Therefore we recommend to prevent sending assist mails for received fax and 
voice mail messages and save them in a backup database.

Perform the following steps:

1. Create a mail database on the IBM/Lotus Domino server that is to be used 
as backup database for the assist mails.

2. Start the Windows registry editor (RegEdit) and change to the path 
HKLM\Software\Wow6432Node\PP-COM\MRS\LNApl\Globals.

3. Create five new registry keys according to the following pattern in this 
folder:

4. Close the registry editor. The installation process is completed now. 

NOTE:  
All registry keys mentioned above and their possible values are described in 
Section F.1.1.1, “Globals”, on page 234 et seq.

Name Type Value

BlockAssistMailToServiceList REG_DWORD 1

BlockAssistMail_Services REG_SZ @VOICE;@FAXG3;@FAXG4

BlockAssistMail_MandatoryFields REG_SZ Form=Memo;$AssistMail=1

BlockAssistMail_OptionalFields REG_SZ DoNotIgnoreMe=0

BlockAssistMail_BackupDatabase REG_SZ <Name of Backup Database>
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E.6  Upgrading Lotus Notes R5.x to supported Versions of IBM/Lotus Notes

This section describes how an existing Lotus Notes connection to a Lotus Notes 
system of version R5.x is upgraded to a IBM/Lotus Notes system of a supported 
version. 

The following components must be edited during an upgrade:

• Lotus Notes environment (Domino server and Notes clients)

The upgrading process must be performed as described in the manual at the 
respective stage.

IMPORTANT:  In the following sections we assume that the Lotus Notes 
environment upgrade from R5.x to a supported version has been performed 
correctly.

• XPR Server

To upgrade the XPR server software you need the installation medium of the 
XPR version 4.0 or higher. Perform the upgrade as described in the Server 
Installation manual.

• Administration database

An administration database operated under Lotus Notes R5.x must be 
upgraded with the design elements of the template for a supported version of 
IBM/Lotus Notes. We recommend to generate a backup of the administration 
database before the upgrade process.

• Unified Messaging mail templates

During a change to a supported version of IBM/Lotus Notes new mail 
templates must be created and assigned to the mail databases of the Lotus 
Notes users, since the mail templates for Lotus Notes version R5.x are not 
compatible with the new template structure of the supported versions.

How to create a Unified Messaging mail template for a supported IBM/Lotus 
Notes version is described in Section 4.4.3, “Mail Template Extensions for 
Lotus Notes R6.x”, on page 89.
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E.6.1  Procedure

1. Generate a backup of the administration database used so far.

2. Update your XPR setup to version 7.

3. Upgrade your Lotus Notes environment (Domino server and all associated 
Lotus Notes clients) to a supported version. 

IMPORTANT:  Make sure to upgrade the Lotus Notes client on which the 
XPR server is installed as well.

4. How to upgrade the design of the administration database used so far:

a) Copy the umAdmin.ntf template file from the XPR server installation 
directory (res\LnApl\TemplatesR6) to the Data directory of the Lotus 
Domino server. This is the folder \Lotus\Domino\Data for a default 
installation.

b) Start a Lotus Notes client or the Lotus Notes administrator client and log 
in with administrative access privileges.

c) Open the administration database used so far for Lotus Notes R5.x.

d) Select the menu item File > Database > Change template... from the 
main menu.

e) You must select the Domino server the template file umadmin.ntf has 
been copied to as template server. The database template of the 
administration database is an advanced template, thus the check box 
Show advanced templates must be selected in the dialog.

f) Dial the template file umadmin.ntf and click Replace.

g) In the following dialog you are queried which languages are to be used for 
the database.
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h) Select one or several languages and confirm your selection by clicking 
the OK button.

i) Confirm the following note dialog with OK.

j) After a successful design upgrade you need to reopen the administration 
database.

k) The user data records are still available in the database after the upgrade, 
but are not displayed. In order to display the data records again, select 
the Upgrade from previous version function in the Actions menu and 
confirm the following dialog with OK.
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l) After a successfully accomplished process, all user data records are 
displayed. The administration database upgrade is thus complete.

5. Create one or several new mail templates for the users and assign the mail 
template to the users' mail database (see description in Section 4.4.3, “Mail 
Template Extensions for Lotus Notes R6.x”, on page 89).
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E.6.2  Possible Problems after an Upgrade

E.6.2.1  Old Messages cannot be represented any more

Old messages that are in the inbox after an update can no longer be displayed 
with the new template for a supported IBM/Lotus Notes version, since the 
messages were displayed with an R5.x template with the mrsMemo form. An mail 
template of a supported IBM/Lotus Notes version uses the new cyMemo format 
to display messages.

How to correct this behavior:

1. Open the mail template for a supported IBM/Lotus Notes version in the Lotus 
IBM/Domino designer client.

2. Switch to the Forms folder and open the cyMemo form with a doubleclick.

3. Rightclick the header area of the cyMemo form and select from the appearing 
menu the Form Properties option.

4. Insert the | mrsMemo entry after Unified Messaging Memo | cyMemo 
in the Name field.

5. Close the Properties dialog of the form. The form modification is thus 
complete.

6. Save the modification performed and close the designer client.

7. Assign the modified mail template to the users' mail databases (see Section 
4.4.3.9, “Assigning created Mail Template”, on page 108).



Sonstiges.fm

Miscellaneous

Upgrading Lotus Notes R5.x to supported Versions of IBM/Lotus Notes

A31003-S2370-M102-9-76A9, 08/2016
OpenScape Xpressions V7 IBM Notes Gateway, Installation and Administrator Documentation 223

          

E.6.3  Mixed Operation of the Lotus Notes Clients 

IMPORTANT:  Mixed operation is only planned for a transition period as short as 
possible, since the administration databases are not compatible.

Make sure that the change to the newer version is completed as soon as 
possible.

If you operate clients of a supported version and of version R5.x at the same time 
in your Lotus Notes environment for a transition period, you must perform the 
following changes at the configuration of your Lotus Notes connection:

1. The mail template for a supported Lotus Notes version must be modified in 
such a way that it can read messages created with a mail template of version 
R5.x (see Section E.6.2.1, “Old Messages cannot be represented any more”, 
on page 222).

2. In the Mail Forms tab of the IBM/Lotus Notes Gateway configuration dialog 
(see Section A.1.9, “Mail Forms Tab”, on page 126), the form for Messages 
must be changed to mrsMemo.

3. Using Integrated Messaging and/or True Unified Messaging, the 
mrsMemo form must in the administration database be added to the 
Replicated or Supported forms (see page 154 and page 155).
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E.6.4  Inserting User-Specific Data Fields in a 
Message

The Lotus Notes APL enables the insertion of user-specific data fields in 
messages sent from the XPR server to Lotus Notes. These fields can be used for 
further processing by other applications.

E.6.4.1  Functionality

The type, name and value of a Lotus Notes data field is defined in the PMF 
properties. These PMF properties are enclosed as attachment in each PMF 
message that is received by the XPR server and forwarded to the Lotus Notes 
APL for dispatch.

By adding registry values that contain user-specific Lotus Notes data field names 
it is possible to additionally insert different data field types supported by Lotus 
Notes in a Lotus Notes message and to evaluate them.

E.6.4.2  Procedure

1. Open the Windows registry editor on the XPR server computer and change 
to the path 
HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LnApl\Globals.

2. Enter the following registry value:

• Value: “CustomProperty_Token” 

• Content: “LN_FIELD_” 

By this registry value a PMF property with the value 
LN_FIELD_COMPANYNAME would be converted into a Notes data field (Text) 
named COMPANYNAME and added to the Lotus Notes messages.

3. To create an AUTHOR data field you need to add the following registry value:

• Value: “CustomProperty_TokenAuthor” 

• Content: “AUTHOR_” 

By this registry value a PMF property with the value 
LN_FIELD_AUTHOR_AuthorOfDocument would be converted into a Notes 
data field (Author) named AuthorOfDocument and added to the Lotus Notes 
messages.
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4. To create a READER data field you need to add the following registry value:

• Value: “CustomProperty_TokenReader” 

• Content: “READER_” 

By this registry value a PMF property with the value 
LN_FIELD_Reader_ReaderOfDocument would be converted into a Notes 
data field named ReaderOfDocument and added to the Lotus Notes 
messages.

5. With the following registry value you define a separator used if a 
CustomProperty field has several values.

• Value: “CustomProperty_MultivalueDelimiter” 

• Content: “,” 

A CustomProperty value Joe User, Bill Smith is converted into a Text 
List Notes data field, which displays two separate values.
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E.7  Configurable Parameters in setup.ini Files

This section describes configurable parameters in the Properties section of 
setup.ini files. 

NOTE:  Each of the parameters described in this section is allocated with a 
default value in an MSI file. This default value is valid until the corresponding 
parameter exists in the appropriate setup.ini file. In the setup.ini file, each 
of these parameters has been assigned a sample value, but this assignment is 
commented out. It is therefore invalid. If you do not wish to use the default value 
from the MSI file, remove the semicolon from the beginning of the line to turn the 
corresponding comment in the setup.ini file into an invalid line and change the 
sample value if required.

INSTALLFG4

If INSTALLFG4 is set to 1, the Fax G4 printer driver is installed, otherwise the 
Fax G3 printer driver.

DISABLEAU

DISABLEAU stands for Disable Automatic Update. The automatic update, 
also called Update Service or SmartUpdate, is an application that monitors 
the system and queries the XPR server for new versions of specific 
applications via the MSP. If new versions are available, they are downloaded 
and installed.

You can see the application as taskbar icon. 

Value 0 activates the automatic update, value 1 deactivates it.

Default 0

Possible values 0 or 1

Files ...\AddOn\Client\LotusNotes\LnFax\...\setup.ini

Default 0

Possible values 0 or 1

Files ...\AddOn\Client\LotusNotes\ActiveX\setup.ini
...\AddOn\Client\LotusNotes\LnConfPlugin\setup.ini
...\AddOn\Client\LotusNotes\LnFax\...\setup.ini
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INSTALLAPPLET

If value 1 is set, the notes.ini file of the client is edited during the setup in 
such a way that the client loads the cycosext.dll file. The cycosext.dll 
file effects creating a login dialog in which you can store your login password.

CUSTOMNOTESINIPATH

In terminal server environments or when deploying multi-user Notes clients, 
i. e. every user uses his/her own notes.ini file, the usual notes.ini file 
must not be used. The path of the usual notes.ini file is stored in the Notes 
section of the registry. Instead, the user-specific notes.ini file must be 
deployed via the following procedure. 

Every user has the notes.ini file in another directory. For example, user 1 
has the file C:\Documents and 
Settings\<user1>\<path1>\notes.ini and user 2 has the file 
C:\Documents and Settings\<user2>\<path2>\notes.ini. All 
users must now map the same drive name to their directory. I. e. user 1 
maps drive N:\ to the directory C:\Documents and 
Settings\<user1>\<path1> and user 2 maps drive N:\ to the directory 
C:\Documents and Settings\<user2>\<path2>. The 
CUSTOMNOTESINIPATH parameter must be assigned the path of the 
notes.ini file in the mapped drive, in the example thus N:\notes.ini. 
Every time a user logs in an application starts, looking for the file that 
CUSTOMNOTESINIPATH specifies and registering the necessary DLL files, 
if this has not been done yet.

NOTE:  
When using multi-user Notes clients you need not only deploy CUSTOMNO-
TESINIPATH but also set NOTESMULTIUSER to 1.

Default 1

Possible values 0 or 1

Files ...\AddOn\Client\LotusNotes\LnFax\...\setup.ini

Default -

Possible values <mapped path to the notes.ini file>, for example N:\notes.ini

Files ...\AddOn\Client\LotusNotes\LnConfPlugin\setup.ini
...\AddOn\Client\LotusNotes\LnFax\...\setup.ini
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NOTESMULTIUSER

In case of multi-user Notes clients, the NOTESMULTIUSER parameter must 
be set to value 1. This is necessary because, unlike terminal server 
environments, multi-user Notes clients are not automatically recognized 
during the installation. 

This parameter must otherwise remain set to 0. 

NOTE:  When using multi-user Notes clients you need not only set NOTES-
MULTIUSER to 1 but also deploy CUSTOMNOTESINIPATH.

Default 0

Possible values 0 or 1

Files ...\AddOn\Client\LotusNotes\LnConfPlugin\setup.ini
...\AddOn\Client\LotusNotes\LnFax\...\setup.ini
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E.8  Installation of a Notes Client on a Citrix Metaframe Server

In the following paragraphs you will find a short explanation of the required steps 
for the installation of a IBM/Lotus Notes clients on a Citrix Metaframe server. 

IMPORTANT:  Citrix Metaframe server support starts with IBM/Lotus Notes 
version 6.0.2. Previous versions are not supported.

NOTE:  At this stage we would like to point to the Redbooks by IBM, publicly 
accessible under http://www.redbooks.ibm.com/. These books provide, among 
other things, very detailed information about the installation of IBM/Lotus Notes 
on Citrix Metaframe servers.

E.8.1  Procedure for Notes 6

1. Log in directly at the Citrix server as administrator (not via a remote 
connection) and make sure that no other users are logged in at the moment.

2. Create a folder named r6clienttemplate on the server. Share the folder 
and use r6clienttemplate as share name. Assign read privileges to the 
group Everyone and assign full privileges to the administrators.

3. Connect with the share you have created above by using your assigned 
default home directory. If your home directory is for example H:, connect as 
follows:

NET USE H: \\TERMSSERVER\R6CLIENTTEMPLATE ... 

4. Open the control panel and double-click the software icon. 

5. Click Add new programs and then CD or floppy disk. 

6. Click Continue.

7. Start the Lotus Notes 6 installation program setup.exe from the CD-ROM.

8. In the first installation dialog click Next.

9. Click Continue.

10. Accept the license agreement and click Next.

11. Enter the company name in the user name field and in the organization name 
field. Do not enter a user name, since the content of these fields is visible for 
all users.

12. Mark the Single User Installation option and click Next.
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13. Enter an installation folder that corresponds to your environment (e.g.: 
C:\Program Files\Lotus\Notes).

14. Change the path for the data directory to H:\notes\data and click Next.

15. For the feature selection make sure that the following features are not 
selected:

• Modem files, 

• Client - Shared connection

• Domino Enterprise Connection Service (DECS)

Then click Next.

16. Click Install.

17. Click Finish. 

18. Open the Windows Explorer and move the C:\WINDOWS\Notes.ini file to 
the H:\notes\data directory. 

19. Open the just moved file with a text editor and add the following entry below 
the line [Notes] :

Directory=H:\notes\data 

20. Create a desktop shortcut to Lotus Notes for all users:

a) In the Windows Explorer select the menu option File > New > Shortcut. 

b) As storage location enter C:\Programs\Lotus Notes\Notes.exe.

c) As shortcut name enter Lotus Notes 6 and click Finish. 

21. Open the properties of the shortcut you have just created and open the 
Shortcut tab. 

22. In the Target field enter the following text:

"C:\Programs\Lotus Notes\Notes.exe" =H:\notes\data\Notes.ini 

NOTE:  Please note the blank between the quotation mark (") and the equal 
sign.

23. In the Start in: field enter the following and click on Apply:

H:\notes\data 

24. Copy the content of the directory r6clienttemplate, i.e. notes directory 
in this directory into the home directory of the single users. This can be 
automated via the following script:
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if not exist h:\notes md h:\notes
if not exist h:\notes\data md h:\notes\data
if not exist h:\notes\data\notes.ini xcopy /s 
"\\FILESERRER\r6clienttemplate\notes\data\*.*" 
"h:\notes\data" 

NOTE:  Please note the blank between the quotation marks in the last line!

25. Configure all Notes clients of the users respectively.



Miscellaneous

Sonstiges.fm

Installation of a Notes Client on a Citrix Metaframe Server

 A31003-S2370-M102-9-76A9, 08/2016
232 OpenScape Xpressions V7 IBM Notes Gateway, Installation and Administrator Documentation

         



Registry.fm

A31003-S2370-M102-9-76A9, 08/2016
OpenScape Xpressions V7 IBM Notes Gateway, Installation and Administrator Documentation 233

         

Function Reference

Registry Entries

F  Function Reference

F.1  Registry Entries

F.1.1  IBM/Lotus Notes Gateway (LnAPL)

The Lotus Notes APL is completely compatible to all registry structures of the 
earlier versions. Old settings are read and then saved in the new format. 
Subsequently, the old settings will be deleted. The actual version of the registry 
structure is detected by the Lotus Notes APL.

The following values are specified under the key:
HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl 

AdditionalMappings [REG_MULTI_SZ]

Contains a list of additional database fields that is to be replicated between 
the XPR correlation database and the administration database in IBM/Lotus 
Notes. Each line represents a database field to be replicated and contains 
three values separated by commas.

DlgSessions [REG_DWORD]

For future dialog service expansions.

Registry Version [REG_DWORD]

The actual version information of the Lotus Notes APL registry entry structure 
is contained here and this is also used to update the old structure. Variables 
should never be modified manually. This could lead to registry entries not 
being found.

Default: –

Possible values: <correlation database field>,<mrs property name>,<notes field 
name>

Default: 16

Default: –
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F.1.1.1  Globals

The following values are specified under the key:
HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl\Globals 

AutomaticResending Message[REG_DWORD]

IMPORTANT:  Should only be used in a TUM scenario. Activation in a 
scenario with inbox replication is only supported project-specifically.

In XPR this key activates the retransmission function (1). Messages that 
could not be transferred to IBM/Lotus Notes because the Notes user's mail 
quota has been exceeded in IBM/Lotus Notes are then sent again. 

This message retransmission is managed via further keys:

• REG_DWORD "RepeatStrategyX1" (default = twice), 

• REG_DWORD "RepeatStrategyT1" (default = 30 sec.), 

• REG_DWORD "RepeatStrategyX2" (default = twice), 

• REG_DWORD "RepeatStrategyT2" (default = 300 sec.),

• REG_DWORD "RepeatStrategyX3" (default = twice), 

• REG_DWORD "RepeatStrategyT3" (default = 36000 sec.),

• REG_SZ "FilterNonDeliveryReportText" (Standard = "Database disc 
quota exceeded")

The key RepeatStrategyXn determines the number of retransmission 
attempts until the next strategy is used. The key RepeatStrategyTn 
determines the period between two attempts of a strategy. 

Example: 

With the default settings (see above), two transfer attempts are first 
executed in a 30-second interval. Then, two more transfer attempts are 
carried out in a 300-second interval. Finally, another two transfer attempts 
are performed in a 36000-second interval. Not until all these attempts 
have been executed, the originator receives an error message.

The key FilterNonDeliveryReportText includes the text that the 
FailureReason field must contain for the function to be carried out.

Default: 0

Possible values: 0 or 1
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BlockAssistMail_BackupDatabase [REG_SZ]

If a backup database has been established that is to store prevented assist 
mails, its name is indicated here.

BlockAssistMail_MandatoryFields [REG_SZ]

In this key the fields are entered that a message must contain in order to be 
identified as an assist mail.

BlockAssistMail_OptionalFields [REG_SZ]

In this key additional fields can be entered that are used to identify an assist 
mail.

EnableHardReconnect [REG_DWORD]

This value determines whether the Lotus Notes APL performs a “hard” 
reconnection to the IBM/Lotus Domino server (1) if the connection has been 
lost and the normal reconnect failed ten times.

BlockAssistMail_Services [REG_SZ]

Indicates the XPR services for which sending assist mails is to be prevented.

BlockAssistMailToServiceList [REG_DWORD]

Enables or disables the prevention of assist mails for incoming fax and voice 
mails.

EnableNotesResponseTracking [REG_DWORD]

This flag specifies whether additional information to IBM/Lotus Notes Mail is 
inserted into messages from XPR to IBM/Lotus Notes (1), so that in the case 
of a reply, the reply references can be created. The additional information is 

Default: –

Possible values: <Name of Backup Database>

Default: Form=Memo;$AssistMail=1

Possible values: Form=Memo;$AssistMail=1

Default: Form DoNotIgnoreMe=0

Default: 0

Default: @VOICE;@FAXG3;@FAXG4

Possible values: @VOICE;@FAXG3;@FAXG4

Default: 0

Possible values: 0 or 1

Default: 1
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inserted into the subject and is readable by the user. If this value is set to 0, 
the Lotus Notes APL does not create the additional information; thus the reply 
context would be lost for an original XPR > Notes > Notes Return Reply.

The reply reference in the other direction Original Notes -> XPR -> XPR 
Return reply is always administrated, since the XPR does not need any 
additional information for this. I.e., in the IBM/Lotus Notes client the reply 
contexts are always displayed correctly.

EnforceDomino5 [REG_SZ]

If this key exists and is set to 1, the LnAPL behaves, independent from the 
actual Domino version, as if it were connected to a Domino 5 server. This is 
useful when the user mailbox replication of Lotus Notes 5 clients to a Domino 
6 server does not work.

If this key does not exist or its value is 0, the LnAPL behaves according to the 
actual Domino version.

NotesDomain [REG_SZ]

Name of the IBM/Lotus Notes domain in which the Lotus Notes APL operates. 
Simultaneous communication is possible between several IBM/Lotus Notes 
servers. These must, however, all belong to the IBM/Lotus Notes domain 
determined here.

PNABServers [REG_MULTI_SZ]

List of the IBM/Lotus Domino servers within the domain that have been 
provided with a copy of the names and address book. The Lotus Notes APL 
requires information from the names and address book for the start. If several 
servers are entered in these fields, the Lotus Notes APL receives all 
necessary information even if only one server is in operation.

Tag [REG_SZ]

Internal use only. Do not alter manually.

SilentDestinations [REG_MULTI_SZ]

A list of the originator addresses that do not receive reports.

Default: Key must be defined manually!

Possible values: 0 or 1

Default: –

Default: –

Example: Notes/Cycos
NotesDev/Cycos

Default: 0

Default: –
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NonFaxDefaulDeliveryReport [REG_SZ]

This key configures the default delivery report used by the LnAPL for non-fax 
messages, for example voice messages.

• N: None

• B: Only on failure

• C: Confirm

• T: Message route (Trace): IBM/Lotus Domino sends a report containing 
all server computers the message has been routed via. This report 
contains as well the information whether the message has been 
delivered.

Default: C

Possible values: N, B, C or T
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F.1.1.2  IBM/Lotus Notes Administration

The following values are specified under the key:
HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl\
Notes Administration 

AddressBookReplication_LegacyDeleteMode [REG_DWORD]

This value determines whether user data records that have been deleted in 
the administration database are also to be deleted in the user database. For 
the default value 0 the Lotus Notes APL does not delete user data records on 
the XPR server that have been deleted in the administration database. The 
value 1 enables this feature.

AdministrationDatabase [REG_SZ]

This value contains the name of the administration database and can be 
assigned freely. The name must not conflict with an existing database name 
on the IBM/Lotus Domino server. If in addition to the database name a path 
(e.g.  XPR\MRSADMIN.NSF) is entered, this will then be interpreted as the 
path relative to the data directory of the IBM/Lotus Notes server unless a drive 
letter or backslash is contained within the path. Paths which contain drive 
letters or leading backslashes are not allowed (e.g. E:\XPR\MRSADMIN.NSF 
or \XPR\MRSADMIN.NSF).

AdministrationServer [REG_SZ]

Hierarchical name of the IBM/Lotus Domino server the administration 
database and the gateway domain are to be created on or are already. Non 
hierarchical names (e.g. Jaggernaut) are illegal.

EnableAdministrationDatabase [REG_DWORD]

Via this value the use of the administration database by the Lotus Notes APL 
can be prevented (0). By default the Lotus Notes APL uses the administration 
database (1).

Default: 0

Possible values: 0 or 1

Default: –

Example: Juggernaut/HGC/DE

Default: 1

Possible values: 0 or 1
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EnableAdministrationDatabaseReplicas [REG_DWORD]

This flag determines whether the IBM/Lotus Notes database works explicitly 
with the indicated administration database (0) or if a replication can be 
accepted defined under the value PNAB servers of the IBM/Lotus Notes 
server (1). If this flag is deleted, all Lotus Notes APL features based on the 
administration database cease to apply during operation in case the IBM/
Lotus Domino server is not available. If this flag is set and the administration 
database is replicated between the servers, the Lotus Notes APL would 
switch during the running operation to another Domino server.

EnableAutomaticUserDBSync [REG_DWORD]

If this flag is set, the Lotus Notes APL will synchronize users of the 
administration database with the user database. Various services of the XPR 
server require a user entry in the user database (e.g. voice mail). This flag 
must be activated if these services are to be available under IBM/Lotus Notes 
without the need for manual administration of two databases.

EnableIntegratedMessaging [REG_DWORD]

This key is used for activating Integrated Messaging for the Lotus Notes APL 
(1). When you open the LN APL configuration dialog in the XPR monitor and 
activate the Use Integrated Messaging checkbox on the Administration 
tab, this key becomes active.

EnableNotesBasedConfig [REG_DWORD]

If this flag is set, the Lotus Notes APL registry entries can be created via the 
administration database under IBM/Lotus Notes. The Lotus Notes APL is 
informed of any configuration modifications by periodical checking of the 
configuration documents in the administration database. If the flag is deleted, 
the configuration of the Lotus Notes APL can only be accomplished via the 
XPR monitor configuration interface. This function has not been 
implemented yet.

Default: 1

Possible values: 0 or 1

Default: –

Possible values: 0 or 1

Default: 0

Possible values: 0 or 1

Default: –

Possible values: 0 or 1



Function Reference

Registry.fm

Registry Entries

 A31003-S2370-M102-9-76A9, 08/2016
240 OpenScape Xpressions V7 IBM Notes Gateway, Installation and Administrator Documentation

         

EnableRestrictedAccess [REG_DWORD]

If this flag is set, only users registered in the administration database are 
allowed to access the IBM/Lotus Notes Gateway. Messages from other users 
will be deleted without a report being generated.

IntegratedMessagingDatabase [REG_SZ]

This value contains the name of the Lotus Notes APL Integrated Messaging 
database, and can be freely assigned. The name must not conflict with an 
existing database name on the IBM/Lotus Domino server. If in addition to the 
database name a path (e.g. XPR\MRSADMIN.NSF) is entered, this will then 
be interpreted as the path relative to the data directory of the IBM/Lotus Notes 
server unless a drive letter or backslash is contained within the path. Paths 
which contain drive letters or leading backslashes are illegal (e.g. 
E:\XPR\MRSINT.NSF or \XPR\MRSIMSG.NSF).

Inbox replications from IBM/Lotus Notes to the XPR server are contained in 
this database.

IntegratedMessagingMRSPollIntervall [REG_DWORD]

Time interval in seconds between two checks for new messages in the XPR 
Integrated Messaging database. In an operational mode, a value of 60 
seconds is sufficient.

IntegratedMessagingPollDelay [REG_DWORD]

Time interval in seconds between two checks for new messages in the IBM/
Lotus Notes XPR Integrated Messaging database.

IntegratedMessagingPollDelayHard [REG_DWORD]

Time interval in seconds between two checks for new messages in the IBM/
Lotus Notes XPR Integrated Messaging database. The database is opened 
and scanned for controlling. If the value is not set or set to 0, this type of 
database check is switched off.

Default: 0

Possible values: 0 or 1

Default: –

Default: –

Possible values: 5 - 256 seconds

Default: 5

Possible values: Seconds

Default: –

Possible values: Seconds
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IntegratedMessagingReconnectDelay [REG_DWORD]

Time interval in seconds between reconnection attempts. Default is a 
maximum of 15 and the value entered for IntegratedMessagingPollDelay 
[REG_DWORD]. Thus 15 seconds if IntegratedMessagingPollDelay 
[REG_DWORD] is smaller than 15, otherwise the value entered for 
IntegratedMessagingPollDelay [REG_DWORD].

OriginatorReplace [REG_DWORD]

NOTE:  For Lotus Notes 6.x only.

Value 1, then the originator address of a voicemail (normally the originator's 
phone number) is replaced by the originator's Lotus Notes address and 
respectively displayed in the inbox. To switch this behavior off the parameter 
must be set to 0. The received message will then contain the default field 
from: with the received number and another field FromDomain with the 
foreign domain address.

This key only takes effects on voice mails, not on the inbox replication for mail 
and fax messages.

OriginatorReplace_ReplyTo [REG_DWORD]

NOTE:  For Lotus Notes 6.x only.

In case of 1 the ReplyTo field is added to the message, which contains the 
address of the foreign domain. In this case the principal field contains the 
Lotus Notes name of the originator, as it is displayed in the inbox and during 
the message opening. The receipt will then be sent to the foreign domain, so 
that the MWI will be switched off there.

This key only takes effects on voice mails, not on the inbox replication for mail 
and fax messages.

Default: 15 

Possible values: up to 15 seconds

Default: 1

Possible values: 0 or 1

Default: 0

Possible values: 0 or 1
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PrincipalOverride [REG_DWORD]

When set to 0, the Lotus Notes APL ignores the principal field in messages 
sent from IBM/Lotus Notes to the XPR server. If this value is set to 1, the APL 
sets the originator of the message to the user contained in the principal field.

ShootYourselfInFoot [REG_DWORD]

This flag activates a compatibility mode which maintains the mail document 
properties transfer. This way IBM/Lotus Notes user information can be sent 
to XPR systems that are connected via Remote System Link. This is also 
possible if XPR servers are not able to replicate user data. If this flag is 
deleted then only the One Time Override Properties (see above) will be 
transmitted. This flag can only be set in the registry entries.

SyncButtonConfDoc [REG_DWORD]

This flag activates the Save Configuration button in the configuration 
document which will be sent to the user after the configuration has been 
modified.

SendProfileDocByMail [REG_DWORD]

In case of 1 it is possible to send a user profile document by mail. In case of 
0 a user document is directly copied to the user mailbox.

IMPORTANT:  
This key should only be activated if the synchronization in the administration 
database takes even in case of deactivated template logs too long.

Default: –

Possible values: 0 or 1

Default: 1

Possible values: 0 or 1

Default: 0

Possible values: 0 or 1

Default: 0

Possible values: 0 or 1
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DisableAutoPreferredDelivery [REG_DWORD]

In case of 0 the preferred delivery is set to MAILBOX for IM users and to LN 
for TUM users. In case of 1 the preferred delivery is not automatically set 
depending on the IBM/Lotus Notes integration (IM or TUM).

IMPORTANT:  This key should only be activated is special scenarios, for 
example, if XPR users are administered by IBM/Lotus Notes. In the default 
setting, which is in most usage scenarios the most suitable solution, this key 
is deactivated to avoid routing problems.

Default: 0

Possible values: 0 or 1
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F.1.1.3  IBM/Lotus Notes Mail Forms

The following values are specified under the key:
HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl\
Notes Mail Forms 

They influence the IBM/Lotus Notes forms for documents and reports.

Delivery Report Form [REG_SZ]

If a form is to be used for delivery other than that of the standard IBM/Lotus 
Notes form, then its name will be entered here. IBM/Lotus Notes 
administrators are responsible for ensuring that the alternative mail form is 
placed in the user’s mail database. Since the mail databases are normally 
configured to automatically inherit its design from a mail form, it is sufficient 
to insert the alternative form into the template.

Memo Form [REG_SZ]

If a form is to be used for messages other than that of the standard IBM/Lotus 
Notes form, then its name would be entered here. IBM/Lotus Notes 
administrators are responsible for ensuring that the alternative mail form is 
placed in the user’s mail database. Since the mail databases are normally 
configured to automatically inherit its design from a mail form, it is sufficient 
to insert the alternative form into the template.

Return Receipt Form [REG_SZ]

If a form is to be used for return receipt other than that of the standard IBM/
Lotus Notes form, then its name will be entered here. IBM/Lotus Notes 
administrators are responsible for ensuring that the alternative mail form is 
placed in the user’s mail database. Since the mail databases are normally 
configured to automatically inherit its design from a mail form, it is sufficient 
to insert the alternative form into the template.

Trace Report Form [REG_SZ]

If a form is to be used for trace reports other than that of the standard IBM/
Lotus Notes form, then its name would be entered here. IBM/Lotus Notes 
administrators are responsible for ensuring that the alternative mail form is 
placed in the user’s mail database. Since the mail databases are normally 
configured to automatically inherit its design from a mail form, it is sufficient 
to insert the alternative form into the template.
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F.1.1.4  IBM/Lotus Notes Reports

The following values are specified under the key:
HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl\Notes Reports 

EnableDefaultFaxDeliveryConfirmation [REG_DWORD]

Even if the IBM/Lotus Notes user does not require a delivery report for a fax, 
this value specifies whether the Lotus Notes APL request a delivery report 
from the XPR or not.

EnableDefaultMailDeliveryConfirmation [REG_DWORD]

This value defines if the Lotus Notes APL requests a delivery report for mail 
documents (except fax) from XPR, even if the IBM/Lotus Notes has not 
requested one in his delivery options.

RemoveCostInfoFieldFromReports [REG_DWORD]

This key controls whether information on the charged costs are to be 
displayed in the send report. Therefore the field Costinfo is hidden or 
displayed.

Default: 1

Possible values: 0: The options set by the IBM/Lotus Notes user will not be 
modified.
1: The Lotus Notes APL requests a delivery report unless 
otherwise specified by the user.
2: The Lotus Notes APL always requests a delivery report, even 
when the user has explicitly switched off reporting.

Default: 0

Possible values: 0: The options set by the IBM/Lotus Notes user will not be 
modified.
1: The Lotus Notes APL requests a delivery report unless 
otherwise specified by the user.
2: The Lotus Notes APL always requests a delivery report, even 
when the user has explicitly switched off reporting.

Default: 0

Possible values: 0: the field Costinfo is displayed in the send report. 
1: the field Costinfo is not displayed in the send report.
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F.1.1.5  Import and Export

The following values are specified under the key:
HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl\Import and 
Export

DefaultFaxcover [REG_SZ]

This value allows the setting of default XPR stationary for all IBM/Lotus Notes 
users. If a fax cover is defined for the user in the administration database, this 
setting will be used.

DefaultFaxlogo [REG_SZ]

This value allows the setting of a default XPR fax logo for all IBM/Lotus Notes 
users. If a fax logo is defined for the user in the administration database, this 
setting will be used.

DefaultNotesFaxForm [REG_SZ]

This value allows the setting of a default Notes fax form for all IBM/Lotus 
Notes users. If a fax form is defined for the user in the administration 
database, this setting will be used.

DisableCorrelDefaultFaxStationary [REG_DWORD]

This key disables the synchronization of fax templates between the CorrelDB 
and the administration database (1). Deactivate the synchronization if you 
want to assign several fax templates in the user document. Without 
synchronization the fax templates in the user document are not assigned as 
default template in the CorrelDB, so that the user may choose the fax 
template when sending the fax.

Default: “ “

Default: “ “

Default: “ “

Default: 0

Possible values: 0 or 1
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EnableExport [REG_DWORD]

This value regulates whether a further representation of the document body 
(e.g RTF) is to be created with mail from IBM/Lotus Notes to the XPR. All Edit 
Level Export Filters from IBM/Lotus Notes can be used. This feature can be 
activated separately for e-mails and fax messages.

EnableRTFImport [REG_DWORD]

This flag determines whether messages from XPR to IBM/Lotus Notes with a 
preexisting RTF representation of the message contents is to be imported to 
the body field (1), or if the body field is created from the text representation of 
the message content.

EnableTiffPatch [REG_DWORD]

This flag activates the TIFF Patch that enables the IBM/Lotus Notes viewer 
to display asymmetrical TIFF files.

ExportLibrary [REG_SZ]

This string determines which IBM/Lotus Notes Edit Level Export Filter is to be 
used to create an additional representation of the document body (e.g. for 
outgoing fax messages). The entry syntax is <export library name>, 
<extension>. The first part <export library name> is the name of the 
export filter shown by the IBM/Lotus Notes client when an export at the 
document level is required. The exports are described in the IBM/Lotus Notes 
initialization file (Notes.ini). All entries with the name EDITEXPxxx describe 
the Edit Level export filter. The first value (found in the comma separated 
entry list EDITEXP xxx) is the name of the filter and can be used as <export 
library name>. Following the fourth entry in the EDITEXPxxx list, are the 
file extensions required by the various filters. Since more than one file format 
is possible, the file extension must be selected and entered in <extension>. 
All file extensions must be preceded by a dot. Example: MicrosoftWord 
RTF, RTF

This is the correct setting for the Rich Text Export filter and the extension RTF.

Default: 2

Possible values: 0: No Export
1: Export for e-mail, no export for fax
2: Export for fax, no export for e-mail
3: Export for e-mail and fax

Default: 0

Possible values: 0 or 1

Default: 1

Possible values: 0 or 1
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NDLConversion_AgentPrintMode [REG_DWORD]

IMPORTANT:  NDLConversion_AgentPrintMode is active by default, 
NDLConversion_FormPrintMode is inactive by default.

IMPORTANT:  NDLConversion_FormPrintMode should be preferred to the 
NDLConversion_AgentPrintMode, since it is saver and more optimized. Use 
NDLConversion_AgentPrintMode only if the deployment of 
NDLConversion_FormPrintMode causes problems.

There are three ways to access the printing feature:

• Menu option Action > Print
If the registry key NDLConversion_AgentPrintMode is active and the 
registry key NDLConversion_FormPrintMode is inactive, the Lotus Notes 
APL does not use the default print feature of the IBM/Lotus Notes clients 
for the NDL conversion but the agent PrintNDLConv, which is found in 
the XPR converter database (see Section E.2.1, “Installation”, on page 
212). Furthermore, the shortcut to the File menu must be set to value A 
for English Notes clients respectively K for German Notes clients, and the 
shortcut to the File > Print menu option to value P (see Section A.1.7, 
“Export Tab”, on page 123).

IMPORTANT:  
NDLConversion_AgentPrintMode is only compatible with Notes Client 
6.x. In contrast, NDLConversion_FormPrintMode is compatible with 
Notes Client 6.x and higher.

• Menu option File > Print
Is only possible if the registry key NDLConversion_FormPrintMode is 
deactivated (see Section F.1.1.5, “Import and Export”, on page 246).

• By opening the document
Is only possible if the registry key NDLConversion_FormPrintMode is 
active (see Section F.1.1.5, “Import and Export”, on page 246). In this 
case the values set in the Shortcut for ’File menu’ and Shortcut for 
’Print’ combo boxes are irrelevant (see Section A.1.7, “Export Tab”, on 
page 123).

Default: 1

Possible values: 0 or 1
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NDLConversion_FormPrintMode [REG_DWORD]

IMPORTANT:  If the key NDLConversion_FormPrintMode is set to value 1, 
the XPR conversion database (MrsCnv.nsf) must be copied from the 
<XPR_Install>\res\LnApl to the <LN_Install>\notes\data directory on 
the XPR computer.

IMPORTANT:  NDLConversion_FormPrintMode is compatible with Notes 
Clients 6.x and higher. In contrast, NDLConversion_AgentPrintMode is only 
compatible with Notes Client 6.x.

IMPORTANT:  NDLConversion_FormPrintMode should be preferred to the 
NDLConversion_AgentPrintMode, since it is saver and more optimized. Use 
NDLConversion_AgentPrintMode only if the deployment of 
NDLConversion_FormPrintMode causes problems.

IMPORTANT:  If NDLConversion_ShowPrintDialog has been activated, 
NDLConversion_FormPrintMode must be activated also.

There are three ways to access the printing feature:

• By opening the document
Is only possible if the registry key NDLConversion_FormPrintMode is 
active. In this case the values set in the Shortcut for ’File menu’ and 
Shortcut for ’Print’ combo boxes are irrelevant (see Section A.1.7, 
“Export Tab”, on page 123). This key can be used in combination with the 
NDLKeepNotesClientOpened key and disables the 
NDLConversion_AgentPrintMode key. 

If the key NDLConversion_FormPrintMode is set to value 1, the 
documents opened by the LnAPL from the XPR conversion database 
(MrsCnv.nsf) are immediately printed via the PostOpen event of the 
Notes API. Consequently, you need not start the print agent or have the 
document printed via the File > Print command. 

• Menu option File > Print
Is only possible if the registry key NDLConversion_FormPrintMode is 
deactivated.

Default: 0

Possible values: 0 or 1
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• Menu option Action > Print
Is only possible if the registry key NDLConversion_AgentPrintMode is 
active and the registry key NDLConversion_FormPrintMode is 
deactivated.

NDLConversion_ShowPrintDialog [REG_DWORD]

The registry key NDLConversion_ShowPrintDialog serves in versions of 
Lotus R8 for opening the Lotus Notes print dialog mandatorily in full mode.

IMPORTANT:  If you use a version of Lotus R8, activate the registry key 
NDLConversion_ShowPrintDialog and the registry key 
NDLConversion_FormPrintMode also.

IMPORTANT:  If you activate the registry key 
NDLConversion_ShowPrintDialog and use a Windows version that deploys 
User Interface Privilge Isolation (UIPI) (for example Windows Server 2008) 
for the computer on which the LnAPL operates, you need to execute the 
following steps. This enables the LnAPL to reach the Lotus Notes client in 
Session0.
Session0 isolation is a security feature of Windows Server 2008, Windows 
Vista and Windows 7 for isolating system processes and potentially 
dangerous applications. See http://en.wikipedia.org/wiki/
Shatter_attack for further general Session0 details.

NOTE:  A local system account must be used for the NDL conversion (see 
step 6 on page 250).

1. Select Start > Run.

2. Enter services.msc for opening the Services window.

3. Rightclick the entry XPR Lotus Notes APL(LnApl).

4. Select the menu option Properties.

5. Click on the Log On tab.

6. Activate the radio button Local System Account.

7. Activate the Allow service to interact with desktop checkbox.

8. Click on OK.

9. Select Start > Run.

Default: 0

Possible values: 0 or 1
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10. Enter regedit.

11. If the following registry key does not exist yet, create it:

12. Set NDLConversion_ShowPrintDialog to 1.

13. Set NDLConversion_FormPrintMode to 1.

The following steps are optional. You need to execute them only if you do not 
want the error messages created by the interaction between LnAPL and 
Session0.

14. Open the service management opened in step 2 on page 250.

15. Rightclick the entry Interactive Service Detection and select Stop.

16. Rightclick the same entry and select Properties.

17. Set the Startup Type field to Disabled.

18. Click on OK.

19. Reboot the computer.

HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl\Import and Export\
NDLConversion_ShowPrintDialog
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NDLRemoveMrsCnvIcon [REG_DWORD]

If you use the XPR conversion database (MrsCnv.nsf) instead of the 
administration database for NDL conversion as mentioned in Section E.1.2, 
“Using IBM/Lotus Notes Forms as Fax Template”, on page 206, an icon for 
the XPR conversion database is created in the workspace of the IBM/Lotus 
Notes client during the NDL conversion process / print job, if it has not been 
created yet. This database icon stores the printer settings including e. g. the 
print orientation (portrait mode/landscape mode) for this database overwriting 
the default printer’s settings in the Microsoft Windows control panel. 

If you want to reset all printer settings stored in this icon, i. e. remove the icon, 
after each NDL conversion process / print job, activate the registry key 
NDLRemoveMrsCnvIcon by setting it to 1.

The prerequisites to use the activated registry key NDLRemoveMrsCnvIcon 
are as follows:

• The NDL conversion already has been configured and is working on the 
XPR server.

• Click the Home tab in the IBM/Lotus Notes client on the XPR server 
computer. Click the Workspace entry in the navigator with the right 
mouse button and select the Set Bookmark as Home Page option.

Bookmark is the bookmark.nsf database containing mails, the calendar 
etc.

Homepage is the page that is shown first when you open a database in 
the IBM/Lotus Notes client.

Default: 0

Possible values: 0 (deactivated) or 1 (activated)
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• The XPR conversion database (MrsCnv.nsf) and the database file 
MrsReset.nsf have been copied from the <XPR_Install>\res\LnApl 
to the <LN_Install>\notes\data directory on the XPR server computer.

All database printer settings of a IBM/Lotus Notes database are stored in 
the icon of that database in the workspace of the IBM/Lotus Notes client. 
The MrsReset.nsf database file is responsible for finding and 
removing the icon created for the XPR conversion database icon in the 
workspace. The LnAPL opens this database and confirms all pop-up 
messages to remove the icon from the workspace.

Check whether the registry key NdlWaitPrintEndSleep must be modified.

NdlWaitPrintEndSleep [REG_DWORD]

The registry key NdlWaitPrintEndSleep (in ms) increases the print job waiting 
time, i. e. the time before the print job is started. This might be used in the 
case that it is not possible to remove the icon (see registry key 
NDLRemoveMrsCnvIcon) in the workspace because the MrsReset.nsf 
database is still opened. 

NdlExporter [REG_DWORD]

This flag activates the NDL converter

NDLKeepNotesClientOpened [REG_DWORD]

In the normal case the IBM/Lotus Notes client is opened and subsequently 
closed again for each NDL conversion. If this key is set to value 1, the IBM/
Lotus Notes client stays open after the NDL conversion. This program entity 

Default: 5000

Possible values: Integer values bigger than 5000

Default: 0

Possible values: 0 or 1

Default: 1

Possible values: 0 or 1
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is then used for all NDL conversions that follow. In this way a program entity 
is among other things ensured to be exclusively used for the NDL conversion 
by the LnAPL.

NdlMCFile [REG_DWORD]

This flag determines the shortcut keys for opening the file menu when using 
the NDL converter. The letters A to Z are used in the entry field. (A= 65, 
Z=90).

NdlMCPrint [REG_DWORD]

This flag determines the shortcut keys for printing out of the IBM/Lotus Notes 
client when using the NDL converter. The letters A to Z are used in the entry 
field. (A= 65, Z=90).

OutboundFileFormats [REG_SZ]

List of the file formats that are to be transported to IBM/Lotus Notes. Important 
is that at least one text format, one graphic format, one audio format, and a 
binary format is entered here. Necessary format conversions are processed 
by the XPR server. Manual manipulation is not critical since non-valid entries 
will be ignored. If you wish to use a fax resolution of 100 x 200, set 
OutboudFileFormats to value FG4.

RenderInConversionDB [REG_DWORD]

If messages contain the MRS_FAX_FORM field, they are not rendered in the 
administration database but in the conversion database. The LnAPL tries to 
find the form from the MRS_FAX_FORM field in the administration database. If 
it finds the form and the form is not available in the conversion database, the 
form is copied from the administration database to the local conversion 
database. If the form exists in the conversion database, but the administration 
database contains a newer version, the form in the conversion database will 
be updated.

The value of the FORM field is reset to the MRS_FAX_FORM field value. 
Subsequently, the form is printed via the NDL Converter routine.

Default: 65

Default: 65

Default: –

Possible values: AS7,TXT,FG3,FG4,WAV,BIN

Default: 0

Possible values: 0 or 1
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F.1.1.6  RTF Adjustments

The following values are specified under the key:
HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl\Import and 
Export\RTF Adjustments

All values defined in this subsection are only active when the “Microsoft Word 
RTF” Export filter is used for the export from IBM/Lotus Notes. If another export 
filter is used then the settings are without any effect.

DocBottomMargin [REG_DWORD]

This value determines the bottom margin of exported RTF documents (unit of 
measure: twips - 1440 twips = 1 inch). If this value is not defined or equal to -
1 decimal, the settings from the IBM/Lotus Notes RTF export filter will not be 
modified (1440 twips).

NOTE:  
These registry settings would only be used if no other settings were found in 
the administration database under IBM/Lotus Notes for the originator of the 
document or if the document itself contains no settings.

DocLeftMargin [REG_DWORD]

This value determines the left margin of exported RTF documents (unit of 
measure: twips - 1440 twips = 1 inch). If this value is not defined or equal to -
1 decimal, the settings from the IBM/Lotus Notes RTF export filter will not be 
modified (1080 twips).

NOTE:  These registry settings would only be used if no other settings were 
found in the administration database under IBM/Lotus Notes for the originator 
of the document or if the document itself contains no settings.

Default: -1

Possible values: -1…32680

Default: -1

Possible values: -1…32680
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DocRightMargin [REG_DWORD]

This value determines the right margin of exported RTF documents (unit of 
measure: twips - 1440 twips = 1 inch). If this value is not defined or equal to -
1 decimal, the settings from the IBM/Lotus Notes RTF export filter will not be 
modified (1440 twips).

NOTE:  These registry settings would only be used if no other settings were 
found in the administration database under IBM/Lotus Notes for the originator 
of the document or if the document itself contains no settings.

DocTopMargin [REG_DWORD]

This value determines the top margin of exported RTF documents (unit of 
measure: twips - 1440 twips = 1 inch). If this value is not defined or equal to -
1 decimal, the settings from the IBM/Lotus Notes RTF export filter will not be 
modified (1440 twips).

NOTE:  These registry settings would only be used if no other settings were 
found in the administration database under IBM/Lotus Notes for the originator 
of the document or if the document itself contains no settings.

Default: -1

Possible values: -1…32680

Default: -1

Possible values: -1…32680
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F.1.1.7  Notes Routing

The following values are specified under the key:
HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl\Notes Routing 

PostMaster [REG_SZ]

This field contains the hierarchical IBM/Lotus Notes user name of the user 
who has been designated as postmaster. The postmaster can be configured 
in the registry as well as in the administration database. If the postmaster is 
configured in the registry as well as in the administration database, then the 
settings will be taken from the administration database. The Postmaster field 
is only of importance when the Lotus Notes APL is configured in a way that 
non-deliverable documents are routed to the postmaster (see below).

RouteErrorHandling [REG_DWORD]

This flag determines the behavior of Lotus Notes APL when a IBM/Lotus 
Notes based routing is active and the document cannot be delivered. If the 
flag is set to 0, the Lotus Notes APL generates an error report. If the flag is 
set to 1, the document is sent to the postmaster. When no postmaster is 
configured or incorrectly configured, an error report is generated.

Default: 0

Possible values: 0 or 1
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F.1.1.8  Replication

The following values are specified under the key:
HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl\Replication 

AddressUpdateID [REG_DWORD]

This value is internally used by the Lotus Notes APL to tag the actual 
replication (IBM/Lotus Notes to XPR). When the Lotus Notes APL is shut 
down the value is written so that not all XPR users need to be replicated again 
at the next start.
Do not modify!

AddressUpdateRatio [REG_DWORD]

This value is used internally by the Lotus Notes APL and determines the 
interval of the address book replication.
Do not modify!

DocumentUpdateID [REG_DWORD]

This value is used internally by the Lotus Notes APL to note the state of the 
Inbox replication for Integrated Messaging.
Do not modify!

DocumentUpdateRatio [REG_DWORD]

This value is used internally by the Lotus Notes APL and determines the 
interval of the Inbox replication.
Do not modify!

ReplicationTag [REG_BINARY]

This value is internally used by the Lotus Notes APL to tag the actual 
replication (IBM/Lotus Notes to XPR). When the Lotus Notes APL is shut 
down the value is written so that not all IBM/Lotus Notes users need to be 
replicated again at the next start.
Do not modify!
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F.1.1.9  Computer Telephony Integration (CTI)

The following values are specified under the key:
HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl\CTI 

CtiDialButtonLogDoc [REG_DWORD]

This value determines whether a Dial button is to be integrated (1) or not (0) 
in the Rich-Text body of a CTI journal message. A prerequisite of the Dialer 
is the integration of the “mrsDialAgent” in the mail file of the user.

EnableCti [REG_DWORD]

This value determines whether a CTI journal replication is active (1) or not (0).

PhoneOutputSuppressNonAudio [REG_DWORD]

This value determines whether the non-audio components in messages 
addressed to the service PHONE from IBM/Lotus Notes are to be deleted (1) 
or not (0). If a Text-to-Speech module is installed on the XPR server, it could 
be desirable to transmit also the non-audio components.

VoiceConnectProtocol [REG_SZ]

This value determines which XPR protocol is to be used to establish a voice 
connection via telephone from IBM/Lotus Notes. XPR uses an outgoing E 
script. A call connection is internally established by sending a mail to the E 
script (NVS:DIALER/<external dialing number>). 

The string DIALER is inserted into the VoiceConnectProtocol which 
corresponds to the logical script name. The establishment of the voice 
connection is triggered by the user from IBM/Lotus Notes by sending a mail 
on the pseudo service VOICECONNECT to the Lotus Notes APL. The subject 
of the mail must contain the internal dialing number in a normalized 
international form.

Example: Subject = 49240412345
Mail is sent to 4921198765@VOICECONNECT@GWDOMAIN

Default: –

Possible values: 0 or 1

Default: –

Possible values: 0 or 1

Default: 1

Possible values: 0 or 1

Default: “ “

Possible values:
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A telephone connection is established between the two extensions. If the 
connection results in a failure an error report is sent to the mail database of 
the initiator.

NOTE:  
You can install alias domains for the VOICECONNECT service.
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F.1.1.10  Notes Connections

The following values are specified under the key:
HKLM\SOFTWARE\Wow6432Node\PP-COM\MRS\LNApl\
Notes Connections 

An additional key with the name of the external domain, via which the connection 
with the IBM/Lotus Domino server is to be established, is created in the “Notes 
Connections” key for each connection with a IBM/Lotus Domino server. The 
following Values are entered for each connection listed under the keys.

AliasDomains [SERVICE] [REG_MULTI_SZ]

List of alias domains for the service [SERVICE]. [SERVICE] corresponds to a 
XPR service ID (e.g. FAXG3, FAXG4, VOICE).

Syntax:

<alias1>
…
<aliasN>

Meaning: The list <alias1> to <aliasN> are stand-in domains for the 
service [SERVICE], addressed via the gateway domain of the key containing 
this value. With the address conversion the Lotus Notes APL adapts the alias 
domain to the corresponding basic address.

Default:

Possible values: Legal is “John Public @ 02404111222 @ FAXG3”.
Or “John Public @ 02404111222 @ FAXG3 @ NOTESGATE”, if 
NOTESGATE is the gateway domain.

With the configuration 
NOTESGATE\AliasDomainsFaxG3=OTHERGATE the addressing 
“John Public @ 02404111222 @ OTHERGATE” or “John Public @ 
02404111222 @ OTHERGATE @ NOTEGATE” is also legal and 
equivalent to the first addressing.

By default the alias domains FAXG3, FAXG4, SMS and VOICE are 
installed for the corresponding services. The alias domains must 
be unambiguous for all gateway domains.

Alias domains are not entered in the Windows registry under the 
obsolete value GatewayDomains.

The deinstallation of standard alias domains (alias domains that 
correspond to a XPR service e.g. FAXG3 or VOICE) can only be 
performed automatically, if they are entered as alias domain in the 
registry.
Example: AliasDomainsFAXG3=FAXG3
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Enabled [REG_DWORD]

This connection is enabled (1) or disabled (0).

EnableMRSPrivilegeCheck [REG_DWORD]

The XPR server (1) executes privilege checks on this logical line.

GatewayDatabase [REG_SZ]

Mail database of the gateway domain.

Gatewayerver [REG_SZ]

The name of the IBM/Lotus Domino server administering the foreign domain.

OutLink [REG_SZ]

This field contains the name of the mail router mailbox from the IBM/Lotus 
Domino server (mail.box).

PollDelay [REG_DWORD]

Time interval in seconds of the IBM/Lotus Notes XPR mail database check for 
new messages.

PollDelayHard [REG_DWORD]

Time interval in seconds between two checks of the domain mail database for 
new messages. The database is opened and scanned for checking. If the 
value is not set or set to 0, this type of database check is switched off.

ReconnectDelay [REG_DWORD]

Time interval in seconds between two reconnection attempts. Default is the 
maximum of 15 and PollDelay. That equates to 15 seconds if the Poll delay is 
less that 15 seconds, otherwise the PollDelay default value.

Default: –

Possible values: 0 or 1

Default: –

Possible values: 0 or 1

Default: 5

Possible values: Seconds

Default: –

Possible values: Seconds

Default: –

Possible values: Seconds
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SuppressForeignDomainModificationACLErrors [REG_DWORD]

If you have switched to restricted privileges for operating, it is still possible to 
perform modifications to foreign or alias domains via the GUI, but these 
modifications will not be correctly executed. For these settings you need 
privileges like for performing a setup. In such a case errors will be reported 
with each start that follows. You can use this value to suppress these errors.

See also Section 3.4.2, “Installation with restricted User Privileges”, on page 
52.

UpdateOptions [REG_DWORD]

This value determines how the Lotus Notes APL is to proceed with the 
GatewayServer and GatewayDatabase values.

Default: 0

Possible values: 0 or 1

Default: 0

Possible values: 0: No change of the existing configuration (NOP).
1: Create mail database and domain document (CREATE).
2: Delete domain with all aliases and mail databases (DELETE).
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F.1.2  Lotus Notes Unified Messaging Gateway 
(LnUmAPL)

ServerList [REG_Multi_SZ]

Hierarchical name of the IBM/Lotus Domino server where the mail databases 
of the Unified Messaging user are contained. Non hierarchical names (e.g. 
Jaggernaut) are illegal.

F.1.2.1  Globals

DominoClusterSupport [REG_DWORD]

Activates (1) or deactivates the support for IBM/Lotus Domino cluster.

F.1.2.2  MailDbAccess

DbSearchCutOffDays [REG_DWORD]

Prevents the search for documents for the number of days set.

Default: 16

Possible values: Juggernaut/HGC/DE

Default: 0

Possible values: 0 or 1

Default: 0 (switched off)

Possible values: Number of days
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F.1.3  IBM/Lotus Notes Client Component

F.1.3.1  Fax Viewer

The following entries are generated for the ActiveX component fax viewer in the

HKCU\Software\Cycos AG\COM\FaxViewer

key:

FaxFillCol [REG_BINARY]

This value contains the selected color of the objects that are to be used in the 
fax. The color is stored binary coded according to the RGB color model.

FaxGrid [REG_DWORD]

This value determines if gird lines are faded out or faded in a fax message.

FaxLineCol [REG_BINARY]

This value contains the line color selected in the fax message. The color is 
stored binary coded according to the RGB color model.

FaxLogoFnt [REG_BINARY]

This value indicates which font possesses the entries of the variables used in 
the fax message.

Default: 00 00 00 00

Possible values: 1st number pair = value for red
2nd number pair = value for green
3rd number pair = value for blue
4th number pair = without significance
(00 00 00 00 = black)

Default: 0

Possible values: 0 = faded out
1 = faded in

Default: 00 00 00 00

Possible values: 1st number pair = value for red
2nd number pair = value for green
3rd number pair = value for blue
4th number pair = without significance
(00 00 00 00 = black)

Default: Binary coded font Courier New
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FaxPrintMode [REG_DWORD]

This value determines which representation form is set for printing a fax 
message.

FaxTxtFnt [REG_BINARY]

This value indicates which font the entries of text objects used in the fax 
message possesses.

FaxTxtFntCol [REG_Binary]

This value contains the text object selected in the fax message. The color is 
stored binary coded according to the RGB color model.

FaxZm [REG_DWORD]

Value for the currently set zoom factor. The value is specified as diminution 
value between 0 and 100%.

FaxZoom [REG_DWORD]

Value for the set adjustment required for fax representation in the current 
window.

Default: 1

Possible values: 1 = Optimum fit (attempt to optimally print out a fax message on 
DIN A4 sheets). 
0 = Fit fax to print page (the entire fax message is always put out 
on one print page).

Default: Binary coded font Courier New

Default: 00 00 00 00

Possible values: 1st number pair = value for red
2nd number pair = value for green
3rd number pair = value for blue
4th number pair = without significance
(00 00 00 00 = black)

Default: 0

Possible values: 0...100

Default: 0

Possible values: 0 = Function is switched off, for example when another zoom factor 
(see FaxZm) has been selected.
1 = Display entire fax in the window
2 = Fit fax optimally to window size
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LeftFaxMargin [REG_DWORD]

Value indication for the width of the left margin of a fax hardcopy. The value 
is specified in millimeter from the left border.

RightFaxMargin [REG_DWORD]

Value indication for the width of the right margin of a printed fax. The value is 
specified in millimeter from the left border.

Default: 10

Default: 0

Possible values:
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F.1.3.2  Wave Player

The following entries are generated for the ActiveX component wave player in the 
key

HKCU\Software\Cycos AG\COM\WavePlayer

key:

AppendSource [REG_DWORD]

Value for the current switch setting of the button for re-recording or attaching 
a voice annotation.

LocalPhone [REG_SZ]

In this value the number of the telephone is entered that you would like to use 
temporarily as output device for your voice mails.

MonitoringSucceededFromPhone [REG_DWORD]

Value for the message stating whether or not the monitoring access 
performed last has been successful.

PlayVoiceDeviceIndex [REG_DWORD]

Value for the definition of voicemail playback

VoiceMailFormat [REG_DWORD]

Value for the set voice format: A-law or µ-law.

Default: 0

Possible values: 0 = New annotation
1 = Attach voice mail annotation to existing recording

Default: –

Possible values: 0 = Unsuccessful
1 = Successful

Default: –

Possible values: 0 = On the telephone defined as "local"
1 = On the own telephone

Default: 1

Possible values: 0 = µ-Law
1 = A-Law
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F.1.3.3  CTI-LSX

The following entry is generated for the client component CTI-LSX in the

HKCU\Software\Cycos AG\CtiLsx

key:

NotesIniPath [REG_SZ]

This value contains the path to the notes.ini file.

Default: C:\Lotus\Notes\notes.ini
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F.1.3.4  MRS Fax

The following entries are generated for the MRS Fax client component in the

HKCU\Software\Cycos AG\Lotus Fax Extension

key:

ClientTag [REG_SZ]

This value stores the password of the IBM/Lotus Notes user in cryptic form.

NotesIniPath [REG_SZ]

This value contains the path to the notes.ini file.

NotesSendForm [REG_SZ]

This value indicates which fax send form is used.

Default: C:\Lotus\Notes\notes.ini

Default: Memo
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